
Wavewin Upgrade List - 04/25/2024 

 

Below is a list of all the additions and changes. 

 

 

Wavewin H.Q.29 - 04/25/2024 

 

1. Data Plotting (Process Templates): When determining if the Voltage channels have a fault for the Sag 

   Swell report Wavewin was using the fault durations to calculate the fault type. It now uses the  

   Voltage dip percentage (%V command) to determine the fault type.  

 

 

Wavewin H.Q.28 - 04/19/2024 

 

1. Data Plotting (Process Templates): Added 2 new template fields to the process template engine.  

      

  A. Data <DATA> Indicates if the data in the Comtrade file is valid or corrupted. If the number of 

     samples exceed the number of samples defined in the CFG file and the sample number is not  

     sequential in the data file will be marked as BAD data. 

     Both the [] and <> brackets apply since it is general to the file. 

 

  B. RMS for the last sample in the file, C command <1^:C:7> Displays the RMS value for the last sample 

     in the file. 

 

 

Wavewin H.Q.27 - 04/11/2024 

 

1. Data Plotting (DIG Files): When opening the fault report from inside the DIG file and when requesting a  

   double ended plot using the 2 menu buttons (5th and 6th buttons from the left) the system reads the remote 

   station, device and line name from the selected line then goes through the table looking for the remote end. 

   If the remote end is found and the date and time between the two are within 50 milliseconds, then the double 

   ended fault location results are shown in the report file and the double ended dialog is displayed when  

   requesting a plot. If the current station name and the remote station name are the same, then a double 

   ended is ignored. 

 

2. Data Plotting (Process Templates - Digital): When writing the triggered digital channels to the DIG file 

   the channels are written back-to-back not adhering to the channel assignments inside the FMT file. This 

   reduces the gap when the channels are not triggered.  

 

 

Wavewin H.Q.26 - 03/31/2024 

 

1. Data Plotting (Process Templates – Default.VIW): Improved the scaling of the analog channels when opening 

   the Default.viw. Also, ignore the view setting that defines the number of samples between the Data bar  

   and the RMS bar. This is ignored when processing data files because the files being processed have  



   difference sampling frequencies.  

 

2. Device Manager (GE UR Relay Driver): Added support to read the files from UR Relays with a firmware 

   version 7.3 and greater. GE UR Relays with a firmware version 7.3 or greater changed the modbus map 

   to have two different modbus maps, one for setting values and one for actual values. 

 

 

Wavewin H.Q.25 - 03/12/2024 

 

1. Data Plotting (Process Templates – PDF Files): Process template will create a PDF file if the conditions  

   defined in the Display dialog are meet when processing a line. If a PDF file is created it will write  

   the path and name of the file to the last column in the DIG file. If a PDF file is not created, then the 

   last column was left blank. A blank column was causing problems in SQL Server. If a PDF file is not 

   created then it now populates the last column with a None. 

 

3. Data Plotting (Process Templates): Added support to have a Default.VIW instead of the Default.LNG.  

   The Default.viw allows for superimposing channels and other features of a view. 

 

 

Wavewin H.Q.24 - 03/08/2024 

 

1. Data Plotting (Sag-Swell): The Sag-Swell PDF report was improved to include the %Vnominal in the F47 

   Plot and it added the units for each section in the Summary report. 

 

2. Data Plotting (Process Templates): Corrected a problem when processing SEL and Emax files when using 

   the Process Template menu option under the File Manager’s Option menu. The command Line designation  

   /Line=All was included for the SEL and Emax files. 

 

3. Data Plotting (Process Templates – Default.txt): The Default.txt file lists the station name, device  

   name, line length, line impedance values, remote station, and remote device. It is used to populate  

   the Comtrade device’s line length, impedance values, remote station, and remote device for Comtrade  

   files that use the Default.LNG line group. When searching for a device in the Default.txt file the  

   station name and device name from the Comtrade long filename is used. The device name and remote device  

   name in the Default.txt has only the circuit name. Added support to extract the circuit name from  

   the device name in the Comtrade file and search the Default.txt using only the circuit name.  

 

4. Data Plotting (DIG-Double Ended): Inside the DIG files a double end fault location can be displayed  

   by clicking on the Waveform toolbar button for the highlighted device. This button will search the  

   table for the remote station and device. If the Default.txt file is used to populate the device’s  

   remote information then the circuit name must be extracted from the device’s name to find the correct  

   remote device. Added support to extract the device’s circuit name when looking for the remote end.  

 

 

Wavewin H.Q.23 - 02/20/2024 

 



1. Data Plotting (F47 Plot): Expanded the Semi F47 Sag Swell plot to display more than one second of data. 

   The plot will now show the full time period of the faulted duration. 

 

2. Data Plotting (Sag-Swell): Created a PDF report that includes the Waveform signals, the F47 Plot and  

   a Summary report on the Sag Swell information. The PDF is created during the process templates. It 

   can create a PDF for all processed files or just files that have a duration on one of the 3 voltage  

   channels. 

 

3. Data Plotting (Process Templates): During the process templates the system will not create a PDF file 

   if the line length and line impedance values are not available for the Fault Report template.  

 

 

Wavewin H.Q.22 - 02/04/2024 

 

1. Data Plotting (Process Templates): Added support to read a line’s impedance values, line length 

   and remote end station and line name for the Default.LNG file. Since one line group file is used for  

   all devices a Default.TXT file is created to list each lines information. The fields in the default.txt  

   file are listed below. The Default.TXT must be saved in the path where Wavewin is running. Wavewin 

   will read the file when it runs. 

 

   Station, Device, Nominal, PosSeqR, PosSeqX, ZeroSeqR, ZeroSeqX, LineMiles, RemoteDME, RemoteName 

 

2. Data Plotting (Channel Fault Inception): Wavewin calculates each channels fault inception when a 

   file is read. To mark each channel’s fault inception with a red dot activate the Chan Fault field 

   inside the properties dialog under the display settings tab. 

 

 

Wavewin H.Q.20 - 01/22/2024 

 

1. Data Plotting (Comtrade): Added support to handle SEL missing samples. SEL defines missing samples  

   with the value -8589939712. If this values is encountered in a Comtrade file then it is changed to zero. 

 

 

Wavewin H.Q.19 - 01/17/2024 

 

1. Data Plotting (DIG - Convert From UTC to Local): Modified the convert from UTC to local time in 

   the DIG file from using the Win API SystemTimetoTxSpecificLocalTime to using the add hour function 

   in the compiler. It will add the specified Time Code to the time listed in the DIG file. The Time 

   Code is specified in the Display dialog under the Data Plotting tab. If the time code is -4 then  

   the Add Hour function will minus 4 from the time listed in the DIG file. 

 

 

Wavewin H.Q.18 - 01/04/2024 

 

1. Data Plotting (Process Templates): Added 4 new template fields to the process template engine.  



      

  A. LFREQ <LFREQ> Displays the Line Frequency          

     Both the [] and <> brackets apply since it is general to the file. 

 

  B. SFREQ <SFREQ> Displays the Samling Frequency 

     Specify the sampling frequency at the reference bar [] or the data bar <>. In the Comtrade 

     CFG file the sampling frequency can be defined as 0. This means the sampling frequency                                                           

     will change. 

 

  C. Secondary Ratio <^#:X> Displays the specified channels Secondary Ratio.    

     Both the [] and <> brackets apply since it is general to a channel not to a sample. 

 

  D. Primary Ratio <^#:Y> Displays the specified channels Primary Ratio.    

     Both the [] and <> brackets apply since it is general to a channel not to a sample. 

           

2. Data Plotting (Process Templates): If the fault date and time is less than or equal to the start  

   date and time then do not process Voltage Dip, Duration and Triggers. This indicates a continuation  

   fault. 

 

3. Data Plotting (Process Templates): Added the Emax RCD files to the process templates engine. It now 

   processes Comtrade files using Line Group Files, SEL Files using VIW files and Exam Files using 

   the internal Line Groups defined in the Emax CTL files. 

 

4. Data Plotting (File Header): Corrected a problem with displaying the file's header information  

   after opening the properties dialog and clicking OK. The file name and date and time was disappearing.  

 

 

Wavewin H.Q.17 - 12/18/2023 

 

1. Data Plotting (SEMI F47 Plot): Does not require to have the 3 voltage channels marked when opening  

   the F47 plot. It now automatically selects the first 3 visible voltage channels without marking them  

   to keep the channel colors.  

 

 

Wavewin H.Q.16 - 12/04/2023 

 

1. Data Plotting (Process Templates): Optimized the processing of the template files by not reading all  

   of the files in the File Allocation Table. It now stops when the specified number of files to process 

   is reached. 

 

2. Data Plotting (Process Templates): Corrected the PDF fault report filenames. The previous version was 

   using the date format yyddmm for the first field in the file name. It now uses yymmdd. 

 

3. Data Plotting (SEMI F47 Plot): Corrected not showing all 3 voltage channels in the F47 Plot window.  

 



4. Data Plotting (SEMI F47 Plot): Added a new option to open the SEMI F47 window when the Comtrade File  

   is open. The new option is in the Display dialog under the Options menu in the File Manager. Select 

   the Data Plotting tab, under the General Setting section select Yes for the Open the F47 Plot field. The 

   SEMI F47 plot will be displayed when the Comtrade file is opened.  

 

 

Wavewin H.Q.15 - 11/28/2023 

 

1. File Manager (Auto Rename): Removed the directory exists checks when reading and writing to the Wavewin.INI 

   file for the Source Path, Archive Path, and Destination Path. Added a check to the start of the auto 

   rename that makes sure all 3 paths exist before starting the rename process.  

 

 

Wavewin H.Q.14 - 11/09/2023 

 

1. Data Plotting (Save SEL Settings to Comtrade HDR File): Corrected a problem saving the settings for the  

   SEL 700 series and 387 series relay. There are two exit points when reading the SEL analog and digital 

   channel data. Wavewin was saving the settings at one exit point but not the other.  

 

2. Device Manager (Poll On/Off): Changed the Print column in the Device Manager to Poll. The print feature  

   has been obsolete. The Poll feature allows for turning on or off polling for a device. When editing 

   a device the new option is a drop down list next to the Log Headers field. Select On to enable polling 

   or Off to disable polling. 

 

3. Device Manager (Group Polling On/Off): Added a new menu option to the right click popup menu to disable 

   or enable polling for a group of marked devices or all devices. To enable or disable polling first 

   select the devices then select the popup menu option Turn On/Off Polling.     

 

 

Wavewin H.Q.12 - 10/30/2023 

 

1. Data Plotting (Save SEL Settings to Comtrade HDR File): Added extra protection to saving the SEL 

   settings to the Comtrade HDR file/section. Also, moved saving the HDR file after the CFG file is saved. 

   It now first saves the CFG, then the HDR file then the DAT file. In previous versions it saved the 

   HDR file first then the CFG then the DAT. 

 

 

Wavewin H.Q.11 - 10/08/2023 

 

1. DIG File (Open CFG File): Added a new feature to open the CFG file from inside the DIG file. To open 

   the CFG file select the line in the table and click the Open CFG file icon on the button menu. 

 

2. Data Plotting (Open CFG File): Added a new feature to open the CFG file from inside the data plotting  

   window. To open The CFG file select the Open CFG file menu option under the File menu. 

 



3. Process Templates (Default.LNG): Supported applying the Default.LNG file to the processed Comtrade files 

   when the Default.LNG file is located in a different directory than where the Comtrade files are located. 

 

4. Data Plotting (F47 Voltage Sag Swell): Added the Duration in Cycles to the F47 Voltage Sag Swell Plot.  

 

5. Data Plotting (F47 Voltage Sag Swell): If no channels are selected before opening the F47 Voltage  

   Sag Swell plot then the first 3 Voltage channels displayed will be automatically selected.  

 

 

Wavewin H.Q.10 - 09/25/2023 

 

1. File Manager (Export File Table): Added a new feature to export the contents of the file manager to  

   a comma delimited CSV file. To export the table select the Export File Table menu option under the Files 

   menu/tab. A dialog is displayed, enter the filename, and select to export the marked files or all files. 

   After the export is complete navigate to the path where the file was saved and double click to open the 

   file in Excel. 

 

 

Wavewin H.Q.9 - 09/06/2023 

 

1. Data Plotting (Print PDFs): Corrected a problem with the waveform files being printed as straight lines. 

   The equations to calculate the scale for each waveform was using integer values resulting in a 0 scale  

   factor. It now uses floating point values for the calculation. 

 

2. File Manager & Data Plotting (Save As Comtrade): When converting an SEL compressed or ASCII file to 

   Comtrade the settings section of the SEL file is saved to the Comtrade .HDR file/section if specified 

   by the user.  

 

2. File Manager (Auto Convert to Comtrade): Added a drop down list to select the Comtrade file type to  

   convert the specified file extensions. Also, added a checkbox to include the SEL settings in the  

   converted Comtrade .HDR file/section. 

 

3. Device Manager (Import File): Added a new section in the Import dialog to Auto Fill the Device Number  

   and Session numbers when importing into a new Device Manager table. The auto fill will only work when  

   the device manager table is empty. It also, allows for specifying the start number for both the  

   device number and session number.  

 

 

Wavewin H.Q.8 - 07/24/2023 

 

1. Line Group Builder (Edit and Clear): Added the ability to open a line group file without having 

   a CFG file open. This allows for editing a line group and saving it when there is no CFG file open. 

   Added a button to clear all fields in the Line Group builder. This will allow for easily switching   

   between line group files and CFG files. 

 



2. Line Group Builder (Passed Parameter): Added the ability to pass a file to the line group builder.  

   The file can be a line group file or a CFG file. This allows for associating the Line Group Builder 

   application with the .LNG or .CFG file in Explorer. 

 

3. Line Group Builder (Illegal Characters): Replaced all illegal characters from the station and device  

   fields read from the Comtrade CFG file with an underscore before creating the line group file.  

 

4. Data Plotting (Line Groups - Illegal Characters): Replaced all illegal characters from the station  

   and device fields read from the Comtrade CFG file with an underscore before looking for the Comtrade 

   Line Group File. 

 

5. File Manager (Popup Menu - Rename): In the Ribbon system the File Manager's rename popup menu option 

   was not displaying the rename dialog. The Rename name displayed in the popup menu was different  

   than the name in the popup menu code. 

 

6. Data Plotting (WFC and EWC Files): An error was occurring when reading the invalid rows in the WFC  

   and EWC HTML files. The <td /> html script was interpreted as an incomplete data cell, and it proceeded  

   to read the next line for the completion. That in turn messed up the parsing of the rows. This error 

   has been corrected in this version. 

 

 

Wavewin H.Q.7 - 06/26/2023 

 

1. Data Plotting (Process Templates – Phase Rotation): Added support to read the phase rotation from the  

   line group and calculate the proper sequence components. If the phase rotation is ABC negative sequence  

   is calculated and if the rotation is ACB then positive sequence is calculated. 

 

2. Data Plotting (Invert Analog Channel): Corrected a problem when channels are inverted and the properties  

   dialog is opened and saved. The channel scale factors were reverted back to their original values.  

 

3. Data Plotting (Calculated Trigger Position): Added a new option in the data plotting window to show a  

   purple dotted line with a fuchsia triangle at the bottom showing the calculated trigger position in  

   the file. The new option is in the Properties dialog under the Display Settings tab. 

 

4. Data Plotting (Number of Cycles from Trigger): Added a new option in the process template engine. The  

   new option allows for selecting the number of cycles the data bar is positioned from the trigger 

   position. The select cycle option is in the File Manager Display dialog under the data plotting tab. 

   The four options are 1, 1.25, 1.75 or 2.00 cycles.   

 

5. Data Plotting (Process Templates – Invert Neutral Channel): Added a check on the neutral channel when 

   calculating the reactance fault location on a line in the process templates engine. If the faulted 

   phase angle minus the neutral angle is greater than 45 then make the neutral angle equal to the 

   faulted phase angle before running the reactance fault location. 

 

6. Data Plotting (Harmonic Analysis Report): Corrected a problem with the harmonic analysis report with 



   Comtrade files that have the sampling frequency set to 0. When the sampling frequency is set to 0 in  

   the CFG file the sampling frequency is calculated using the time at each sample. This causes the  

   sampling frequency to change across cycles. Instead of using the maximum harmonic to calculate the 

   0 harmonic it now uses 0 for the calculation. 

 

7. Device Manager (FTP Driver): Corrected a problem when parsing new files to collect using the FTP driver. 

   The parsing was not picking up dates that have a single digit day. This problem was introduced in the 

   H.Q.4 release dated 12/01/2022. 

 

 

Wavewin H.Q.6 - 02/07/2023 

 

1. Data Plotting (Process Templates – Rename DIG Files): Added a new option to rename all DIG files before  

   processing a new batch of waveform files for the process templates feature. To rename the DIG files  

   there are four new fields in the Display dialog under the Data Plotting Tab. The first field called  

   Rename After allows for selecting what to do with the DIG files before processing new files. The  

   two options are, No – do not rename and Yes, rename the files. All DIG files will be renamed using  

   the long file naming format (Comnames). The three remaining fields are used to rename the files. 

   Enter the timecode where the files are located along with the station name and device name. 

 

 

Wavewin H.Q.5 - 01/17/2023 

 

1. Data Plotting (Process Templates – Delete Files): Added two new options to the process templates.  

   To save on disk space there is two new drop down options in the Display dialog under the Data Plotting 

   Tab. The first is Delete After processing a file. The 3 options are: No, Yes and Only Non Fault files.  

   The second option is Delete No Line Group. There are two options: No and Yes. This will delete any  

   files that do not have a line group or encounter an error opening the file.  

 

2. Data Plotting (Line Groups): When reading lines from a line group file spaces after the Positive  

   and Zero Sequence values was causing errors when converting to a real value. All spaces before and  

   after are deleted before the conversion.   

 

3. Data Plotting (Process Templates - PDF): Added a new option for creating Fault Location PDF files. 

   The new option will create a PDF if a Fault Type is detected. The four options for creating a  

   fault location PDF are: All Files, No Files, Breaker Operated & Fault Type or just Fault Type.   

 

4. Data Plotting (Process Templates - Digital): Replaced all illegal characters with a - from the digital  

   channel titles before writing to the DIG file. The illegal characters was causing separator issues.  

  

 

Wavewin H.Q.4 - 12/01/2022 

 

1. Device Manager (FTP/SFTP): Made a number of improvements to the FTP and SFTP extract driver for  

   Comtrade files. 



     Before any files are extracted the list containing the latest files are sorted by filename. This  

     will group the Comtrade CFG, DAT, HDR and INF files in order.  

 

     Changed the way the CFG date and time is implemented across Comtrade Files. In previous versions  

     the CFG fault date and time was held in memory until the DAT, HDR and INF files are extracted.  

     If the system is shut down before extracting the DAT, HDR and INF files then the CFG file was not  

     matching the remaining Comtrade files. It now updates the DAT, HDR and INF files directory listing  

     in memory to match the CFG date and time. This list is saved to the DEV_###.FTP file located 

     in the directory where the device configuration files located right after extracting the CFG file.  

     This ensures that the CFG file will match the remaining Comtrade files. 

 

     Added error reporting. If an error is encountered either connecting to the server or getting 

     a directory list or extracting a file. Each error is reported in the debug.fil file located in 

     the path where Wavewin is running. The error format is:  

       Date Time – Protocol Error on Device ## at Port ## Error Type 

       11/30/2022 22:09:00.077 - FTP Error on Device#: 66 at Port#: 43 Error = Time Out. 

 

     When a directory listing is received from the server it will only list the date and time of the 

     files generated in the last 6 months. All other files only have the date, no time. See the example 

     below: 

 

      -rw-r--r--    1 server    server         7090 Nov 26 20:17 040219,062250673,5,OC SW,BKR 

BUS1,Softstuf,,999.00,$$$$,CG T.CFG 

      -rw-r--r--    1 server    server       507868 Nov 26 20:17 040219,062250673,5,OC SW,BKR 

BUS1,Softstuf,,999.00,$$$$,CG T.DAT 

      -rw-r--r--    1 server    server          259 Nov 26 20:17 040219,062250673,5,OC SW,BKR 

BUS1,Softstuf,,999.00,$$$$,CG T.HDR 

      -rw-r--r--    1 server    server         2998 Sep 26  2018 040226,131325030,5,South Station,DFR 

TR16,,,,,,20925.CFG 

      -rw-r--r--    1 server    server       593134 Sep 26  2018 040226,131325030,5,South Station,DFR 

TR16,,,,,,20925.DAT 

      -rw-r--r--    1 server    server          620 Sep 26  2018 040325,191158635,+3S,MARA,250,Electric 

Company,,,,.CFG  

      -rw-r--r--    1 server    server       398502 Sep 26  2018 040325,191158635,+3S,MARA,250,Electric 

Company,,,,.DAT    

 

     Wavewin will only collect files that have both the date and time. All other files are ignored.     

 

 

Wavewin H.Q.3 - 11/07/2022 

 

1. Data Plotting (Process Templates – PDF): Only create PDF files if a breaker operated and there is  

   a valid fault type. 

 

2. Line Group Builder (Add Line Group): Corrected a problem when selecting Cancel or No when adding 



   a line group that already exists in the open line group file. 

 

 

Wavewin H.Q.2 - 10/24/2022 

 

1. Data Plotting (Process Templates - Duration): Corrected a problem when calculating the duration of  

   the faulted phases. Defining SAC channels inside a line group was causing the duration to be added  

   every time a SAC channel was calculated. Instead of adding the duration the software now keeps a  

   pointer to the beginning of the fault and a pointer to the end of the fault. The duration is calculated  

   from the difference in samples from the two pointers.   

 

3. Data Plotting (Process Templates - PDF): When processing files a PDF file can be created. The function  

   to produce the PDF file is also the same function that displays the summary file inside the DIG table. 

   When a Summary is requested inside the DIG table a single ended fault location is performed depending  

   on the fault type. It also looks for the far end of the line and performs a double ended fault location. 

   When processing files it was trying to find the far end of the line which is not available during the  

   file processing and was causing an access violation error. The function has been modified to only call 

   the double ended fault location from inside the DIG table.  

 

4. Data Plotting (Process Templates - Negative & Positive Sequence Values): Added the unit prefix to the 

   negative & positive sequence value calculations for the process templates. In previous versions the  

   prefix was not being applied for channels that have a prefix equal to kilo.  

       

 

Wavewin H.Q.1 - 09/25/2022 

 

1. Line Group Builder (Time Adjustment): Added a new field in the Line Information tab to add a time  

   adjustment to the line group file. The field is added to the end of the line group file. The name of the 

   field is call TIMEADJUSTMENT=. To minus a time from the file’s time add a minus sign before the time 

   adjustment number. 

 

2. Data Plotting (Process Templates): Added the Three-Phase and Multi-Phase single ended fault location 

   engines to the DIG summary window.  

 

3. Data Plotting (TimeAdjustment): Read the time adjustment field from the line group file if it exists. 

   Apply the time adjustment to the files time before the file is opened.     

 

 

Wavewin H.Q.0 - 09/01/2022 

 

1. Data Plotting (Process Templates): Added a new command to the Templates to define the phase rotation 

   of the channels. In the Line Group builder a new field was added to the Line Information tab called 

   Phase Rotation. This field is saved to the line group as PhaseRotation=ACB. The line rotation can be  

   ABC or ACB. In the template the new command is called <PHSROT>. This command will write the Phase  

   Rotation to the DIG files. 



 

2. Data Plotting (Process Templates): Added a new command to the Templates to define the Remote Device  

   name. In the Line Group builder a new field was added to the Line Information tab called 

   Remote Device. This field is saved to the line group as RemoteDevice=. In the template the new command  

   is called <RDev>. This command will write the Remote Device name to the DIG files. 

 

3. Data Plotting (Invert Channels): Added a new option from the data plotting’s right click popup menu to  

   automatically invert all the marked analog channels. To activate first marked the desired analog  

   channels using the spacebar or mouse, next right click on the analog channel table and select  

   the Invert Marked Channels menu option. 

   All of the marked channels scale factor will be multiplied by -1. To restore the original mark the  

   channels again and select the popup menu option Invert again.  

 

4. Line Group Builder (Edit Line Group): Corrected a problem when editing line groups that have numbers 

   defined as the analog and digital channels.    

 

5. Device Manager (SFTP Driver): Added extra protection to catch invalid connection configuration and 

   invalid Remote Paths. If a connection fails or the remote path does not exist on the server an error 

   is written to the debug.fil file located in the same path where Wavewin is running.  

 

 

Wavewin H.P.21 - 07/20/2022 

 

1. File Manager (Append CSV Files): Changed the Append Log File command to append all marked like CSV 

   files on the active path from the file manager. To append a number of CSV files first mark the files 

   then select the Append CSV Files from the Options/Report menu.  

 

2. Data Plotting (SEL Views): Added support to have views specific to each type of SEL Relay.  

 

 

Wavewin H.P.20 - 06/17/2022 

 

1. Data Plotting (Mark and Save): Added a new analog command to the Mark and Save window and the Process 

   Templates. The new Z commands extracts and saves the Frequency calculated from the 3rd to the 4th cycle. 

   To extract the Frequency use the following command: <^1:Z:8>. The ^1 specifies the first visible channel.  

 

 

Wavewin H.P.19 - 06/12/2022 

 

1. Data Plotting (Auto Process Templates): Added 5 new command to write the DME fault location variables  

   parsed out of the DME Comtrade *.INF file. The Z1 and Z0 Magnitude and Angle Line Impedance values and 

   Fault Location and Line Length are parsed out of the INF file if they exist in the file. The 5 new  

   template command are: 

 

   -> DME-LINELEN,   DME-FAULTLOC,   DME-Z1MAG,   DME-Z1ANG,   DME-Z0MAG,   DME-Z0ANG 



      <DMELL:8>,     <DMEFL:8>,      <DMEZ1M:8>,  <DMEZ1A:8>,  <DMEZ0M:8>,  <DMEZ0A:8> 

 

 

Wavewin H.P.18 - 06/03/2022 

 

1. File Manager (DIG Files): Corrected a problem when passing a file with extension different than the  

   Comtrade file extensions. The system was marking it as a processed file by adding a ,WWD to the end of  

   the filename. The system was corrected to only add a ,WWD to the end of a Comtrade file.  

 

 

Wavewin H.P.17 - 05/24/2022 

 

1. Data Plotting (Mark and Save): Added 2 new analog commands to the Mark and Save window and the Process 

   Templates. The W and V extracts and saves the MWatts and MVars at the data bar or the reference bar. 

   To extract the MWatts and MVars specify the Voltage and Current Channels first followed by a W or V. For 

   example <^1,^4:W> or <^1,^4:V>.  

 

 

Wavewin H.P.16 - 05/15/2022 

 

1. Data Plotting (Auto Process Templates): When a Comtrade file is processed using the Auto Process Templates  

   feature it first checks to see if a line group file exists for the file. If a line group file does not exist 

   then it will skip the file. Support was added to the check for line group file feature to include the device  

   name in the file. In previous versions the line group file only contained the station name in the  

   filename, such as Station-A.LNG. To expand to multiple devices per station the Device name was added, such 

   as Station-A,Device-A.LNG. The Station name and the Device name are read from the Comtrade’s .CFG file. 

   The first line in the CFG file list the station name, device name, Comtrade version number. The  

   Station-A.LNG and the Station-A,Device-A.LNG are both supported.  

 

 

Wavewin H.P.15 - 05/04/2022 

 

1. Data Plotting (Up Sample): Added up sampling to the Auto Convert to Comtrade and the /Comtrade passed 

   parameter. Up Sampling is specified in the Change Frequency dialog. If the Always Open Frequency check box 

   is checked then before saving the converted file to Comtrade it will change the frequency to the  

   specified frequency in the Always Open Frequency edit box.  

 

2. Device Manager (Automatic Update Properties Dialog): Modified the User_Params.ini file to include the 

   star passwords and IPs. When the user_params.ini file is saved to the path were Wavewin is running the 

   next time it starts it will read the user_params.ini and update all the specified fields in the  

   Properties dialog and the Star Password and IP address in the Display dialog. 

 

 

Wavewin H.P.14 - 04/20/2022 

 



1. Data Plotting (Analog Channel Titles): Increased the maximum characters per analog channel title from  

   50 to 80. 

 

2. Data Plotting (Line Groups): Added support to have the station,devicename.LNG as the devices line group 

   filename. In previous versions the Line Group file was named station.LNG. Expanding the name to include 

   the device name allows for supporting multiple devices in the same substation. The station name is read  

   from the first field in the first line of the Comtrade .CFG file or section. The device name is read  

   from the second field in the first line of the Comtrade .CFG file or section. The fields on the first 

   line in the CFG file are separated by a comma.  

 

3. Device Manager (Star Passwords): Added starring out the IP addresses for the Star Passwords feature. The  

   IP addresses are starred out in the Device Manager and Configuration dialog along with the export feature.   

 

4. Device Manager (ZModem Driver): Corrected a problem when unzipping files collected using the ZModem 

   driver. The unzip feature was tagging the unzipping of the files with an error causing the zip file to be 

   renamed with an Error indication and not deleted from the save path.        

 

 

Wavewin H.P.12 - 04/03/2022 

 

1. Data Plotting (Process Templates): Added a new feature that will write the digital channel title to the  

   report file using Breaker or Event script codes, example [B01:H] or [E02:H]. The H after the colon indicates 

   to write out the digital channel header. 

 

2. Data Plotting (Process Templates): Added a new feature that will write the digital channel status to the  

   report file using Breaker or Event script codes, example [B01:S] or [E02:S]. The S after the colon writes an 

   “A” if the digital channel had a change of state or an “N” if there was no change of state. 

 

3. File Manager (Save As): Changed the Save As Comtrade in the File Manager to a generic Save As feature. The 

   Save As Comtrade menu option under the Options menu has been changed to Save As. The new Save As dialog allows 

   for directly selecting the Save As format (Comtrade 1991, 1999, 2013 Ascii or Binary, RMS, Instantaneous  

   Values, Vector Values and Summaries). Also added a Save As menu option under the File menu. The new Save  

   As dialog has a drop down list box to select the format and radio buttons to select the files to process. 

 

4. Data Plotting (Emax Director Driver): Corrected a problem reading the version number inside the Emax director 

   files. The version number appears in two places, the beginning and end of the CTL file. Wavewin was reading  

   the version number from the end of the file, which was not always in the same byte position. It now reads 

   the version number from the beginning of the file that always starts at byte number 296. 

 

5. Data Plotting (Process Templates): Added protection from having duplicate templates added to the  

   process templates when using the batch mode processing or using the Process Template dialog. 

 

 

Wavewin H.P.11 - 02/02/2022 

 



1. Device Manager (SFTP Client): Added a new file transfer protocol to extract files from an SFTP Server.   

   The new SSH FTP Client works the same as the current FTP Client with the addition of password authentication. 

   To specify  an SFTP connection select Ethernet in the connection Types section of the Device Configuration 

   dialog. Then select SFTP in the Protocol list box.  The SFTP Client connects to the SFTP Server using  

   the username and password defined in the device configuration dialog. Once the connection is established 

   the SFTP Client requests a DIR list for the specified remote path. It then parses each file/folder in the 

   list. All files that have a date and time greater than the Current date and time displayed in the Change  

   Polling Start Date & Time dialog are marked for retrieval. 

 

2. Data Plotting (Restore Original View): Added a new feature that will restore the analog channels, digital 

   channels, phasors, and the analog table back to the original view when the file was first opened. To  

   restore the original view select the Restore Original View menu option under the View menu in the Menu 

   based system or click the Restore Original View icon in the View section under the Waveform tab in the  

   Ribbon System.  

 

3. Data Plotting (Line Groups): Increased the number of lines contained in a Line group file from 25 to 50. 

 

4. Data Plotting (Ametek Line Groups): Corrected the reading of the Line groups defined in the Ametek original 

   file formats. 

  

 

Wavewin H.P.10 - 12/01/2021 

 

1. Device Manager (SSHClient): Replaced the existing SSHClient component with a more reliable component.  

   The previous SSHClient was designed to work with ASCII communications only. The new component supports  

   both ASCII and Binary communications. The new component also has a better support team and the old  

   component is no longer supported. 

 

2. Data Plotting (Append Files): When Appending files only the files that have matching analog and digital 

   channel titles are appended. The scale factor has been added as an additional check to make sure all  

   analog channels appended have matching scale factors as well. 

 

3. Data Plotting (Sort Digital Channels): Added a new feature that will sort the Digital Channels according 

   to the change of state. This new feature will sort the first change in state in Ascending order or sort 

   the first change in state in Descending order. There is also an option to restore the order of the  

   Digital Channels when the file was first opened. In the menu system there is a new submenu under  

   the Channels menu called Sort Digital Channels and in the ribbon system a new drop down menu was  

   added to the Channels tab under the Arrange section. 

 

4. Data Plotting (Sequence Components Calculator): Added an option inside the Sequence Components calculator 

   to always use the displayed channels that are selected in the voltage and current drop down lists.  

   A new checkbox has been added under the phasor diagram to specify that the channels selected in the  

   drop down boxes be preselected when opening the sequence components calculator. 

 

5. Data Plotting (Fast SACs): Changed the name of the positive and negative sequence components Fast SACs 



   titles to be Time Pos Sequence and Time Neg Sequence. This will clarify that these Fast SACs are time 

   based equations. 

 

 

Wavewin H.P.9 - 08/11/2021 

 

1. Device Manager (Long Filenames): Added support to remove all illegal characters from the Comnames 

   Filenames when saving a file that was composed from data extracted from the device.  

 

 

Wavewin H.P.8 - 06/14/2021 

 

1. File Manager (IEEE Comnames): Added support to handle the IEEE Comnames long name format from SEL 

   devices. The SEL devices are formatting the IEEE Comnames as: 

     20210610,11.35.37.289,-6,PORTSMALL 345,XYZ_420NE,X POWER.dat 

   The format is including the 4 digital year in the first field and adding dots between the time fields. 

   Wavewin now checks if the date field is greater than 6 fields. If it is greater than it reads  

   the date starting at the 3rd character. It also checks if dots are in the time field, if yes then 

   it ignores the dots. These files are now displayed correctly in the File Manager. 

 

3. Create SER Files (Substation and Device Columns): When creating the SER files it now takes the  

   Station and Device fields directly from the IEEE Comnames files instead of from the CFG files 

   for Comtrade files. 

 

2. Device Manager (Baud Rate and Passwords): Added an option to quickly change the baud rate and level 

   1 password for multiple devices. There is a new option in the Device Manager right click popup menu 

   called Set Password and Baud Rate. When the dialog is displayed there are two options on what devices 

   to change, All Devices or Marked Devices. If there are marked devices in the table then the Marked  

   Devices radio button is automatically checked. If there are no marked devices in the table then the 

   Marked Devices option is disabled. The Baud Rate field is defaulted to no selected option and the 

   password field empty. If there is no change need to the baud rate field leave the selection as empty. 

   Same with the password field if it is empty then no changes will occur.  

 

 

Wavewin H.P.7 - 05/18/2021 

 

1. Device Manager (GE SR Relays): Modified the GE SR Relay driver to have the option to only extract 

   the waveform files and bypass the SER extraction. Change the SR driver from TXCOMMAND=GE-SR-RELAYS to 

   TXCOMMAND=GE-SR-RELAYS-W 

 

2. File Manager (Create SER Files): Added code to populate the Time Code field inside the SER report 

   file with the Time Code located inside the ComNames Property dialog only if the time code is not  

   available in the original waveform filename.  

 

3. Data Plotting (Replay Plus Driver): Corrected a problem when reading the Sampling Frequency from 



   The Replay Plus .DAT file. 

 

 

Wavewin H.P.6 - 04/20/2021 

 

1. Device Manager (Extract SEL Files): Added extra checking when extracting the Date and Time from an 

   an SEL CEV compressed format. Wavewin looks for the following fields in the header section of the SEL 

   compressed format: 

     “Year 

     “Month 

     “Day 

     “Hour 

     “Min 

     “Sec 

     “Msec 

  In a SEL relay being polled the “Sec was included in the FID= Serial line. This caused Wavewin to pick 

  up the field below the FID= as the Seconds field for the date and time. The field was not a valid second 

  and the extracted files were not being saved because the field being used as the second had invalid filename  

  characters. To correct this Wavewin now validates each date and time field. If each date and time field  

  does not convert to a number then it looks for the occurrence of the date and time fields above.     

 

2. Device Manager (Create SEL Fault Reports): When saving the Fault Summary .SLS files the target information 

   was inserted before the filename field. The target has been removed from the Fault Summary file.   

 

 

Wavewin H.P.5 - 04/09/2021 

 

1. File Manager (Auto Create SER Files): Modified the Auto Create SER file to create the SER table to 

   conform with the NERC PRC-002 SER Format. The previous versions were creating the following table columns 

   in the SER file: 

      Substation, Device, State, Trigger Date, Trigger Time, Chan. #,Channel Title 

   The new table columns are: 

      Date, Time, Local Time Code, Substation, Device, Channel Title, State 

   The local time code column will only be populated in the SER file if the original file is in the IEEE  

   Comname filename format. The 3rd field in the Comname filename contains the Time Code. If the time  

   code exists in the original file then it is used to populate the time code column in the SER file.   

 

 

Wavewin H.P.4 - 03/29/2021 

 

1. File Manager (Auto Rename Files): Activated the Auto Rename Files when Wavewin is ran if include 

   sub-folders is not selected. The Auto Rename was only activated if include sub-folders was checked.  

 

2. Data Plotting (RMS Calibrated Channels): Corrected a problem when selecting RMS calibrated data type 

   from the Properties dialog inside the data plotting window. It was relying on the setting defined in 



   the Driver Configuration dialog located in the File Manager table. 

 

3. Data Plotting (SEL Driver – Digital Channels): Added support to display digital channels that are not  

   a multiple of 8. The SEL CEV format has always defined the number of digital channels to be multiples of 

   8, one bit per channel. A file we recently discovered had 124 digital channels. In previous versions the 

   Last 4 bits were not being processed.   

 

 

Wavewin H.P.3 - 03/09/2021 

 

1. File Manager (Auto Rename Files): Added more support to avoid runtime errors when the file format is  

   not correct or incomplete. Also, if the station name and device name cannot be found in the file then 

   it is marked as unable to rename. 

 

 

Wavewin H.P.2 - 03/04/2021 

 

1. File Manager (Auto Rename Files): Added a 4th directory for moving all files that have encountered  

   errors when trying to rename a file. The new path is called the Error path. This prevents from 

   trying to rename the files every time the process is ran.  

 

 

Wavewin H.P.1 - 03/01/2021 

 

1. File Manager (Auto Rename Files): Added support to replace all filename illegal characters in the 

   station and device names with a dash (-) before renaming the files. Also, removed all non-printing  

   ASCII characters from the station and device names. Added more protection to the SEL display driver  

   to avoid access violation errors when the file format is not correct. When renaming the files it now 

   checks to see if the file already exists in the destination folder, if it exist then the file is 

   deleted in the source folder and the rename is bypassed. 

 

 

Wavewin H.P - 02/17/2021 

 

1. Device Manager (SEL Event Extensions): Added code to add the proper extension to an extracted SEL  

   event file. If the first 3 digits of the outgoing command is CEV then the extension will be CEV else 

   it is defaulted to EVE. 

 

2. File Manager (Auto Rename Files): Added support to bypass all error message boxes being displayed during  

   the rename process. Also, changed the way the rename process works. In previous versions it would first  

   move the files from the source path to the archive path then copy the files to the destination path. 

   It would then rename the files in the destination path. A number of requests ask to leave the files in 

   the source path if an error occurred reading the files. So it now copies the files from the source path 

   to the destination path and if the rename is successful it then moves the files from the source path  

   to the archive path and deletes any files that encountered errors from the destination path. This way 



   all files that were not successfully renamed remain in the source path.     

 

 

Wavewin H.N.6 - 02/10/2021 

 

1. Data Plotting (SEL Event Files): Added support to bypass an error when there are less than 50 lines  

   from the start of the event to the end of the file.   

 

 

Wavewin H.N.5 - 01/26/2021 

 

1. Device Manager (Relay Tech Configurations): Created a generic polling configuration for relay techs to  

   poll relays in the station without having to edit the configuration to add the station and device names. 

   The station name and device name for each record in the device manager lists the type of data to retrieve 

   from the relay. For example, one record will have Compressed Raw in the Device Name field and Event in 

   the Station name. When the device is activated to poll the relay will download all the new Compressed 

   Raw event files from the relay and name the event files using the IEEE Comnames format. The device name 

   and station name will be automatically populated with the Relay ID and Station ID fields listed in the 

   event file. Below are examples of the Relay and Station Fields defined in a compressed format and an 

   ASCII format located in the event file. When an event is extracted from the relay the SEL driver will 

   automatically look for the Relay and Station ID fields and put the fields inside 2 variables: RID and 

   TRMID. The RID variable will replace the Device field in the IEEE long filename and the TRMID variable 

   will be used for the Station field in the filename. The Device and Stn-Group fields will be added to the 

   IEEE long filename in the 7th field, right after the Company Name field, see the example filename below.  

 

   Wavewin will only perform the automatic naming of the files using the Relay and Station ID fields from 

   inside the event files if a file named Relay_Techs.INI exists in the path where Wavewin is running from. 

   The Relay_Techs.INI file lists all the possible titles a relay would use to label the Relay and Station 

   ID. If a relay uses another title to represent the Station and Relay ID’s add them under the proper 

   section. The Relay_Techs.INI file lists all the possibilities for the Relay IDs under the [RELAYIDS] 

   section and all the possibilities for the Station IDs under the [STATIONIDS] section. The two sections 

   must be separated by a blank line. See the Relay_Techs.INI File Contents section below to see the format of 

   the file. 

 

   Compressed Format 

   "FID","RID","SID","03E2" 

   "FID=SEL-421-R113-V0-Z004005-D20050119","Relay 1","Station A","0f13" 

 

   ASCII Formats 

   SID     := "Station A" 

   RID     := "Relay 1" 

 

   RID   =FEEDER 1                       TID   =STATION A    

 

   Example Filename: 



      181003,21272145,-5,Station A,Relay 1,Softstuf,Event-Compressed Raw,100.000,$$$.$$,TRIG.SEL  

 

   Relay_Techs.INI File Contents 

   [RELAYIDS] 

   MID 

   RELID 

   RID 

    

   [STATIONIDS] 

   TID 

   TRMID 

   SID 

 

2. Device Manager (Event File Type Field): Added an option to add event commands to the Event File Type 

   Field’s drop down list using a file called SEL Event File Type.INI. When the Device Manager is open, 

   it will check if the SEL Event File Type.INI exists in the path where Wavewin is running from. If 

   it does not exist then it will create the file with the default event commands that currently exist 

   in the Event File Type drop down list. The Event File Type Field is stored in the Command field. 

   Currently the field stored in the Command field is a letter or number that corresponds to each title 

   listed in the Event File Type drop down box. The current letters are listed below with its corresponding 

   title and outgoing command. 

    

   Storied Letter/Number  Title    Outgoing Command 

   0            Default    EVE # 

   S            Short     EVE # 

   L            Long     EVE # L 

   R             Raw (Unfiltered)   EVE # R 

   C             Compressed Raw   CEV # R 

   X      Compressed Raw L60  CEV # R L60 

   D      Compressed Default  CEV # 

   B      Compressed B Command  CEV # B 

   A      ASCII EVE B Command  EVE # B 

 

   The # in the outgoing command represents the Event number. The system now stores the number that 

   represents the position in the drop down list box. For example, the new stored values are listed below: 

 

   New Storied Number  Title    Outgoing Command 

   0     Default    EVE # 

   1     Short     EVE # 

   2     Long     EVE # L 

   3     Raw (Unfiltered)   EVE # R 

   4     Compressed Raw   CEV # R 

   5     Compressed Raw L60  CEV # R L60 

   6     Compressed Default  CEV # 

   7     Compressed B Command  CEV # B 



   8     ASCII EVE B Command  EVE # B 

 

   Following is what the Command field for an SEL-421 Relay used to be stored in the configuration: 

     0~OTTER~TAIL~0~0~C~IP=196.72.197.177:4097 

 

   The C in the 6th position indicates to use the Compressed Raw event command. The new command now looks like 

   the below: 

 

     0~OTTER~TAIL~0~0~4~IP=196.72.197.177:4097 

 

   The 4 replaced the C and indicates to use the 5th field in the drop down list. The index into the drop 

   down list starts with 0 so the 4 is equal to the 5th field.  

 

   Backward compatibility is also preserved. When the MID window is opened it will check if the Event File 

   Type field stored in the Command field is a letter and convert it to its new number.  

 

   The new SEL Event File Type.ini allows for adding up to a maximum of 50 commands. When the file is read 

   all lines that start with a ; is ignored.  The ; allows for adding comments to the file. The format of the 

   file is the title that will be placed in the drop down list box then the command separated by a comma. 

   Add a # in the outgoing command field where the event number goes. When the command is sent to the relay 

   the system will search for the # in the outgoing command string and replace it with the proper event number.  

 

   It is recommended to compose the list of commands before configuring the devices so the order is preserved. 

   If new commands are needed, add them to the end of the file. If new commands are added in the middle or 

   beginning of the file then existing configurations will not have the proper commands. 

 

 

Wavewin H.N.4 - 12/17/2020 

 

1. Data Plotting (Digital Channels): Increased the Digital Channel title characters from 80 to 90. 

 

2. File Manager (Process Templates): Added 2 new fields in Display dialog under the Data Plotting tab. 

   These 2 new fields are called PDF Width and PDF Height. When running Wavewin as a service the monitor 

   coordinates for the PDF are not exact. These fields allow for changing the width and height to fit the 

   PDF report properly. 

 

3. Device Manager (SEL-FTP Events): Added the ability to connect to a SEL Relay using the TCPIP connection 

   to check if there are new files for download. If there are new files then the FTP connection is used to 

   download the new files. This was required because the level 2 password is used to logon to the FTP server 

   and that causes alarms sent to SCADA. This will eliminate a majority of the alarms by only logging on to 

   FTP server if there are new events to download. 

 

 

Wavewin H.N.3 - 12/02/2020 

 



1. File Manager (Copy Files): Corrected a problem when coping files using the Opposite click popup 

   Menu. The system was activating the move drag and drop. This problem has been corrected in this  

   Version.  

 

2. File Manager (Process Templates): When Wavewin reads a Comtrade file it composes the analog channels  

   titles from the 2nd, 3rd, and 4th fields (ch_id, ph and ccbm) in the Comtrade CFG file. For example if  

   the first 4 fields in analog channel information in the CFG file for channel 1 is: 

        1,A1,A,Feeder 780M - A Phase 

   Then the channel title will be: A1 A Feeder 60M - A Phase  

   The three field are separated by a space. 

   Some DME equipment are changing the information in the first two fields from one fault file to another. 

   If a line group is setup to look for channel titles using a string then some channels are not being  

   found because of the changes. Wavewin now deletes the first 2 fields in the name when searching for 

   the 3 Voltage and 4 Current channels for the line group. 

   Also, the same is true for the digital channels. Wavewin uses 2nd, 3rd and 4th fields to compose the  

   name. The same was applied to the digital channels when searching for Breaker and Event channels.  

 

3. File Manager (Process Templates): Added debug information when a channel defined in a line group 

   cannot be found in the file. The Channel name, the line group and the line group filename is written 

   to a Debug.fil file located in the Wavewin Folder. This works for both analog and digital channel. 

 

4. Data Plotting (Analog Channels): Increased the Analog Channel title characters from 40 to 50. 

 

 

Wavewin H.N.2 - 11/25/2020 

 

1. File Manager (Process Templates): When Wavewin reads a Comtrade file it composes the analog channels  

   titles from the 2nd, 3rd, and 4th fields (ch_id, ph and ccbm) in the Comtrade CFG file. For example if  

   the first 4 fields in analog channel information in the CFG file for channel 1 is: 

        1,A1,A,Feeder 780M - A Phase 

   Then the channel title will be: A1 A Feeder 60M - A Phase  

   The three field are separated by a space. 

   Some DME equipment are changing the information in the first two fields from one fault file to another. 

   If a line group is setup to look for channel titles using a string then some channels are not being  

   found because of the changes. Wavewin now deletes the first 2 fields in the name when searching for 

   the 3 Voltage and 4 Current channels for the line group. 

   Also, the same is true for the digital channels. Wavewin uses 2nd, 3rd and 4th fields to compose the  

   name. The same was applied to the digital channels when searching for Breaker and Event channels.  

 

 

Wavewin H.N.1 - 11/11/2020 

 

1. File Manager (Process Templates): Added code to remove all begin and end blanks from the Station 

   name inside the Comtrade CFG file. If blanks are included in the station name then the line group 

   file will not match. 



 

2. File Manager (Process Templates): Added code to look for the first Breaker or Events that triggered 

   In the line group rather than looking directly adding the digital channel information in the DIG file. 

 

3. Device Manager (Tesla FTP Extraction): Corrected a problem when adding the Tesla original filename to the 

   extracted long filename. If the Add Original Filename field inside the Display dialog under the Device  

   Manager tab is set to YES then the code renaming the files when a Tesla file is extracted was adding the 

   original filename twice at the end of the long filenames. 

 

 

Wavewin H.N - 10/30/2020 

 

1. File Manager (Create SER Files): Corrected an error where the digital data being binned into memory  

   was not being freed which caused a memory leak. 

 

2. File Manager (SEL Fault Reports): When setting up the SEL Fault Reports from the Display dialog 

   in the File Manager the Create Fault Report checkbox field is saved to the system templates  

   and the Report path is saved to the systems Wavewin.ini file. If Wavewin is shut down using  

   the Task Manager then the templates are not saved. The templates are saved upon exit but the  

   Wavewin.ini file is saved when leaving the dialog therefore the SEL Fault Reports will not be 

   created if Wavewin was not exited properly. Saving the templates and the Wavewin.ini file  

   has been added when existing the dialog. 

 

 

Wavewin H.M.17 - 09/17/2020 

 

1. File Manager (Automatically Rename Files): Added a new feature to Automatically rename waveform/load  

   files to the IEEE ComNames format. This new feature monitors a folder for waveform/load files with  

   user defined extensions. When a file is detected in the source path or in its included folders it  

   will first move the original file to the Archive path then read the file’s configuration information  

   and rename the file to the destination path. To activate this feature select the Auto Rename Files  

   option under the Options menu/tab. A dialog will be displayed. Enter the Source Path, click the  

   Include Sub Folders check box if needed. Enter the Destination and Archive Paths. Enter all file  

   extensions (*.DAT,*.CEV,*.CFF) and the scan period. If this feature needs to start when Wavewin  

   runs click the Automatically Start Auto Rename Files at Run Time checkbox. The bottom section of  

   the dialog gives a status update on the activity of the process. It displays the last scan time,  

   the original and Renamed filenames and when the next scan will start in minutes. To start the process  

   click the Start Rename button. 

 

 

Wavewin H.M.16 - 08/29/2020 

 

1. File Manager (Create SER Files): Added a new feature to create SER files for each waveform file. 

   This new feature monitors a folder for waveform files with user defined extensions. When a file is  

   detected it will read the file and create a comma delimited SER file from the digital channel  



   activity. The SER file will have the same name as the original waveform file. To activate this  

   feature select the Create SER Files option under the Options menu/tab. A dialog will be displayed.  

   Enter the Source Path, click the Include Sub Folders check box if needed, enter the file extensions  

   (*.DAT,*.CEV,*.CFF) and the scan period. If this feature needs to start when Wavewin runs click the  

   Automatically Start Create SER File at Run Time checkbox. The bottom section of the dialog gives 

   a status update on the activity of the process. It displays the last scan time, the original and  

   SER filename being processed and when the next scan will start in minutes. To start the process  

   click the Start Create button. To create an SER file with all the digital activity from all processed  

   Waveform files click on the Create a Combined SER File check box. Select or enter the path of the  

   Combined file and enter its filename. This allows for adding the SER information into a database  

   from one single file. 

 

   To create the SER files for each file being processed by the Auto Process Templates add a /SER to  

   each line in the Format files being processed. 

 

2. File Manager (Process Batch Templates): Added the ability to specify a /SER command to create 

   SER files for each file being processed. This allows for creating a SER file for each file being  

   processed without having to run the Create SER Files option.  

 

3. File Manager (Zip Marked Files): Updated the zip compression components. This upgrade now 

   allows including folders in the zip file and for adding a password to the zip file. 

 

 

Wavewin H.M.13 - 08/07/2020 

 

1. Data Plotting (Auto Process Templates): When collecting files using the Device Manager the FTP  

   driver gives the option to convert all the date and times assigned to the extracted filenames 

   from UTC to the local time. If the files are processed using the process templates then the  

   date and times are processed using the UTC time. Fault files are legal records and cannot be  

   modified, so the date and times cannot be changed in the files. To have the date and times  

   in the processed DIG files match the date and times in the filename a new option was added 

   to the Process Files section in the Display properties dialog. The new option is called 

   Convert and the drop down box has Yes or No. If the files need to be converted from UTC 

   to local time select Yes. Selecting Yes will convert all the date and times in the DIG files 

   to local time and convert the date and times displayed in the data plotting window when the  

   files are opened from the DIG files. The Display dialog is located under the Options menu/tab 

   in the File Manager. 

 

 

Wavewin H.M.10 - 07/06/2020 

 

1. Device Manager (FTP Get Files): Improved the extraction of Comtrade (.CFG, .DAT, .HDR  

   and .INF) files from an FTP server. The new extraction will open the CFG files an extract  

   the Fault Date and Time from the file and use that date and time to name the long filenames. 

   In previous versions it would use the date and time listed in the DIR extracted from the  



   FTP server. The date and time from the FTP DIR was only accurate to the minute.  

  

2. Data Plotting (Auto Play Waveform): Added three new buttons to the Ribbon and 3 new menu options 

   to the menu system. The new options will auto play the displayed analog and digital channels.  

   The Ribbon’s new buttons are located in the Data plotting's main toolbar and the menu options  

   are under the Data menu. This new feature will move the channels to the left keeping the data cursor  

   fixed at one cycle from the beginning of the display. In the Ribbon system the button  

   to the left of the auto play button is a button to slow the speed of the waveform movement  

   and to the right is a button to increase the speed of the waveform. In the Menu system 

   use the menu options to increase or decrease the speed of the waveform. 

   The auto play Waveform does extensive drawing to the screen. To minimize flicker and  

   slow drawing select a maximum of 7 channels and expand the time scale to see a smooth  

   transition when the analog channels are played. The drawing is done in the background.  

   This allows for marking, deleting, expanding, contrasting, scaling channels and more  

   while the Waveform is being played.  

 

3. Data Plotting (Digital Groups): Added an option inside the Save View dialog to create 

   digital groups. When a record is open, Wavewin will only display the digital channels that  

   changed state. When creating digital groups all of the digital channels may have to be  

   displayed prior to opening the Save View dialog. Before opening the Save View dialog select  

   the All Digital ribbon item in the Waveform tab. This will include all of the digital  

   channels in the Save View dialog. The new Digital Groups section is disabled until the  

   New Group button is clicked. To create a digital group use the Mouse to select the  

   digital channels in the Digital Channel’s list box. Next, click on the New Group button.  

   Once the New Group button is clicked the Digital Group section will be enabled and the  

   Digital Group Name field will have the focus. Type in the name of the new group and hit  

   enter or click the Save button. The table below the Digital Group Name field will be  

   populated with the name of the digital groups in the first column and the number of  

   channels in that group in the second column. When a view is selected with Digital Group  

   defined in the view a new drop down button is added to the Data Plotting main toolbar.  

   The new drop down lists all the Digital Groups in the View. To display a digital group  

   select the group from the drop down menu. By default Wavewin only displays the triggered  

   digital channels for each group. To view all the digital channels in the group click on  

   the All Digital ribbon item in the Waveform tab. 

 

4. Data Plotting (Digital Channels): Increased the maximum number of digital channels from 

   2048 to 4096. 

 

5. Data Plotting (Auto Process Templates): Added a new way to process files. In the past  

   Wavewin would add a WWD to the last field in the filename to indicate a file has been  

   processed. When using third party backup software to move files from one folder to another  

   the third party’s software was constantly copying  back files that were previously  

   processed. It was doing this because it could not find the files since they were renamed  

   by Wavewin. A second option was added to process files according to the file’s save date.  

   In the System Settings dialog under the Data Plotting tab a new field was added to specify  



   the process type. If Rename with ,WWD is selected in the Process Type drop down then the  

   field to the right of the Process Type field changes to Batch Files. The batch files drop  

   down allows for selecting New Files (Files that do not have a WWD as the last field) or  

   All Files. If the By Save Date drop down option is selected then  the field to the right  

   of the Process Type field changes to Start DT. The Start DT allows for setting what Date  

   and Time to start at when processing the files. For example, to process just the last  

   30 days of files set the date and time to 30 days prior to the current date and time. 

    

   Another field was added to give control over how many files get processed during a single  

   session. The Process # field allows for selecting 1 to 256 files per session. 

    

   Softstuf supplies a Fault Report template to process waveform files for fault information.  

   In the Fault Report template there is a field for producing PDF files that gives a fault  

   summary and a screen dump of the faulted area. These PDF files were being produced for  

   all fault files collected and processed. A large number of PDF's were being created that  

   we’re not necessary. An option was added to select what files would produce a PDF. The  

   new field is in the System Settings dialog under Data Plotting tab in the Process File  

   section. The available options are All Files, No Files or Breaker Opt Files. In the  

   fault report template there are 4 columns used to monitor up to 4 breaker digital channels.  

   If one of the 4 breakers operated then a PDF will be saved. 

 

   Corrected a problem when using SAC operations in the Channel designations inside the Line  

   Group files.  

 

6. File Manager (Auto Convert to Comtrade/ComName Rename): Removed a 14 character limitation  

   for the station and device names in the ComName format when renaming files to the long  

   format either directly from the File Manager or through the Auto Convert to Comtrade.   

 

7. File Manager (Auto Convert to Comtrade): When the auto convert to Comtrade tries to copy 

   waveform files to the destination path it was not coping the support files with the  

   data file. This applied to Comtrade files, Emax files, Transcan file and Rochester files. 

   It now copies all support files to the destination path. 

 

8. Device Manager (GE EVT Report): Corrected a problem when requesting the full EVT report  

   From the GE UR Relays. When the driver request the current number of events from the  

   relay the system was not by passing the check for new events for the new GE-D60A Driver. 

 

9. Data Plotting (Process Templates): Added a few new checks to the process template engine.  

   When Comtrade Files are collected it may encounter that the DAT file is collected first  

   then the CFG file. If this occurs then the process template engine tires to process the  

   file before the CFG file is collected and the system sees it as a Replay Plus file. To  

   correct this the system always checks if the CFG exists before processing. Another added 

   check was making sure the save date of the .DAT and .CFG files are greater than one minute  

   from the current date. This was added to avoid conflict with reading files when they are  

   being written to. The last modification was in previous versions before the system processed  



   a file the name of the file was changed to indicate that the file has been processed. The  

   file indication is a WWD added as an optional field in the long filename. If the system  

   stopped before the file was fully processed than it will miss that files data. The filename  

   is now changed once the file has been fully processed. 

 

10.File Manager (Change Filename): Added a new option in the File Manager to change the names 

   of the marked files in a path or all the files in a path. The new option is under the File 

   menu in the menu system and under the File tab in the ribbon. The new option is called  

   Change Filenames. This new feature allows for adding new information to the end of a  

   filename or removing characters from a filename. For example if there are pound signs in 

   a number of file that need to be removed open the dialog select the Remove option, type 

   # in the File String edit field then select Marked Files or All Files and click OK. If 

   there are no marked file in the path then the Marked Files radio button is grayed out. 

 

11.File Manager (Process Templates): Corrected a problem when opening waveform files from  

   the processed DIG file. Since the filename is now marked as processed (add a WWD in one of  

   the optional fields in the filename) after the file is processed then it is not writing  

   the correct filename into the table at process time. To correct this when a double click 

   occurs in the DIG file, the system checks if the file exists and if it does not it adds 

   the WWD to the file and tries to open that file.  

 

 

 

Wavewin H.M.9 – 03/20/2020 

 

1. Device Manager (SEL Fault Reports): Added an option to create an SEL Fault Report 

   text file for each fault file retrieve from the SEL Relays. To activate this new  

   feature open the Display Dialog under the Options menu/tab in the File Manager.  

   Click on the Device Manager tab. Click on the Create a Fault Report for each SEL Fault  

   Retrieved check box. Next, select or enter the path where the fault report files will be  

   saved. The contents of the report are listed below: 

 

 Date: 07/14/20 

      Time: 12:38:32.18 

   Station: BAIN SOUTH  

    Device: SOUTH STREET SET #2  

     Event: CG T 

  Location: +21.62 

   LineLen: 72.71 

   Targets: INST SOTF Level1 EN C G 

 

 

 

Wavewin H.M.7 - 12/17/2019 

 



1. Device Manager (GE EVT Report): Added support to extract the entire list of the events  

   from a GE UR Relay. The existing driver GE-D60 only extracts the latest events according  

   to the last event number in a modbus address. The new driver GE-D60A extracts all the  

   events in the relay during every poll session. 

 

2. Data Plotting (Process Templates): Added a new command in the process templates feature.  

   The New command is called ReportFile. This new command is only recognized if the template  

   name contains “_Fault_Report” minus the quotes. The new report will create a PDF screen  

   dump of the Analog and Digital channels along with a summary of the line. The summary  

   contains a Fault Report, Event Report and a Location Report.  

 

3. Device Manager (FTP Driver): Corrected a problem when the FTP server sends the list report  

   to the FTP client with just line feeds and no carriage returns. A number of SEL Relays  

   are sending the requested list report to the Wavewin FTP client with no carriage returns. 

   This was causing the client to only see the first file in the list.   

 

 

Wavewin H.M.6 - 10/28/2019 

 

1. File Manager (Auto Convert to Comtrade): Added support to perform a number of tasks  

   for the Source Path, Destination Path and Archive Path. There is a new button in the  

   Auto Convert to Comtrade dialog called Advance. The Advance button displays the Advance 

   Settings dialog. This dialog has 3 sections, one for the Source path, one for the Destination 

   Path and the last one is for the Archive path. The Source path section allows for including 

   Sub-folders when scanning for files to convert to Comtrade. The Destination path section  

   allows for renaming the destination files to be named using the IEEE long file naming format. 

   The Archive path section allows for renaming the archive files to the IEEE long file 

   Naming format. It allows for appending all like files into one Comtrade file for an  

   entire year. If append is selected then the drop down list will be enabled asking what to do 

   with the files that have been appended: Delete the files or Backup the files. If Backup 

   is selected an edit box is displayed to define the path where the files are to be moved to. 

 

2. File Manager / Data Plotting (Append Files): After appending files the number of appended  

   files is added to the data plotting’s window header. For example, if 28 files were successfully  

   appended the final result will be displayed in the data plotting window and the window header  

   will look like:  

     28 Appended Files – the first file’s original name – date and time – Values – (file type) 

   Also, the maximum number of files that can be appended was increased from 100 to 400. 

 

3. Data Plotting (SEMI F47-0706 Chart): Added a new option under the Channels tab called 

   SEMI F47 Voltage Sag Chart. This chart is for Voltage channels only. First mark the  

   desired voltage channels in the data plotting window then select the new option. 

   In the chart each channel is display at the voltage sag level on the y-axis and the duration 

   of the sag on the x-axis. Each channel’s dot is colored the same color as it is plotted in the  

   data plotting window. 



 

4. Data Plotting (3-D Drawing): Added a new option under the Channels tab called Draw 3-D Plot.  

   This Draw 3-D plot will draw a maximum of 3 channels. First mark the desired channels in the  

   data plotting window then select the new option. In the plot each channel’s number, title, 

   maximum and minimum values for the entire signal along with the channel’s fault duration in  

   cycles and milliseconds. Each channel’s 3-D plot is colored the same color as it is plotted in the  

   data plotting window. 

 

5. File Manager (Display Dialog – Analog Table Font Size): Added a new option in the File Manager’s 

   Display setting dialog under the data plotting tab. The new feature allows for setting the Analog 

   Table font size. The options are Sizes: 8, 9 , 10, 11, 12, a4 and 16. 

 

6. File Manager (Display Dialog – Duration): Added a new section in the File Manager’s Display dialog 

   under the data plotting tab. The new section is called Duration Calculation. There are two calculations 

   used when determining the fault duration and sag duration. This section allows for modifying these 

   calculations. When a file is open an RMS value is calculated at each sample using a running RMS  

   calculation. After the first full cycle the duration equations are run on each sample using the 

   RMS values. 

 

7. Data Plotting (Harmonic Power Calculator): Added a new power calculator to the data plotting window. The 

   Power calculator requires 1 marked voltage channel and 1 marked current channel. First marked the  

   required channels then select the Power Calculator option under the Data tab. The calculator  

   displays MWatts and MVars for all harmonics of the signal. The following calculations are used:  

o MWatts = (V * I) O Cos(Øv - ØI)  

o MVars = (V * I) O Sin(Øv - ØI)  

 

8. Data Plotting (Digital Search): Modify the search digital channels feature to mark and move  

   the found channels to the top of the digital channels. 

 

9. Data Plotting (Save View): Defaulted the Save View path to be the path where the file is located. 

 

10. Data Plotting (RMS Calibrated Channels): In RMS Calibrated Files added an option in the analog table  

    popup menu to remove the root 2 multiplier from all of the marked analog channels. In the  

    Channel display window added a * in front of each analog channel’s number to show the channel  

    is multiplied by root 2. 

 

11. Device Manager (Days Idle Report): Added a new report in the Device Manager that displays a table  

    listing the number of days idle since a waveform was extracted. The table columns are, Device #,  

    Group #, Days Idle, Last Date, Station, Title and Driver Name 

 

 

Wavewin H.M.5 – 05/27/2019 

 

1. Data Plotting (Emax Driver): Corrected a problem reading Waveform and Long-term files 

   produced from the new Emax 64 bit program. The problem was reading the version number  



   inside the .CTL and .SET files. When reading the version number Wavewin was looking 

   for the V1x.xx. starting at the 296 byte. The newer files have V1x.x. We removed 

   the check for the second . in the version number.   

 

2. Data Plotting (Emax Long-Term Driver): Corrected a problem reading the magnitude of 

   The channels when displaying them in the phasor window. 

 

 

Wavewin H.M.4 - 05/20/2019 

 

1. Data Plotting (Default.LNG): Added support for a Default Line Group to Process Template  

   files for same types of files that have the same analog channel layout but have  

   different station names, such as processing all SEL 311 files. Create a Line Group file  

   called Default.LNG and save the file to the path where all the same types of files are  

   located. 

 

2. Data Plotting (Line Impedance Comtrade): When saving a file as Comtrade Wavewin will 

   save the line impedance values in the Comtrade header file. When the Comtrade file 

   is read it will pick up the Line Impedance values and use them in the Fault Location 

   Dialogs. 

 

3. Data Plotting (Wave Driver): Updated the Wave Audio driver to support the latest  

   format. 

 

4. Data Plotting (Circular Chart): Added support to show negative values in the  

   Circular Chart diagram. All negative values are marked with a small circular 

   at the negative value. 

 

5. Data Plotting (Synchro-phasor Comtrade Files): Added support to read Synchro-phasor 

   (real and imaginary) data saved in the Comtrade file. Wavewin checks the CFG file 

   analog channels for a R or I in the Phase column. If they exist then it will  

   calculate the Phasor from the real and imaginary values and plot the phasors  

   in the Phasor diagram. 

 

6. Data Plotting (Mark and Save): Added two new commands to the template file, + and -. 

   The + command writes the channels maximum value to the values files, and the -  

   command writes the channels minimum value to the values file. Also added the L and G  

   commands for the + and – command to indicate alarm or normal if the value following 

   the L or G is Less than or Greater than.  

   Example: [^1:+:7] for maximum values and [^1:-:7] for minimum values. 

 

7. File Manager (Save As Comtrade): Corrected a problem saving a file from the  

   file manager as Comtrade. The CFG file information was missing the digital 

   channel information. 

 



8. File Manager and Data Plotting (Save As Comtrade): Added support to remove all 

   commas from the Station and Device names before saving the information in the 

   first line in the Comtrade CFG file.    

 

9. Device Manager (RXABORT): Added a new command in the drivers.ini file call RXABORT. 

   Set RXABORT to the maximum time it should take the driver to execute. If it exceeds 

   the RXABORT then it will exit that device and move on to the next device.  

    

 

Wavewin H.M.3 - 03/15/2019 

 

1. Data Plotting (Automatically Append Files): Corrected the auto append when a 

   Comtrade .CFG file is double clicked on. The system was trying to append all 

   common files instead of opening the file in the ASCII Editor. 

 

2. Data Plotting (Mark & Save): Added the Less than (L) and Greater than commands  

   for the new % operator. 

 

 

Wavewin H.M.1 - 02/22/2019 

 

1. Data Plotting (Automatically Append Files): Added support to automatically append 

   a device files within a selected time frame. In the Display Dialog off the File  

   Manager's Option menu there is a new option under the Data Plotting tab to turn on  

   the automatic appending and to specify the time period in minutes. When the automatic  

   appending is On the file manager will scan all IEEE long filenames in the same path 

   and include any files that match the time period, the substation, device and company  

   names. All matching file will be plotted in the same window appended by time. 

 

2. Data Plotting (Digital Toggled Channels): Added support to show only the digital 

   channels that toggled state. In the Display Dialog off the File Manager's Option menu  

   there is a new option under the Data Plotting tab to turn on/off showing only the 

   digital channel's that toggled. 

 

3. Data Plotting (Primary Values): Added support to always open waveform files with 

   Primary values. In the Display Dialog off the File Manager's Option menu there 

   is a new option under the Data Plotting tab to turn on/off showing Primary values  

   when a file is open. 

 

4. Data Plotting (Mark & Save): Added two new template items: F for Harmonic data 

   and % for change in Nominal. Please refer to the help for specific details. 

 

 

Wavewin H.M - 01/28/2019 

 



1. Device Manager (SEL Events): Added support to read the SEL His reports that have  

   an extra column call REF# before the date and time columns.  

 

2. Data Plotting (Move Digital Channels): Added support to move the digital channels 

   using the plus (+) and minus (-) keys. To move digital channels first mark the 

   channels then use the plus key to move them up and the minus key to move them 

   down. 

 

3. Data Plotting (Search Digital Channels): Added support to search for digital channels. 

   To search for certain digital channels select the Search Digital Channels option 

   under the Channel menu. For a single channel search enter the channel title in the  

   search box then press enter. If found the digital channel will be displayed. 

   To search for multiple digital channels enter the channel title in the search box 

   then press the Add button to add it to the Search List. Once all titles are entered  

   press Search. The star Wildcard (*) is accepted in each search. 

   

 

Wavewin H.L.12 - 11/19/2018 

 

1. Device Manager (FTP): Modified the extraction of a single file from the FTP server. 

   The file is extracted once a day. To specify a file add the remote path and name 

   next to the Remote Path field separated by a pipe sign. For example to extract the  

   SOELOG.TXT from the /LOGPATH folder on the server enter the following: 

    \WaveData|\LOGPATH\SOELOG.TXT 

   The first remote path is the path where the files will be extracted that have the  

   extensions entered into the File Extensions field. 

 

2. Device Manager (FTP): Removed the Connect and Disconnect drivers from the FTP  

   LAN-DIRECT, FTP-EVENTS driver. The FTP components automatically connect and 

   disconnect when requesting a List from the FTP server. 

 

3. Device Manager (FTP-MID): Add the polling extensions next to the Remote path 

   in the MID window. Added the byte progress when extracting a file next to the 

   File size field in MID. Added the polling type in the MID window header,  

   Periodic Poll or Poll One Time. 

 

4. Data Plotting (SEL Driver): Added support to ignore the CTR_IA, CTR_IB... if 

   there values are 0 or 1. Also, added the same for PTR_VA, PTR_VB and PTR_VC. 

   This allows for using the CTRW, CTRX, PTRY and PTRZ values instead of the per 

   channel ratio values. 

 

 

Wavewin H.L.11 - 10/24/2018 

 

1. Device Manager (FTP): Added support for wildcards in the File Extension field. 



   To specify files that have certain characters in the filename use wild cards.  

   For example, to extract only TXT that contain TR in the filename add *TR*.TXT  

   to the file extension field. 

 

 

Wavewin H.L.10 - 10/17/2018 

 

1. Device Manager (FTP): Added the ability to extract a single file from the FTP server 

   every time a polling cycle is complete. To specify a file add the remote path and name 

   next to the Remote Path field separated by a pipe sign. For example to extract the  

   SOELOG.TXT from the /LOGPATH folder on the server enter the following: 

    \WaveData|\LOGPATH\SOELOG.TXT 

   The first remote path is the path where the files will be extracted that have the  

   extensions entered into the File Extensions field. 

 

 

Wavewin H.L.9 - 09/26/2018 

 

1. Device Manager (GE D60 Driver): Final release for the GE UR Relay Fault Report extraction. 

 

 

Wavewin H.L.8 - 09/21/2018 

 

1. Device Manager (GE D60 Driver): Corrected a problem with the GE D60 driver 

   extracting the fault reports. The fault report is extracted using modbus and 

   an html file is retrieved. The error was occurring when computing the start 

   number to retrieve. Older firmware versions hold a total of 10 Fault Reports 

   but newer version have 15 Fault Reports. 

 

 

Wavewin H.L.7 - 09/09/2018 

 

1. File Manager (Auto Process Templates): Added the ability to process TIS files. 

 

2 File Manager (Auto Process Templates): Corrected a problem when entering a  

  single line group for the /Line= field inside the Template files. 

 

3. Data Plotting (TIS Driver): Open all TIS files displaying Primary Values. 

 

4. Data Plotting (TIS Driver): Corrected a problem when adding the line frequency  

   and sampling frequency at the end of the filename. 

 

5. Data Plotting (Line Groups - Versioning): Added a new option in the File Manager's 

   Display dialog under the Data Plotting tab to turn On/Off creating a version 

   of the line group files when a file is opened. The default is Off. 



 

 

Wavewin H.L.6 - 08/09/2018 

 

1. Device Manager (GE D60 Driver): Corrected a problem with the GE D60 driver 

   extracting the fault report. The fault report is extracted using modbus and 

   an html file is retrieved. The error was occurring when detecting the end of 

   the html file. 

 

2 Data Plotting (SEL 710 Display Driver): Added support to display the compressed 

  files from the SEL-710 relay. Most CEV files end the waveform data with "SETTINGS". 

  The SEL 710 relay ends the waveform data with the word Global Settings. 

 

 

Wavewin H.L.5 - 07/17/2018 

 

1. Device Manager (GE D60 Driver): Corrected a problem with the GE D60 driver  

   timing out after requesting the number of Fault report Files. 

 

 

Wavewin H.L.4 - 07/12/2018 

 

1. Device Manager (GE D60 Driver): Added the extraction of the FaultReport.htm 

   file to the existing driver. 

 

 

Wavewin H.L.3 - 07/09/2018 

 

1. Device Manager (File Transfer): Added a 3 option to the TXFILE command in the  

   Drivers.ini file. The existing 2 options are /Move and /Copy. The third  

   option added is /Archive. The /Archive option will move the file to an 

   Archive path under the path were the source file exists. The Archive path is 

   created if it does not exist. 

 

2. Device Manager (Long Filenames): Added 2 new options in the Device Manager's 

   Display Dialog to add the #Device Number or the _Device Number or none after 

   the Device Name in the long filenames when extracting files from a device. 

   Also, add a similar option for the Station name. 

 

 

Wavewin H.L.2 - 07/03/2018 

 

1. File Manager/Data Plotting (Email): Added support to email files from Wavewin  

   using Outlook 2016. 

 



2. Device Manager (GE UR Relays): Removed the password checks for the older firmware 

   (7.0 and lower) and newer firmware (7.1 and higher) versions for the GE UR Relays. 

 

 

Wavewin H.L.1 - 06/18/2018 

 

1. Communication Manager: Corrected a problem with moving columns around the 

   Communications Manager and with the Reset button. 

 

2. Fault & Communication Manager: Added support to have the Fault Data Manager  

   and Communications Manager remember the last active directory even if it was 

   a network drive. In previous versions a network drive was not saved due to 

   speed performance. 

 

3. Communications Manager: Corrected a problem with the query fields. 

 

4. Communications Manager: Modified the Line Len, Location, Fault Date and Fault 

   Time columns to Master number, Master Name, Error Date and Error Time in the  

   bottom Information window. 

 

 

Wavewin H.L - 05/29/2018 

 

1. Data Plotting (Adjust File Time): Added an option to adjust the displayed files 

   date to the existing Adjust File's Time dialog.   

 

2. Fault Data Manager (Active Path): Added support to remember the last active path 

   in the Fault Data Manager. 

 

3. Communication Manager: Added a new manager to display all .ERR files group by 

   device. The .ERR files must be in the Long Naming Format. To display the new 

   Communications Manager click on the computer Icon next to the Fault Data 

   Manager Icon. This new manager works the same way as the Fault Data Manager  

   but only displays .ERR files. The Communications Manager remembers the last  

   active path. 

 

4. Device Manager ($File Command): Added support to the existing $File Command to 

   search for key words in a file and put the line in the file into the defined 

   variable. The maximum length of the $File Command is 40 characters. The $file 

   command starts at the end of the file and searches up. 

   Example:  

   RXSTRIP=N00,%^[$C:\Softstuf\SOELOG-(04).TXT:FAULT],D0,C08.X20,Y7,H05,"LOCATION:",@FLOC) 

 

5. Device Manager (RXEXTRACT): Added a new command to Extract a line from a file and 

   using key words. If the key words are found on a line in the file, then that line 



   is put into the specified variable. The maximum length of the RXEXTRACT Command is  

   255 characters. The RXEXTRACT command starts at the end of the file and searches up. 

   Example: 

   RXEXTRACT=^[^EVE]Trends-SOE\^[^STN]-^[HDR]\^[HDR]-SOELOG.TXT:FAULT,FLOC 

   The Filename and Path is specified between the equal sign (=) and the last colon (:).  

   The Search string is defined between the last colon(:) and the comma (,). The Variable  

   name is defined after the comma (,). 

   Example to display the variable in the MID window. 

   RXSTRIP=N00,D0,C08,X20,Y7,H05,"LOCATION:",%^FLOC 

 

6. Device Manager (Edit Driver): Added a new option to the Device Manager opposite click 

   popup menu called Edit Driver. This option will open the active Drivers.ini file and 

   display the devices Driver at the top of the ASCII editor. 

 

 

Wavewin H.K - 03/20/2018 

 

1. Data Plotting (Digital Channels): Corrected a problem displaying the digital  

   channels after marked digital channels are deleted. This problem occurred when 

   there are more digital channels listed then displayed.   

 

2. Data Plotting (SEL Display Driver): Add support for the SEL 751 ASCII Format. 

 

 

Wavewin H.J - 02/25/2018 

 

1. File Manager (Auto Process Templates): Corrected a problem when one template file  

   is specified in the Auto Process Template dialog.   

 

2. File Manager (SOE Manager): Add the path to filename column. Clear the SOE Manager 

   before a refresh if the SOEDTB.DTB file does not exist in the source path. 

 

3. Data Plotting (Mark and Save): The last template and Values file is maintained in 

   the dialog if the Auto Process Template was processed or the Mark and Save dialog 

   is opened from the Data Plotting window. 

 

 

Wavewin H.I - 10/25/2017 

 

1. Data Plotting (Single Ended FL - Three-Phase): Added a new tab to the Single Ended 

   Fault Location Dialog to calculate a Three-Phase Fault Location. The Three-Phase 

   calculator requires 3 faulted voltage channels and 3 faulted current channels.  

   Select the faulted channels from the drop-down lists and enter the positive line 

   impedance magnitude and angle. Click the Calculate button to see the result at 

   the data bar. 



 

2. Data Plotting (Double Ended FL): Added the results of the double ended fault  

   location for Positive, Negative and Zero Sequence to the Report. Click the  

   Report button to see all 3 fault locations. 

 

3. Data Plotting (ABB MDAR Files): Added support to read the ABB MDAR files that have  

   a space before each header and data line. 

 

4. Data Plotting (SEL-321 Driver): Added support to place the trigger bar at the end  

   of the 4th cycle and not at the position of the greater than sign. The greater than 

   sign is defined as the trigger position in relays after the 321 series. The greater 

   than sign is not defined in the SEL 321 Relay manual. 

 

 

Wavewin H.H - 10/01/2017 

 

1. Data Plotting (Single Ended FL - Multi-Phase): Added a new tab to the Single Ended 

   Fault Location Dialog to calculate a Multi-Phase Fault Location. The Multi-Phase 

   calculator requires 2 faulted voltage channels and 2 faulted current channels.  

   Select the faulted channels from the drop-down lists and enter the positive line 

   impedance magnitude and angle. Click the Calculate button to see the result at 

   the data bar. 

 

2. File Manager (Process Templates): Added a new dialog that allows for automatically 

   processing up to 5 templates. To open the new dialog, open the File Manager's Option 

   menu and select the Auto Process Templates menu option. Select the templates to 

   process, enter or browse for the results path, select the files to process then 

   click the Run button to start the process. When a single ended fault location is 

   detected a PDF file will be created with the location results and a screen dump 

   of the faulted channels. A CSV file is created for each template file. The CSV 

   file is named the same name as the template file with a .DIG extension. 

 

 

Wavewin H.G.27 - 09/06/2017 

 

1. Device Manager (Terminal Mode - Inter-Char Delay): Added the ability to  

   pause between port numbers through the Orion. The address field is used to switch  

   between ports on the Orion. If a port number is 2 characters long insert a comma  

   between the two numbers in the address field to pause 1 second insert 2 commas to  

   pause 2 seconds. For example, if the port number is 15 enter 1,5 in the address field. 

   Terminal Mode now handles the comma(s) inserted into the address field to act 

   as an inter char delay for Ethernet connections. 

 

 

Wavewin H.G.25 - 08/08/2017 



 

1. Device Manager (SDC-VAR.INI): Corrected a problem with the SDC-VAR.INI not saving  

   the variables when leaving the MID window. 

 

2. Device Manager (RXVARS): Added a new command in the Drivers.ini file to save the  

   SDC-VAR.INI file. The new command is called RXVARS, to turn on saving the variables 

   add RXVARS=1 to a driver. To turn off saving change the command to RXVARS=0. 

 

 

Wavewin H.G.24 - 08/02/2017 

 

1. Device Manager (Export): Added a message box before exporting devices stating that all  

   CMND, CMND1 and CMND2 passwords will be exported as stars if the Star All Passwords  

   option is set to Yes in the Display dialog. 

 

 

Wavewin H.G.23 - 07/30/2017 

 

1. Device Manager (FTP Driver): Added a new option in the table's Display dialog to 

   add the original file name to the extracted long file name as an optional field. The 

   default is set to Yes. To change this option, open the Display dialog from the Options  

   menu and click on the Device Manager tab and select Yes or No from the FTP drop down 

   list. 

 

 

Wavewin H.G.22 - 07/17/2017 

 

1. Device Manager (FTP Driver): Modified the FTP driver that automatically assigns a time 

   to a file when only the date is available. Added a check to keep the same time and not 

   increment the milliseconds if the previous file name is the same as the current file  

   name. This will ensure that Comtrade files (.DAT, ,.CFG and .HDR) all have the same 

   date and time. 

 

2. Device Manager (SEL Driver): Added an additional check to make sure a space is in front  

   of the LL command if it is not at the start of the line. 

 

 

Wavewin H.G.21 - 06/27/2017 

 

1. Device Manager (SEL Driver): Improved the Line Length extraction when retrieving SEL 

   events file. Added a check to make sure the LL command is followed by a : or =. 

 

 

Wavewin H.G.20 - 06/05/2017 

 



1. Device Manager (FTP Driver): Modified the FTP driver to get all files that have a date 

   and/or time greater than the device's last extracted date and time listed in the SDC-HIS.INI 

   file. When a LIST is requested from the FTP server a DeviceNumber.LST file is saved to the 

   Wavewin path. Files listed in the FTP's LST file have a date and time if the file is within 

   the last 6 months. All other files just have a date. In previous versions, Wavewin would 

   only extract files that have a date and time. It now extracts all files that have a date 

   and/or time greater than the device's last extracted date and time. If there is no time 

   then Wavewin will automatically tag the file with 01:00:00.000. And if there are  

   consecutive files with the same date then the millisecond will be incremented. For example, 

   below shows the files with the same date and the date and time Wavewin assigns: 

 

      Date from the FTP Server Date and Time assigned by Wavewin 

      ------------------------  --------------------------------- 

            Jul 25 2016              08/25/2016 01:00:00.000    

            Jul 25 2016              08/25/2016 01:00:00.001 

            Jul 25 2016              08/25/2016 01:00:00.002 

            Jul 25 2016              08/25/2016 01:00:00.003 

 

   This prevents files from being overwritten that have the same date and no time when using  

   the IEEE long file naming convention to name files. 

   

 

Wavewin H.G.19 - 05/17/2017 

 

1. Device Manager (Star Password): Added a new field inside the Table Display dialog 

   to Star all passwords displayed in the Device Manager and the Device Configuration 

   dialog. The new field is called Star All Passwords and is located under the Device 

   Manager tab. 

 

2. Device Manager (Duplicate Dialog Background Color): Added a new field inside the  

   Table Display dialog to change the background color of the Duplicate Device  

   Configuration dialog. The new field is called Duplicate Dialog Background Color and  

   is located under the Device Manager tab. 

 

 

Wavewin H.G.18 - 05/01/2017 

 

1. Device Manager (Additional SEL Drivers): Added support to the SEL-EVENT1= and SEL-EVENT2= 

   drivers to handle escape code sequence commands. It will now read commands from the  

   'Commands' dialog for sending out event commands. Example: set Command 9 to 'EVE R' 

   in the Device Command dialog. Then set the additional SEL Drivers TXCOMMNAD to  

   SEL-EVENT1=^[^CMND9]. The event command sent to the relay will be EVE R. 

 

2. Device Manager (SER Driver): Modified the SER driver to only issue one date when the 

   start date and end date are the same date. 



 

3. Data Plotting (Change Line Frequency): Added a new dialog to change the Line Frequency of  

   the active data plotting window. The new dialog is accessed from the Data menu under the 

   the Change Line Frequency menu option. 

    

 

Wavewin H.G.17 - 04/20/2017 

 

1. Device Manager (SER Driver): Changed a check for 11 lines in the SER report to only 

   require 6 lines or more. 

 

 

Wavewin H.G.16 - 04/10/2017 

 

1. Device Manager (SEL Additional Drivers): Added two new internal drivers to read  

   different SEL Event types for the same date and time in the History Report. The two 

   new drivers are called: SEL-EVENT1 and SEL-EVENT2. 

 

2. Device Manager (SER Driver): If the date in the SDC-HIS.INI file is greater then 

   10 days from the current date then always issue the SER command 10 Days back from the  

   current date. 

 

 

Wavewin H.G.15 - 04/02/2017 

 

1. Fault Data Manager (Include Sub Folders): Added a new status field to show all the files 

   associated with the devices in the Fault Data Manager. 

 

2. Fault Data Manager (Drag Drop Files): Added a message box confirming to move all files  

   associated with all the marked devices. 

 

 

Wavewin H.G.14 - 03/27/2017 

 

1. Device Manager (SEL Events): Added support to check if an event is a Trip when the Event  

   information is followed by the Target information in an EVE file. In previous version it  

   checked for a T following the Events information. It now checked for a T followed by a  

   space. 

 

2. Fault Data Manager (Include Sub Folders): Added support to include sub folders in the  

   device and information windows. 

 

3. Data Display (Email File): Corrected emailing the wrong file when selecting the email file 

   option inside the data plotting window. 

 



 

Wavewin H.G.13 - 03/20/2017 

 

1. Device Manager (SEL Events): Added support to read the line length when it is defined at the 

   beginning of a line in the settings section of the event. 

 

2. Device Manager (Dialogs): Corrected a number of typos in the Device Manager dialogs. 

 

3. Batch Report (Data Bar): Set the data bar 1.5 cycles from the first RMS trigger in the  

   current channels. 

 

 

Wavewin H.G.12 - 03/14/2017 

 

1. Device Manager (SEL Events): Added support to make the parsing engine parse the first line and 

   second line in the CEV files according to a carriage return at the end of a line. 

 

2. Device Manager (SEL Events): Added support to name the SEL file extensions according to the  

   command issued to the relay if the extensions are defined in the SEL.INI. 

 

3. Fault Data Manager (# of Events): Added support to list all files with the same name but with 

   different extensions. 

 

 

Wavewin H.G.11 - 03/07/2017 

 

1. Device Manager (SEL Events): Added support to specify the names of the SEL file extensions 

   when extracted. A new ini is included with the Wavewin download. The file is named SEL.INI. 

   To change the extension of the SEL compressed files to .CEV and ASCII files to .EVE open 

   the SEL.INI file and specify 32 for the Compressed File field and 33 for the ASCII files 

   field. The Default is set to 1 for the .SEL extension. The SEL.INI is read when the Device  

   Manager table is open. Make sure the Device Manager table is closed before editing the  

   SEL.INI file.   

 

 

Wavewin H.G.10 - 02/14/2017 

 

1. Batch Report (/Template=): Added support for multiple Template files defined on 

   each line in a Batch Mode configuration file. 

 

2. Batch DIG Report (Double Ended): Flipped the order of the Data Plotting Windows 

   when requesting a Double Ended Display. 

 

 

Wavewin H.G.9 - 01/24/2017 



 

1. Fault Report (Comma Delimited Table): Added specific functionality to the comma delimited 

   table to automatically open fault location reports that have the .DIG extension. The table 

   also allows for viewing a fault location report for each entry in the table. It also 

   allows for automatically opening both ends of a line and displaying the double ended 

   fault location dialog. 

 

 

Wavewin H.G.8 - 12/12/2016 

 

1. Data Plotting (Mark and Save): Added a new template command to calculate the maximum value  

   minus the minimum value divided by 2 ((max-min)\2), example <^3:M>. The new M command works 

   on the entire channel not on a sample basis. The <> or [] brackets can be used. 

 

2. Data Plotting (Mark and Save): Improved the trigger capabilities for the :B, :M, :N and :S 

   commands. The trigger now requires a L or G before the value. L is for less than and G is 

   greater than, <^1,^2,^3:NG5000>. If the result of the :M, :B, :S or :N command is true then  

   Alarm is written to the Values file else Normal is written. 

 

 

Wavewin H.G.7 - 12/02/2016 

 

1. Data Plotting (Mark and Save): Added a new template command to calculate the negative sequence  

   magnitude of 3 analog channels, <^1,^2,^3:N>.  

 

2. Data Plotting (Mark and Save): Added a new template command to set a trigger for the :B. :S and 

   :N commands, <^1,^2,^3:N5000>. If the result of the :B, :S or :N command is greater than the  

   trigger then Alarm is written to the Values file else Normal is written.  

 

 

Wavewin H.G.5 - 10/25/2016 

 

1. Device Manager (SysLog): Changed the connect to Syslog to connect to syslog when the 

   Device Manager is opened and closed when the Device Manager is closed. The write to syslog 

   will check if the connection is open if not then it will reconnect to syslog. In  

   previous versions the syslog connection was opened before writing and closed after 

   writing. 

 

2. Device Manager (Lock): Added support to lock the Events path, Events Browse button, 

   Message path, Message Path Browse button, Disk Limit field and the 4 Syslog fields 

   when Lock is set to On. 

 

3. Device Manager (LogCommand - Syslog): Added support to write all Log Commands to the 

   Syslog. In the Drivers.ini file set the LOGFILE=SYSLOG. This indicates to write all 

   log commands to the Syslog not to a file. 



 

 

Wavewin H.G.4 - 10/07/2016 

 

1. Data Plotting (Harmonics): Modified the Harmonics window to not show the mirrored Harmonics. 

   To display the mirrored harmonics, open the properties dialog select the Display Settings 

   tab and select ON for the Mirrored Harms field. 

 

 

Wavewin H.G.3 - 09/14/2016 

 

1. Data Plotting (Line Groups): Added support to plot up to 10 Software Analog Channels (SAC) 

   per line group. The SAC channels are calculated when the line group is selected. 

 

2. Data Plotting (EMAX Display Format): Applied the 64-character analog channel title to EMAX 

   Director formats only. 

 

 

Wavewin H.G.2 - 09/06/2016 

 

1. Data Plotting (Single Ended FL): Added support to select the values to plot in the Single 

   Ended Fault Location. A drop-down list was added next to the Fault Location results to 

   select either the Fault Location values or Fault Impedance. 

 

2. Data Plotting (Single Ended FL): Added support to always display the fault location results 

   in miles. 

 

3. System (Wavewin Display Coordinates): Added support to display Wavewin maximized if  

   Wavewin was previously displayed in a connected monitor that was removed from the list of  

   connected monitors.  

 

 

Wavewin H.G.1 - 08/28/2016 

 

1. Device Manager (Terminal Mode-Backspace): Added support to handle all backspace commands  

   transmitted from the connected devices. 

 

2. Device Manager (Browse for Folders): Added support to display all network folders in the 

   Browse for Folders Dialog used in the Export Dialog, Search File Contents Dialog and the  

   Device Configuration Dialog. 

 

3. Device and File Manager (Search File Contents): Added checks to make sure the Search Path  

   and Report Path exist before starting the search. Added status fields to show the progress  

   of the search. Also, added a new button to view the results of the search in a comma delimited  

   table. 



 

4. Device Manager (EXIT Command): Added support to only execute the exit command if the ports and 

   mid passed parameters exist. 

 

 

Wavewin H.G - 08/16/2016 

 

1. Device Manager (Backup Syslog): Added two new fields in the Save and Archive (Properties) Dialog  

   to define the Backup Syslog host and Port Number. If these fields are populated, then all outgoing  

   terminal commands will be written to the backup syslog. 

 

2. Device Manager (SSH Telnet Client): Changed the SSH Telnet Client protocol name to SSH Client 

   in the Device Configuration Dialog. 

 

3. Device and File Manager (Search File Contents): Added a new menu option to the Device Manager's  

   Option menu and to the File Manager's File menu to Search the Contents of a File. The option  

   is also available under the Device Manager's right click popup menu. The Search File Contents  

   Dialog allows for defining the Search: 

     Start Date - Checks if the File's Save Date is equal to or greater than the Start Date. 

     End Date   - Checks if the File's Save Date is equal to or less than then the End Date. 

     Search Path - Enter the search path. 

     Include Sub Folders - Check to include all sub folder under the Search Path. 

     Extensions - Enter the file extensions to search separated by commas. 

     Search String - Enter the search strings to search for separated by commas. 

     Report Path - Enter the Path where the results file will be saved. The results are saved 

                   to a comma delimited CSV file. 

   Button Options: 

     Save - Save the entered search fields to a txt file. 

     Save As - Save the entered search fields to a new txt file. 

     Open - Open an existing txt file. 

     Search - Start the search. After the search is complete the search dialog is closed and the 

              results will be opened in a comma delimited table. 

     Close - Close the search dialog. 

 

 

Wavewin H.F - 07/26/2016 

 

1. Device Manager (Syslog): Added two new fields in the Save and Archive (Properties) Dialog to 

   define the Syslog host and Port Number. If these fields are populated, then all outgoing terminal  

   commands will be written to the syslog. 

 

2. Device Manager (SER Driver): Added the Window's Directory Username to the SER long filename. 

 

 

Wavewin H.F.1 - 07/15/2016 



 

1. Data Plotting (LNG Line Groups): Removed the re-processing of the SAC channels when the Adjust Offset  

   is called in the line group .LNG that has the setting Offset=Y. 

 

 

Wavewin H.F - 06/15/2016 

 

1. Data Plotting (LNG Line Groups): Added a new feature in the line group .LNG files called Offset=Y.  

   This new feature will automatically apply the adjust offset to the line group channels when the  

   line group is selected. 

 

2. Data Plotting (Digital Channel Spacing): Added a new feature to allow for changing the spacing  

   between the digital channels. The new option is available in the data plotting properties dialog 

   under the Display Setting tab. To increase or decrease the spacing between the digital  

   channels select a number from the Digital Height drop down list. 

 

3. Data Plotting (Digital Channel Color): Added a new feature to allow for changing the triggered  

   color portion of the digital channels. The new option is available in the data plotting properties  

   dialog under the Colors tab. To change the color of the triggered portion of the digital  

   channels select a color from the Digital Triggers Colors drop down list. 

 

 

Wavewin H.E - 06/02/2016 

 

1. Device Manager (SSHTelnet): Added support to connect to a SSHServer. There is a new option in the  

   Device Configuration dialog under the Protocol list called SSH Telnet Client. Enter the IP address,  

   Port Number, Username and Password for the connection.  

 

2. Device Manager (Terminal Mode Control Characters): Corrected an extra space character being transmitted  

   when a CTRL-Char is pressed. 

 

 

Wavewin H.D - 05/17/2016 

 

1. Data Plotting (Fluke 435): Added support to read the Fluke 435 Power Quality Analyzer files. The file  

   must be in a comma delimited format. To display the Fluke file first convert it to a comma delimited  

   file in excel. In the Wavewin File Manager move table cursor to the file, open the Drivers menu and  

   select the Comma Delimited Driver. 

 

2. File Manager (Tesla Records): Added support to automatically convert the Tesla Proprietary file to the  

   IEEE Comtrade Binary 1999 format using the File Manager's Auto Convert to Comtrade dialog.     

 

 

Wavewin H.C - 04/29/2016 

 



1. Device Manager (Terminal Mode): Allowed for recursive escape code sequences in terminal mode's  

   programmable function keys. 

 

2. Device Manager (Terminal Mode): Allowed for pause commands in terminal mode's programmable function  

   keys. 

 

 

Wavewin H.B - 04/03/2016 

 

1. Device Manager (Terminal Mode): Added support to allow for the backspace key when typing in  

   terminal mode. When the backspace key is pressed a Ctrl-H is transmitted to the connected 

   device, the last typed character is removed from the terminal window and the cursor is move  

   one-character back. 

 

2. Device Manager (Terminal Mode): Added the reserved function keys AUTO CONNECT and AUTO DISCONNECT. 

   The AUTO CONNECT will be automatically executed when terminal mode is opened. The AUTO DISCONNECT 

   can be manually executed when a terminal session is completed. The AUTO CONNECT automatically  

   executes the commands defined in the AUTO CONNECT function key.  

   Example: 

          Title              TXCommand 

          -----              -------- 

       AUTO CONNECT         ACC^[13;CMND;13]PORT ^[ADDR;13]ACC^[13;CMND1;13] 

      AUTO DISCONNECT       ^[04]QUIT^[13] 

 

3. Device Manager (Terminal Mode): Added support to automatically execute the AUTO DISCONNECT when 

   exiting the Terminal Window if the connection is still valid. A message will be prompted  

   requesting the user to wait until AUTO DISCONNECT has completed. 

 

4. Device Manager (Terminal Mode): Added support to read the CMND, CMND1 and the address fields 

   in the function keys. 

 

5. Device Manager (Terminal Mode): Added a new menu option under the Option menu. The new option is 

   Save As. This allow for saving the terminal session to an ASCII text file. 

 

6. Data Plotting (Mehta Driver): Added support to read the Mehta SCF file when it has an extension TXT. 

   The Mehta driver first checks for the *.SCF file in the path where the file to be plotted is located. 

   If it is not found it next check for the *.SCF file in the defined header path. If it is not found 

   in the header path it then checks for the *.TXT file in the same sequence. 

 

7. Reports (SOE List): Added support to save the Trigger date and time fields as two separated columns  

   when using the Save and Save As menu options. The day, month, year, hour, minute, seconds and  

   milliseconds in the table are separated as single columns for easy search and sort. 

 

 

Wavewin H.A - 03/08/2016 



 

1. Device Manager (FTP-Unzip): Added support to use the Zip Files Date and Time for the long 

   file naming format when an invalid date is returned for the files contained in the downloaded 

   zip file. 

 

 

Wavewin H.9 - 03/03/2016 

 

1. Device Manager (FTP): Added support to read the FTP dir from the ABB REC-650 Relay. 

 

 

Wavewin H.8 - 10/25/2015 

 

1. Date Plotting (Adjust Offsets): Added a new menu option called Adjust Offsets under the Options menu. 

   The Adjust Offsets feature finds the maximum and minimum values between the data bar and RMS bar and 

   applies the following equation to each sample: (max-min)/2)+min. The adjust offsets is applied to the  

   marked analog channels. If no channels are marked, then it is applied to all visible channels. 

 

 

Wavewin H.7 - 10/12/2015 

 

1. Date Plotting (Mark and Save: Unbalance): Added a new template command to calculate the unbalance of 3 

   analog channels using the DFT magnitude, <^1,^2,^3:B>. The unbalance command finds the largest and  

   smallest magnitude of the 3 channels, the result is the difference between the largest and smallest. 

 

2. Date Plotting (Mark and Save: Skew): Added a new template command to calculate the skew of 3 analog 

   channels using the angles, <^1,^2,^3:S>. The skew command adds the angles for the 3 specified channels. 

   One of the 3 analog channels must be marked as a reference channel.  

 

3. Date Plotting (Mark and Save: Header): Added a new template command to add a header to the Values file. 

   To add a header to the Values file, define the first line in the template file with <Header>= followed  

   by the header information. For example, the following two lines define the header and the data of the  

   Values file: 

 

         <Header>=  Station, Device, Date, Time, RMS, Angle 

         <Station>, <Device>, <Date>, <Time>, <^1:R>, <^1:P>   

 

4. Date Plotting (Mark and Save: Use Default): Added a new check box in the template section to Use the  

   Default save. The Use Default check box will automatically write the visible analog channel columns  

   separated by commas for all visible analog channels in the Values notepad. The header for each column 

   is added to the values file on the first line. 

 

 

Wavewin H.6 - 09/30/2015 

 



1. Date Plotting (Passed Parameters-Prefault Report): Added two new passed parameters  

   /Line= and /Template="". 

   The /Line= parameter specifies what line group to apply when a file is open using the passed parameters.  

   /Line= can specify a specific line group or ALL which indicates to open all line groups. The  

   /Template="" specifies what template file to use when creating automatic reports. 

    

   Example passed parameter: "c:\files\*.DAT" /Line=All /Template="c:\template\create-report.txt" /Exit 

 

   The above example will open each file with an extension of .DAT, select the first line group then apply 

   the template. It then selects the next line group and applies the template and so on until all line  

   groups have been selected. After all line groups have been selected and the template applied to each  

   line group the software will close using the /Exit command. 

 

   The template report is saved to the same path where the template file is located. 

 

2. Date Plotting (Passed Parameters-On Demand DEFL): Added a new passed parameter to automatically do a  

   double ended fault location. The new passed parameter is FLAuto.RUN. When the software sees the  

   FLAuto.RUN file it opens the file, reads the two fault files path and filename and line groups  

   (if needed). It opens the two files, applies the line groups, tile the two files, opens the double  

   ended fault location window, requests a report then closes Wavewin. 

 

   Example FLAuto.RUN File: 

 

   "C:\Faultlib\041002,130008523800,,Near Side,Transcan1991,.CFF" /Line=F35 

   "C:\Faultlib\041002,130008531157,,Far Side,USI_2002,.CFF" /Line=S23 

 

   The fault report is saved to the same path where the near side file is located. 

 

3. Device Manager (Change Passwords Dialog): Added an option in the User Entered Change Passwords  

   dialog that will show/hide the text entered the password fields for the 7 level passwords.  

   The new option is a checkbox located at the bottom of the dialog called Show Text. Click the  

   checkbox to show the entered characters. The title of the checkbox will change to Hide Text. Click  

   the checkbox again to hide the entered text. To open the change password dialog, select the Change  

   Device Password menu option under the Options menu then select the Specified By User submenu option. 

 

 

Wavewin H.5 - 09/21/2015 

 

1. Date Plotting (Line Frequency): Allowed for the line frequency to be specified as a real number  

   with 2 decimal digits of accuracy.  

 

2. Date Plotting (SAC Angle Calculations): Added phase angle conversion equations to mitigate discontinuity  

   in the plotted traces by ensuring that all angles are represented between -180 and 180 degrees. 

 

 



Wavewin H.4 - 09/05/2015 

 

1. Date Plotting (Edit Mark Analog Scans): Added a new dialog to edit the Marked Scans. The new dialog  

   is accessed from the Edit Marked Scans menu option under the Values menu. The Edit Marked Scans dialog  

   allows for adding comments to each scan and for deleting existing scans. Each comment has a maximum of  

   40 characters. To add a comment double, click on the comment fields in the table, the editor will be  

   displayed. The up and down arrow keys will move the editor to the next or previous comment fields. To  

   exit the editor press the Escape key. To view the comments for each scan in the data plotting window  

   mouse over the marked scan tick marked displayed above each marked scan. To delete scans from the list  

   check the box next to the scans then click the Delete button.  

 

2. Date Plotting (Double Ended Fault Location): Added a new button to view and save an ASCII report for the  

   fault location. The new button is called Report. The report button will save and display an ASCII report  

   for the current fault location. The report is saved to the same folder where the open files are located  

   and is named in the following format: 

       Current Date, Current Time, Near Side Station, Near Side Line, Far Side Station, Far Side Line,  

       Fault Location.TXT 

   After the file is saved the report is displayed in a rich text editor. The editor allows for adding  

   information to the report. 

    

3. Date Plotting (Single Ended Fault Location): Added a button to view and save an ASCII report for the  

   fault location. The new button is called Report. The report button will save and display an ASCII report  

   for the current fault location. 

   The report is saved to the same folder where the open file is located and is named in the following  

   format: 

       Current Date, Current Time, Station, Line, Fault Location.TXT 

   After the file is saved the report is displayed in a rich text editor. The editor allows for adding  

   information to the report. 

 

4. Date Plotting (Double Ended Fault Location): Added more logic to the unit’s selection for the line length. 

   If the line length units are selected as percentage then the line length is automatically defaulted to  

   100. 

 

5. Date Plotting (Sequence Components): Corrected the header information for the Sequence Components dialog.  

 

6. Device Manager (Edit the Command Fields): Added a new dialog to edit the 12 available Commands for the  

   selected device. To open the commands dialog, select the Commands dialog from the Device manager or right  

   click in the table and select the Command menu option in the popup menu. 

  

 

Wavewin H.3 - 08/05/2015 

 

1. Date Plotting (Mark Analog Scans): Added a menu option and shortcut key to easily mark Analog scans.  

   The new menu option is under the Values menu called Mark Scan. The shortcut key is Ctrl-S.  

 



2. Date Plotting (Navigate to Marked Analog Scans): Added a menu option and shortcut key to easily  

   navigate to the marked Analog scans. The new menu option is under the Values menu called Next Mark Scan.  

   The shortcut key is Ctrl-X. 

 

 

Wavewin H.2 - 06/15/2015 

 

1. Date Plotting (Mark and Save): Improved the Mark and Save Sample date window. Below is a list of changes: 

 

   A. Changed the Mark and Save menu option under the Values menu to open the Mark and Save Window. 

   B. Added a Template Section to view the contents of the template and to select the active template  

      from a drop down menu. New Template files can be added to the drop-down list by using the Browse  

      button. 

   C. Added a Mark button inside the Mark and Save window to add sample data to the Values window. 

 

2. Date Plotting (Emax Driver):  Added support to read the correct Emax format when the version  

   information is not available in the CTL file. 

 

3. Device Manager (CMND6): Added the CMND6 variable from the drivers.ini file to get access to each device  

   Save Path. 

 

 

Wavewin H.1 - 06/05/2015 

 

1. ASCII Editor (CR/LF): Added support to read an ASCII file with any combination of the CR LF at the  

   end of a line. 

 

2. Date Plotting (VFT Data): Added a new display driver to read VFT Data files. 

 

3. Data Plotting (Auto Scale ++ Mode): Added a new setting in the properties dialog to switch between  

   Dynamic mode and fixed mode for the ++ Auto Scale. Dynamic scales each channel to the maximum  

   display for each channel. Fixed mode scales each channel to the average value for all  

   displayed channels. 

 

4. Data Plotting (Pick, Mark and Save): Added new fields that can be defined in the Format files.  

   The new fields are: 

 

 <Device> - Writes the Device name in the Values file. 

 <Cycles> - Writes the number of cycles from the fault bar to the data bar in the  

                   Values file. 

 <DeltaX> - Writes the DeltaX value from the fault bar to the data bar in the  

                   Values file. 

 

5. Data Plotting (Pick, Mark and Save): Corrected a data type problem when writing the date and time  

   at the cursor position to the Values file. 



 

6. Device Manager (RXSAVE): Added a feature to the RXSave command that will append to existing files.  

   Previous versions always overwrote the existing file. 

 

7. Device Manager (RXSAVECRC): Added a new RXSAVE command called RXSAVECRC. This new command will  

   compute the CRC for an entire file and add the CRC value to the name of the file. This new command  

   always overwrites the existing file. 

  

 

Wavewin G.Z - 05/05/2015 

 

1. Data Plotting (Phasors): Updated the phasor scaling after isolating channels in a view.  

 

2. Data Plotting (Double Ended Fault Location): Added Fault Resistance to the double ended calculator.  

   Also added the ability to select the units for the line length. 

 

3. Data Plotting (Emax Driver): Added support to read Emax's new format files with channel titles 64  

   characters in length. 

 

4. Data Plotting (SEL Driver): Added support to read SEL's CT and PT ratios from the CEV header section. 

 

5. Data Plotting (Comtrade Driver): Added support to default the Scale Factor and B factor inside the CFG  

   file if there is no value defined. A message box is displayed indicating that the values have been  

   defaulted. 

 

6. Data Plotting (Single Ended FL): Added a check that prevents a division by zero when the Z1 and Z0  

   angles are set to 0. 

 

7. Device Manager (SEL Driver): Increased the buffer to support line lengths greater than 1024 characters. 

 

8. Device Manager (Import Devices): Optimized for faster performance when importing devices in overwrite  

   mode. 

 

9. Device Manager (Dynamic Import): Added checks for the following: ignore Device's to be deleted if they  

   do not exist, report if a device number is out of range (1..2000) or invalid.  

 

10. File Manager (ASCII Editor): Increased the buffer to support line lengths greater than 1024 characters. 

 

 

Wavewin G.Y - 04/16/2015 

 

1. Device Manager (Change Device Passwords): Added 7 Level Passwords to the Change Device Password Dialog. 

 

2. Device Manager (Encrypted Device Passwords): Moved the Change Device Password using an Encrypted file  

   from the Change Device Passwords dialog to a menu option under the Change Device Password menu option  



   under the Device Manager Option menu.  

 

3. Device Manager (Memory Optimization): Removed memory for obsolete commands, RXSTART, TXLOGON, TXEND  

   and TXSTART. Dynamically cleared the data space of all drivers. Data space is only loaded when the  

   driver is running. Move to an inheritance-based system from an instance-based system. 

 

4. Device Manager (Drivers.ini Path and Name): Added a new field in the Save and Archive (Properties)  

   dialog to specify the path and name of the Drivers file to use when polling the devices. 

 

5. Device Manager (Terminal Mode Logging): Log terminal mode commands if their length is greater than or  

   equal to 1 character. This eliminates logging CR with no text. Cleared the buffer after each command  

   is logged. 

 

6. Device Manager (CR and LF in Files): Removed Carriage Returns and Line Feeds from lines that have more  

   than 1024 characters.   

 

7. File Manager (ASCII Editor): Added support to read the tab ($09) command in the ASCII editor. 

 

 

Wavewin G.X - 02/26/2015 

 

1. Data Plotting (SEL Display Driver): Added support to handle analog values in the compressed format  

   that exceed the compilers limit by defaulting the exceed values to zero. 

 

 

Wavewin G.W - 02/23/2015 

 

1. Data Plotting (Double Ended Fault Location): Added a graphical interface to show the fault location 

   on the line from both the near and far ends of the line. 

 

2. Data Plotting (Double Ended Fault Location): Create a text file report when the fault location is  

   calculated. The report file is saved to the Wavewin path and is called WAVEDEFL.DTB. 

 

3. Data Plotting (SAC H=0): Added support to plot the DC Offset of a channel using the SACs. Example  

   to plot the DC Offset of Channel 3 enter +3/H=0/u=Amps/ or +3H=0/u=Amps/ in the Channels Operators  

   field. 

 

4. Data Plotting (Append Open Files): Corrected a problem when Appending Open Data Files. The process  

   of copying the existing data plotting variables to the new appended window was causing an exception  

   error. 

 

 

Wavewin G.V - 01/28/2015 

 

1. Device Manager (FMS_Settings.txt): Added support to automatically read the path where the  



   FMS_Devices.ini, FMS_History.ini and FMS_Params.ini files are located from the field inside the  

   FMS_Settings.txt file.  

   The path is defined as: 

 

     Dynamic Path=C:\SEL\Update 

 

2. Device Manager (LDP and SER Data): Added support automatically read the number of days to buffer back  

   for reading LDP and SER data. The setting is defined as: 

    

     DAYS BUFFER=20 

 

3. System (/Comtrade passed parameter): Added a new option to the /Comtrade passed parameter. The  

   /Comtrade=3 option will open the specified event files, select the default view then save only  

   the channels in the default view to a Comtrade 1999 Binary file format.  

 

 

Wavewin G.U - 12/29/2014 

 

1. Device Manager (Auto Configuration): Added support to read the device save path and Communication 

   Processor ID number from the specialized Device import engine. The Communication Processor ID is 

   saved in the CMND7 field in the Command field and the save path is saved in CMND6. 

 

2. Device Manager (CMND 7): Added a CMND7 field to hold the Communication Processor ID number. CMND7 is 

   saved in the Device's command field. 

 

3. Device Manager (FMS Devices): Added support to automatically monitor for FMS_DEVICES.INI in the Wavewin 

   install path from the DUNRENAME command. When FMS_DEVICES.INI is detected Wavewin will shut down the MID 

   window then close the Device Manager table. If ports mid is defined as passed parameters, then Wavewin  

   will automatically restart the Device Manager table within 2 minutes from closing, then it will open  

   the MID window if they are not running. When the Device Table is open it will add, modify or remove the  

   devices defined in the FMS_DEVICES.INI. The FMS_DEVICES.INI must be in the same format as the Device  

   Manager's export format. 

 

4. Device Manager (FMS Params): Added support to automatically monitor for FMS_PARAMS.INI in the Wavewin 

   install path from the DUNRENAME command. When FMS_PARAMS.INI is detected Wavewin will shut down the MID 

   window then close the Device Manager table. If ports mid is defined as passed parameters, then Wavewin  

   will automatically restart the Device Manager table within 2 minutes from closing then it will open  

   the MID window if they are not running. When the Device Table is open it will read and update the  

   Save and Archive (Properties dialog) with the fields defined in the FMS_PARAMS.INI. 

 

5. Device Manager (FMS History): Added support to automatically monitor for FMS_HISTORY.INI in the Wavewin 

   install path from the DUNRENAME command. When FMS_HISTORY.INI is detected Wavewin will shut down the MID 

   window then close the Device Manager table. If ports mid is defined as passed parameters, then Wavewin  

   will automatically restart the Device Manager table within 2 minutes from closing then it will open  

   the MID window if they are not running. When the Device Table is open it will read FMS_HISTORY.INI and  



   update the Device polling date and times in the SDC-HIs.INI. The format for the FMS_HISTORY.INI is  

   device title, date and time: 

 

 Device 112,12/01/2014 03:21:36.437 

 Device 148,07/21/2014 12:21:36.437 

 Device 222,09/15/2014 23:21:36.437 

 Device 283,10/26/2014 07:21:36.437 

 

   All blank lines and lines that start with a ; are ignored. 

 

6. Data Plotting (SACs in Views): Added support to save SAC channel names and operators in a User  

   defined view. The SAC operator is saved next to the Channels name surrounded by brackets. 

 

              20,Add Channels 1 2 3[+1/+2/+3/u=A/] 

              21,Add Channels 5 6 7[+5/+6/+7/u=V/] 

 

   The SAC channels are calculated when the view is selected. 

 

7. Data Plotting (Open View Automatically): Added an option to have a default view automatically  

   displayed when a specific file type is opened. To create a default view, open the desired event file, 

   select the analog and digital channels for the view and press enter to show only the selected  

   channels. Next select the Save View menu option under the View menu. Enter the path where the 

   event is located. The View's file name is automatically defaulted to the extension of the displayed 

   file (keep the default name). Click OK to save the view. Close the data plotting window. In the  

   file manager select the Display menu option under the Options menu. Select yes for the Open View 

   field under the Data Plotting settings section. Click OK to save. Open one of the event files that 

   has the same extension as the view's filename. The view is saved with the .VIW extension. 

 

8. System (/Comtrade passed parameter): Added a new option to the /Comtrade passed parameter.  

   The /Comtrade=2 option will open the specified event files, select the default view then save only  

   the channels in the default view to a Comtrade file. The Comtrade file is in the 1991 ASCII format  

   and is saved to the same path where the event file is located and named using the same name as  

   the event file.  

 

 

Wavewin G.T - 11/11/2014 

 

1. Device Manager (SEL Driver): Eliminated the problem with SEL history date and event date mismatch by  

   requesting the files using their file ID number listed in the history. The ID will only be use if  

   the ID's are equal to or greater than 10000. 

 

2. Device Manager (Close Gracefully): Added support to trap the WM_Close message sent to Wavewin when the  

   program is shut down by Always Up when running as a service. 

 

 



Wavewin G.S - 10/22/2014 

 

1. Data Plotting (ERLPhase Comtrade Converter): ERLPhase added an option to the Comtrade converter DLL 

   to convert all files contained in the original file or just the high-speed file. To set the converter 

   option open the Driver Configuration dialog located under the Option menu. Next select the  

   NXTPhase-Tesla driver then select the convert files option. 

 

2. Device Manager (FTP Save Path): Increased the saved path for the FTP extract files from 80 characters  

   to 255. 

 

3. Device Manager (FTP Mehta): Added support to name the Mehta .X01 long file names for display in Wavewin. 

 

4. Data Plotting (SEL Driver): Added support to read and display the analog channels from the  

   Compressed/ASCII format. The compressed/ASCII format has just the date and time and channel titles  

   in the header section. 

 

5. Data Plotting (Save As Comtrade): Corrected a problem with Saving RMS calibrated data values when the  

   "Convert RMS calibrated date to peak type is set to yes. The conversion during saving to Comtrade will 

   be applied in the data plotting window only and the data type must be set to RMS Type. 

 

 

Wavewin G.R - 09/03/2014 

 

1. Data Plotting (Harmonics Window): Display the percentage of DC Offset in a channel as Harmonic 0.  

   Harmonic 0 is displayed as the first harmonic in the table and in the histogram view. 

 

2. Data Plotting (Reference Vector): Added a new menu option under the View menu to display the phasor 

   vector at the Reference Bar to measure Neutral Shifts. The new menu option is called Reference Vector. 

   The new menu is an On/Off feature defined by a check next to the menu option. Checked equals display 

   vector and unchecked hides the vector. 

 

3. Data Plotting (LPG and R Line Groups): Added support to read the channel colors from the line groups  

   defined in the Comtrade .DAT file corresponding .LPG files and from the R***.inf files. 

 

4. Data Plotting (Set Data Bar): Added a new menu option under the View menu to automatically set the Data 

   Bar position to 2 cycles from the Fault bar. If this option is turned on the data bar is automatically 

   positioned 2 cycles from the fault bar when opening files. The new menu option is called Auto Set Data  

   Bar. The new menu is an On/Off feature defined by a check next to the menu option. Checked equals  

   automatically set the data bar to 2 cycles from the fault bar and unchecked sets the data bar one cycle  

   from the first sample. 

 

5. Data Plotting (Single Ended FL): Added support to automatically fill in the V,I and N channels drop 

   down list from the first 3 marked channels in the active data plotting window. 

 

6. Data Plotting (Double Ended FL): Added support to automatically reference VA as the referenced channel 



   for both near end and far end windows if no analog channels are marked in the displayed windows.   

 

 

Wavewin G.Q - 08/10/2014 

 

1. Data Plotting (Scale by Units): Made the Auto Scale default setting to Units for new installations. 

 

2. Data Plotting (SEL 187): Corrected the units for the analog channels for the SEL 187 ASCII format. 

   Previous versions were displaying the units as kV. The units are now being defined as V. 

 

3. Data Plotting (Scale by Units): Added a new Auto Scale mode to Scale channels according to the  

   channel units. Current channels are scaled with respect to each other and Voltage channels 

   are scaled with respect to each other. 

 

4. Data Plotting (Super Impose): Added support to have multiple super imposes in the analog channel 

   plot screen. 

 

5. Data Plotting (Plot Single Ended FL): Added support to plot the Single Ended Fault Location in the  

   Data Plotting window. A new button was added to the Single Ended Radial and Reactance tabs to 

   plot the FL for the whole record or between bars. 

 

6. Data Plotting (Plot Double Ended FL): Added support to plot the Double Ended Fault Location in the  

   Data Plotting window. A new button was added to the Double Ended dialog to plot the FL for the whole  

   record or between bars. 

 

7. Data Plotting (Plot FL): Corrected a problem with the Fault Location's dialog Plot drop down menu  

   buttons text being displayed in the same color as the button's color in version Window's 7 or greater.  

 

 

Wavewin G.P - 07/20/2014 

 

1. Data Plotting (Scale Table Column): Added support to increase or decrease the Scale column value 

   when a channels Amplitude is increased or decreased. 

 

 

Wavewin G.O - 05/08/2014 

 

1. Device Manager (BPR Driver): Added support to read the Event Files from the BPR relays. 

 

 

Wavewin G.N - 04/23/2014 

 

1. Device Manager (EPM and Nexus): Added support to read the Waveform logs from the Nexus and  

   EPM relays. 

 



 

Wavewin G.M - 04/10/2014 

 

1. Data Plotting (Fast SAC): Corrected a problem with the + and - sequence equations being flipped. 

 

 

Wavewin G.L - 03/23/2014 

 

1. Device Manager (Bitronics-W): Added a new command to extract only the Waveform files from the Bitronics 

   devices using the FTP protocol. 

 

2. File Manager (Lock State): Added support to not allow a user to delete files/records from the tables if  

   the system is in the Lock state. The Lock State is set in the Device Manager Save and Archive  

   (Properties) dialog. 

 

3. Data Display (REL Driver): Added support to display the ABB REL 300 series files. 

 

 

Wavewin G.C - 09/30/2013 

 

1. Device Manager (SETSYSVAR): Added a 3rd parameter field in the SETSYSVAR command to specify the CMND 

   number to change (0=CMND, 1=CMND1 ... 6=CMND6). 

 

2. Device Manager (Change Device Passwords): Added support to change the device password on multiple 

   marked devices in one request. 

 

 

Wavewin G.9 - 09/06/2013 

 

1. Device Manager (FMS Data): Added a check to extracting the SER data to make sure an appended file is 

   not deleted if no new SER filtered data is extracted during a poll. 

 

 

Wavewin G.9 - 09/02/2013 

 

1. Data Plotting (Replay Plus Driver): Corrected reading the digital channel's data bytes in the Replay 

   Plus Driver. In previous versions the digital data bytes were read from left to right. In this 

   version the bytes are read from right to left. 

 

2. Device Manager (FMS Data): Removed the write to file error checking. This was causing problems with 

   I/O checking variables. 

 

3. Device Manager (Change Passwords): Added a new feature to read device password information from an  

   encrypted data file.  

 



 

Wavewin G.8 - 08/20/2013 

 

1. Device Manager (% Disk Used Limit): Added a new option in the Device Manager's Save and Archive dialog  

   called % Disk Used Limit. This field allows the user to select at what percentage the disk used space  

   reaches before shutting down the polling process. This stops the polling process when there is limited  

   disk space available on the defined Events Path drive. 

 

 

Wavewin G.7 - 08/15/2013 

 

1. Fault Data Manager (Device List): Added the polling status fields and Events Path to the Fault Data  

   Manager's device list. The device list is displayed from the Options menu. 

 

 

Wavewin G.6 - 07/15/2013 

 

1. Device Manager (Mehta Transcan Driver): Changed the way the Transcan events are extracted from the  

   devices. The new polling process will extract events that have a date and time greater than the  

   latest date and time located in the SDC-HIS.INI file. The SDC_HIS.INI file is located in the  

   Wavewin directory. In previous versions the events were extracted according to the Master Number.  

   This was causing to many events being extracted on an initial poll. The date and time check limits  

   the number of events extracted. 

 

 

Wavewin G.5 - 06/12/2013 

 

1. Device Manager (User Log On): Added more protection to the user log on feature to gain access to the  

   device manager fields and features. In the Save and Archive dialog a user ID field was added along  

   with a confirm password field. Also, a status field is displayed suggesting how the password field  

   should be structured. A Lock Saving field was also added to lock a user from changing the information  

   located in the device log files. It also prevents the user from changing any of the fields in the  

   Save and Archive dialog. 

 

2. Device Manager (Change User Password): Added a new dialog under the Option menu called  

   "Change User Password". This feature allows a user to change their existing password when the system  

   Lock Saving feature is set to Yes.  

 

 

Wavewin G.3 - 03/25/2013 

 

1. Device Manager (Ethernet Connect): Added an indicator when an Ethernet connection is connected. This 

   helps speed up the ethernet connections. In previous version it always waited a fix number of seconds 

   to see if the connection was connected properly. 

 



2. Data Plotting (Y Scaling): Changed the PixDisp column to display the number of Volts or Amps per inch 

   in the current view/print according to the number of pixels per inch of the screen or printer.   

 

 

Wavewin G.2 - 03/08/2013 

 

1. Device Manager (DEV_Group Files): Added support use the group number instead of the device number 

   when naming the log files (DEV_###.DTB). To switch between using the group number instead of the 

   device number the passed parameter GROUP must be passed when running Wavewin. 

 

2. Device Manager (Direct Indexing Vars): Added support to direct index into the variable list using  

   the device number. Also, increased the number of variables from 64,000 to 300,000. Each device 

   in the system can have a maximum of 150 variables. 

 

3. Device Manager (Lock passed parameter): Added a new passed parameter to lock all saving of the ASCII 

   or Hexadecimal files. The new parameter is LOCK. When lock is passed to Wavewin the user will not be 

   able to edit any files on disk or change any of the device manager polling properties. 

 

 

Wavewin G.1 - 02/25/2013 

 

1. Device Manager (Modbus): Added support to send modbus SOE response commands from the device manager 

   while polling the TIS devices. 

 

2. Data Plotting (SEL 487E): Added support to read the SEL 487E compressed file format. 

 

 

Wavewin F.Z - 02/07/2013 

 

1. Device Manager (FTP Get Events): Added support to tag the FTP event files with the correct year. When 

   requesting a DIR from an FTP server the year is not always listed. Added an equation to calculate the 

   proper year for each file in the list. 

 

2. Data Plotting (Comtrade 2013): Added support to read the new Comtrade 2013 format. Also added the save  

   as Comtrade to support the Comtrade 2013 format.  

 

 

Wavewin F.Y - 01/14/2013 

 

1. File Manager (Rename TIS Files): Added the TIS fault information to the IEEE long file name format. 

   The faulted channel name is in Optional field # 1. The maximum magnitude is in Optional field # 2. 

   And the duration of the fault in milliseconds is in Optional field # 3. The sampling frequency is in 

   Optional field # 4. 

 

2. File Manager (Passed File Parameter): When a file is passed as a passed parameter to Wavewin it use to 



   first open the file manager then open the passed file. It now just directly opens the file. Directories 

   that have thousands of files takes allot of time to load. This version speeds up the display of  

   passed files.  

 

3. Data Plotting (Drag and Drop Analog Channels): Added the ability to drag and drop mark analog channels 

   to a new position in the analog trace section. 

 

4. Device Manager (MID Memory Optimization): Improved the MID polling memory consumption by 20%. 

 

5. Device Manager (Device Assignment at Connect): Added the active device assignment when a device is 

   connected via serial connection or Ethernet connection. 

 

 

Wavewin F.X - 12/17/2012 

 

1. Device Manager (Set Events Path): Added a new dialog to set the event save path for all devices or  

   marked devices only. This allows for quickly changing the save path for multiple devices without 

   having to edit each device. 

 

2. Device Manager (Polling Start Date): Added a new dialog to set the event polling start date and  

   time. When the system is first ran the polling process will extract all events from the configured 

   devices. To have only the events extracted after a specific date and time select the desired date 

   and enter the time.  

 

3. Device Manager (Device Table): Added an opposite click popup menu that allows for editing the selected 

   device, duplicating the selected device, creating a new device and change the polling start date. 

 

4. Device Manager (MID Window): Expanded the number of MID windows that fit in one screen. In  previous  

   versions only four polling device windows would be displayed. It now calculates the number of windows 

   to display according to the screen resolution. 

 

5. Device Manager (MID Window - Terminal Mode): Added the ability to view terminal mode for each MID  

   window being polled by clicking on the MID window's header.   

 

6. Device Manager (MID Window - View Log): Added the ability to view the polling log for each MID  

   window by opposite clicking on the MID window's header.   

 

7. Device Manager (Specialized Import): Added a specialized import for comma delimited files that have 

   a fixed format.    

 

8. File Manager (Append Logs): Modified the append logs engine to sort the marked logs file according 

   to the fault date and time. In previous version is was sorting them by save date and time. 

 

9. File Manager (Tesla SOE): Added a new display driver to read the Tesla encoded SOE files and display 

   the contents in an ASCII editor. All files ending in EventData.DAT are tagged as Tesla SOE files. 



 

 

Wavewin F.W - 11/28/2012 

 

1. Device Manager (TIS Driver): Combined the TIS Binary and ASCII drivers. The only difference is the  

   trigger file formats. For Binary the trigger files are saved in a compressed Binary format and for 

   ASCII the trigger files are saved as comma delimited ASCII files. 

 

2. Device Manager (IDM RAS Driver): Added a new device driver to dial into the Hathaway IDM RAS connection 

   and retrieve a list of files and extract the latest event files. 

 

3. Data Plotting (Bitronics RAW Files): Added a display driver to plot the Bitronics RAW Trend files. 

 

 

Wavewin F.V - 10/24/2012 

 

1. Device Manager (Password Management): Added a Level 2 password with password confirmation  

   fields to the Change Password dialog. 

 

2. Device Manager (Bitronics): To extract Bitronics data from the Mx70 series meters using FTP enter 

   the word Bitronics into the File Extension fields. The Bitronics meter requires specific extraction 

   of several files from different directory locations. 

 

3. Data Plotting (SEL Events): Corrected a problem with the SEL display driver calculating the sampling 

   frequency from the SER listed data. 

 

 

Wavewin F.T - 10/10/2012 

 

1. Device Manager (SOI List OperVal): Increased the number of characters for the SOI List operator 

   value from 26 to 40. 

 

2. Device Manager (SDC-VAR.INI): Added a check to make sure a device manager variable is not written 

   to the SDC-VAR.INI file if it contains a Carriage Return or a Line Feed. In previous versions 

   the contents of the SDC-VAR file were being off skewed because of <CR> an <LF> in variables. 

 

3. Device Manager (Change Password): Added a Level 2 password in the change password dialog. By  

   default both Level 1 and Level 2 passwords are set to blank strings. If a password is blank, then  

   no action is taken. If the Create Strong, Random password check box is checked then both 

   password are set to Random, telling the system to create a random password. 

 

4. Device Manager (MID Marked Devices): Added a check to make sure the first device (Start System) 

   is marked in the device manager table if the user wants to poll a number devices and not all the 

   devices in the table. The first device defined in the table starts the polling process. If the  

   user wants to poll only a number of devices then they mark the first device and the desired  



   devices. This will insure the first device will be included in the polling process if the user 

   forgets to mark the first device. 

 

5. Device Manager (FTP Get Events): Changed the format of the events latest date and time stored  

   in the SDC-HIS.INI file. All date and times will be in the standard format as  

   mm/dd/yyyy hh:mm:ss.zzz. Also, added a check to make sure a file with a size of 0 is not  

   extracted. 

 

6. File Manager (Networked Drives): Improved the reading of the drive letter from the network drive 

   name. In previous versions the network drive was read from the information between the last ( ) 

   symbols in the string. In some cases, the information between last ( ) symbols is not the network  

   drive. It now looks for the ':' between the ( ). If not found, then go to the next () symbols. 

 

7. Data Plotting (Mark & Save): Corrected a problem with the mark and save not reading the selected 

   format file correctly from the menu option.  

 

8. Device Manager (FTP): Added error checking and display. 

 

 

Wavewin F.S - 09/26/2012 

 

1. Device Manager (ZIP Files): Changed the file type designations in the first user field in the IEEE  

   Long Filename when the "File Names" field is set to Rename to IEEE Long Filename. Bitronics meters  

   produce three types of files, Waveform, Disturbance and Trend. The files original names are named  

   with the first character as "W" for Waveform files, "D" for Disturbance files and "T" for Trend  

   files. Now the FTP engine will only fill the user field if no commas exists in the original name 

   and the 4th character is an underscore (_). It will put the first 3 characters of the zip file in 

   the IEEE long names first user field. 

 

2. Device Manager (FTP Get Events): Changed the FTP Get Events driver to work as an event-based object 

   rather than a preemptive based object. A preemptive object will issue a request and wait until the 

   request is complete then continue in the code. This was causing device communicating via TCP/IP to  

   time out because the FTP object freezes the system when receiving large files. The event base  

   object works in the background allowing all communications types to flow without interruptions.  

 

 

Wavewin F.R - 09/10/2012 

 

1. Device Manager (FTP Get Events): Enhanced the FTP Get Events driver. In previous versions the FTP 

   driver would extract the maximum number of events and store the latest date and time in the SDC-HIS.INI. 

   The next poll the FTP Get Events would only extract events with a date and time greater than the 

   date and time stored in the SDC-HIS.INI file. This could cause events not to be extracted due to  

   the FTP directory list not sorted according to date and time. In this new version the FTP driver  

   stores all events to extract in a String list. It goes down the string list extracting events.  

   This ensuring no events are missed due to the FTP list not being sorted according to date and time.  



 

2. Device Manager (Change Passwords): Changed the password management file from a *.CSV to a *.TXT file. 

 

3. Device Manager (Device 255 Reserved): Added additional checks to make sure Device number 255 is 

   not used when numbering devices. Device  255 is a reserved system device number. The added checks 

   were added to the port configuration dialog and the import engine. 

 

4. Device Manager (FMS Outage): Added a designation in the FMS_Diagnostic_Filter.txt file to indicate 

   what SER element is used for Outage information. The new designation is "=outage". For example 

   if IN401 is listed in the FMS_Diagnostic_Filter.txt and is the outage indicator then add =outage next 

   to it, IN401=outage. 

 

5. Device Manager (FTP Terminal): Added a new button in the device manager table to open the FTP terminal 

   mode directly from the table. It will only open the FTP terminal mode application if the table cursor 

   is positioned on an FTP device. 

 

6. Device Manager (Terminal Mode from MID): Added access to the terminal mode window from the MID polling 

   window. To view the information being polled from a specific device click on the device's MID header. 

   If terminal mode is already open when clicking on a new device MID header then the currently open 

   terminal window is closed first, and a new terminal window is open for the new device. 

 

7. Device Manager (Polling Button): In previous versions when clicking on the polling buttons and the 

   polling process is active a message box was displayed stating the polling process is already in 

   progress. In this version if the polling buttons are clicked and the polling is in progress then 

   the MID polling window is brought to the front of all other windows. 

 

8. Device Manager (PPS): Added support for the PPS GPS in the TIS driver. 

 

9. Device Manager (PPS): Activated the display interface in MID for the PPS polling device. 

 

10. Data Plotting (PNRF Display Driver): Added support to read and display all analog and digital 

    channels from PNRF files that have multiple recorders. 

 

 

Wavewin F.Q - 08/20/2012 

 

1. Device Manager (FTP Unzip): Added the ability to automatically unzip Zip files extracted using the 

   FTP driver. A new drop-down field was added to the FTP Client configuration dialog. The new field  

   is called Zip Files. This new field defines what action to take when extracting Zip files. The  

   three options are:  

     "No"                        - do not unzip the file and do not delete the zip file,  

     "UnZip"                     - unzip the contents of the Zip file and maintain the original Zip file,  

     "UnZip and Delete Zip File" - unzip the contents of the Zip file and delete the original Zip file. 

   The File Names drop down defines how the Zip file and the files contained in the Zip file are named. 

   "Maintain Original Filename" will preserve the original filename of the Zip file and the files  



   contained in the Zip file. "Rename to IEEE Long Filename" will rename the Zip file and the files 

   contained in the Zip file using the IEEE long file naming format. 

 

2. Device Manager (FTP Driver): Added file type designations in the first user field in the IEEE Long  

   Filename when the "File Names" field is set to Rename to IEEE Long Filename. Bitronics meters produce 

   three types of files, Waveform, Disturbance and Trend. The files original names are named with the 

   first character as "W" for Waveform files, "D" for Disturbance files and "T" for Trend files. The 

   FTP engine looks at the first character of the original name if it is a "W" then Waveform is put  

   in the first user field in the IEEE long name. If it is a "D" then Disturbance is added and if "T"  

   then add Trend.   

 

3. File Manager (User Shortcuts): Added user defined shortcuts to menu options in the File Manager 

   and Data Plotting windows. To define shortcuts, open the File Manager's Display dialog (located 

   under the Options menu). Click the Shortcuts button. Two tabs are displayed below the dialog  

   definition "File Table" and "Data Plotting". To add shortcuts, click the menu options under the  

   "Actions" list and click the Move button (green arrow). Shortcuts can be deleted, moved up and  

   moved down in the list. A drop-down menu button is displayed in the button menu bar with the  

   selected shortcuts. 

 

 

Wavewin F.P - 08/14/2012 

 

1. Device Manager (Password Management): Added a dialog to the Change Password feature. When the Change  

   Password menu option is selected a dialog box is displayed. The new dialog box allows for entering  

   the new password manually or have the system generate a 6 character randomly generated password.  

 

2. Device Manager (Password Management): Added support for the new device Command separator. In older 

   versions, the separator between the command fields was a blank. The new separator is the ~ symbol. 

   The password management feature replaces the old password defined in the second field in the Command 

   column with a new 6 character randomly generated password. The table and database are both updated.  

 

3. Device Manager (SDCMenu): Added support to automatically connect to Ethernet and Virtual serial ports 

   when using the remote SDC commands through the terminal window. 

 

4. Device Manager (SDCMenu): Added a new command to disconnect from a switched Ethernet or Virtual  

   serial port. To back out of a connection type SDCOUT at the prompt. 

 

5. Device Manager (Poll One Time Only): Added a new button menu that will perform a poll one time only. 

   The button looks like the MID button with a right arrow. The poll one-time only feature will open 

   the MID window and automatically start the polling process for all the marked devices in the device 

   management table, if no devices are marked then it will poll all devices that have a driver  

   assigned. 

 

6. Device Manager (Poll Periodic): Changed the MID button to a button with a clock for polling the  

   devices periodically. The poll periodic button will poll the devices according to the polling 



   settings defined in the Save and Archive dialog. 

   

 

Wavewin F.O - 06/18/2012 

 

1. Data Plotting (Fast SACs): Added a drop-down list to the operator fields in the SAC dialog. The drop 

   down list allows for selecting predefined Fast SACs. There are 16 defined Fast SACs. If there are 

   marked channels in the analysis window then the channel numbers defined in the SAC operator are 

   automatically populated into the Fast SAC. If no channels are marked, then the channel position 

   in the operator is replaced with a pound sign (#). The user is responsible for entering the channel 

   numbers and for completing the unit.   

 

2. Data Plotting (Fast SACs): Added support to add new SAC header and operators to the Fast SAC file 

   by the users. The Fast SAC file (SacList.FMT) is not included with the downloaded zip file. When  

   the system is ran Wavewin will look for the SacList.FMT file if it is found it will read and bin 

   the contents into memory. If it is not found it will create it with the 16 default SAC header and  

   operators.  

 

3. Data Plotting (USI & APP Line Groups): Added support to read the USI and APP line group data along 

   with the Z0, Z1 and line length. The Z1 and Z0 data is stored in rectangular form. The USI & APP  

   drivers automatically convert the Z1 and Z0 data to polar form. The Z0, Z1 and line length are  

   automatically populated in the Single Ended and Double Ended Fault Calculators. Added two new fields 

   in the Driver Configuration dialog to define the paths were the USI and APP line definition files  

   are located. 

 

4. Data Plotting (USI & APP Line Groups): Corrected a problem reading the USI and APP line paths from 

   the Wavewin.ini file. There was a case sensitive problem between the Wavewin.ini file and the  

   read Wavewin.ini file engine in Wavewin. In the Wavewin.ini file the USI and APP header characters 

   are all capital letters and in the read Wavewin.ini file engine it was looking for USI and APP 

   headers with just the first characters in capital letters. The engine now reads and compares all 

   driver headers in upper case. 

 

5. Data Plotting (USI & APP Line Groups): Corrected a problem displaying the SAC channels when a line 

   group is selected. The display channel sequence was setting the SAC display channels beyond the 

   maximum number of channels.  

 

6. Data Plotting (Emax Line Groups): Added support to read the Emax line group Z0, Z1 and line length. 

   The Z1 and Z0 data is stored in rectangular form. The Emax director and long-term drivers automatically 

   convert the Z1 and Z0 data to polar form. The Z0, Z1 and line length are automatically populated in  

   the Single Ended and Double Ended Fault Calculators. 

 

7. Data Plotting (Save As Comtrade): Added support to clean all illegal filename characters, carriage 

   return and line feeds from the station and device names before saving to Comtrade using the IEEE 

   long file naming format. In previous versions the Emax station information read from the Emax CTL file 

   contained carriage returns and was causing a problem saving the files as Comtrade. 



 

8. Windows 7 (Dialogs): Adjusted the dialog sizes to accommodate the screen size. If a dialog is  

   larger than the screen then scroll bars are displayed to scroll through the dialog. Also, 

   automatically size the dialog according to the dialog fields and not as default values. 

 

9. Windows 7 (ASCII Editor): Adjusted the ASCII text marking to mark the text with reference to the  

   font character width and not the default width. Some Windows 7 systems have character sizes that 

   are different from the defined default width.  

 

10.Windows 7 (Date and Time Blinking): Minimized the date and time blinking in the systems main menu 

   bar by turning off the Transparent field. 

 

11.Data Plotting (SEL Display Driver): Added support to default the SEL display driver to show analog  

   values as RMS Calibrated. This is available for new installations. For existing installations, the  

   Driver's data type can be changed by editing the Driver Configuration dialog. 

 

 

Wavewin F.N - 06/04/2012 

 

1. Data Plotting (Fast SACs): Added a drop-down list to the SACs operator fields. The drop-down list 

   allows for selecting predefined Fast SACs. The position of the channel number is replaced with 

   a pound sign #. If there are marked channels in the data plotting window, then the pound sign is  

   replaced with the marked channels number. If no channels are marked the user will have to replace 

   the pound sign with the desired channel numbers. To have the Fast SAC header automatically copied 

   to the SAC title fields click on the check box located at the bottom of the Fast SAC drop down list. 

 

2. Data Plotting (USI & APP Line Groups): Added support to read and display the line groups for the 

   USI and APP recorders. Both recorders save their line definitions in the Comtrade *.INF file.  

   To specify where the INF files are located open the Device Configuration dialog and select the  

   USI and APP Comtrade Files under the Drivers list box. On the right-hand side enter the path for 

   the line definition files. 

 

3. File Manager (Auto Convert to Comtrade): Added support to automatically start the auto convert to 

   Comtrade when Wavewin is ran. To have the auto convert to Comtrade start at run time open the  

   auto convert dialog and click on the check box located at the bottom of the window.  

 

 

Wavewin F.M - 05/08/2012 

 

1. Device Manager (FTP Get Events): Corrected a problem with the FTP Get Events driver. In F.L the FTP 

   driver was only executing the get events driver for the first device listed in the MID window. 

 

 

Wavewin F.L - 03/07/2012 

 



1. Data Plotting (Beckwith M-3311A): Added a display driver to plot the Beckwith M-3311A relay files. 

 

 

Wavewin F.K - 02/10/2012 

 

1. Device Manager (Virtual Comm Port): Modified the polling of virtual ports. In previous versions virtual 

   ports where polled simultaneously. Simultaneous polling was causing bottle necks which resulted in loss 

   of data. In the latest version each virtual port will be polled in order. 

 

 

Wavewin F.J - 02/01/2012 

 

1. Device Manager (Reserved Device #): Reserved device number 255 for system internal purposes. 

 

2. Device Manager (Optimization): Optimized the performance of the system so it can poll large files 

   without loading up the polling buffers. 

 

 

Wavewin F.I - 01/25/2012 

 

1. Data Plotting (SEL 734P): Added support to read and display the proper units for the Voltage Channels 

   (Volts or kVolts). 

 

2. Data Plotting (SEL 734P SSI): Added support to read and display the proper data type values for the  

   analog channels (Primary or Secondary). The Vsec indicates secondary values. 

 

3. Device Manager (SEL Events): Improved the extraction of the SEL events files from the SEL relays. In 

   previous versions MID would start with the earliest file then decrement up. If new events come in during  

   polling then an event may be missed. Added a check to make sure the event's date and time matches the  

   date and time in the history. 

 

4. Device Manager (SEL Events): Added support to extract the SEL Compressed Raw 60 cycle files. There 

   is a new option in the "Event Type" drop down list. The new option is "Compressed Raw L60". 

 

5. Data Plotting (SEL 734P): Added support to read and display the SEL-734P Event files. In previous  

   versions the event files had a blank line between the channel headers and data. This version of the  

   relay has no blank line. Wavewin was not setting the channel titles. 

 

6. Data Plotting (SEL 734P SSI): Added support to display the latest version of the 734P SSI format. In  

   previous versions the 734P relay had one VBASE setting for all the voltage channels. In the latest 

   734P relay version there are 3 VBASE settings, one for each voltage channel. 

 

7. Data Plotting (SEL Compressed): Added support to read the "Prim Val" field from the SEL compressed  

   files and set the data values type properly. 

 



 

Wavewin F.H - 01/08/2012 

 

1. Device Manager (FTP): Corrected a problem with exporting FTP connections when multiple extensions are 

   defined. The pipe sign separator was breaking the extensions into different table columns. 

 

2. Device Manager (SEL Events): Changed the direction the events are extracted. In previous versions 

   the events were extracted latest event first (top of the history down). It now extracts the oldest events 

   first (bottom of the history going up).  

 

3. Device Manager (SEL Events): Increased the number of events listed in the His report from 12 to 48. 

 

4. Device Manager (SEL Events): Added clearing the SEL event number variable after the SEL events  

   driver has completed.   

 

 

Wavewin F.G - 12/08/2011 

 

1. Device Manager (ABB670 FTP): Added support to read and extract Comtrade zip files from the ABB 670 

   relay using the FTP communications protocol. 

 

 

Wavewin F.F - 10/10/2011 

 

1. Data Plotting (Reference Angles Across Windows): Allow for referencing angles across open windows when 

   not in Sync mode. In previous versions it was required to have sync mode on to see angles referenced  

   across windows. To reference angles across windows, open the Windows Properties dialog click on the  

   "Display Settings" tab. The last field on this tab allows for activating referenced angles across  

   windows. 

 

2. Data Plotting (Hathaway Replay Plus Driver): Corrected a problem reading the number of bytes per 

   scan when there are no digital channels defined in the file. 

 

 

Wavewin F.E - 09/18/2011 

 

1. Data Plotting (Wavewin Sniffer Driver): Added support to read the event files generated from the  

   new Wavewin Sniffer 24 DFR. 

 

2. Fault Data Manager: Added support to read different file types that have the same substation name 

   and device name in the IEEE long file name format. 

 

3. Device Manager (SEL Recorders): Added support to read the data saved in the SEL recorders. All data 

   is saved in a comma delimited format and can be plotted using the SDC driver. 

 



4. Data Plotting (SEL 735): Added support to the SEL driver to plot the SEL 735 relay event files. 

 

 

Wavewin F.D - 07/05/2011 

 

1. File Manager (Default Path): Added support to define the default path the file manager will always 

   open in. To define the file manager's default path, select the "Display" menu option under the  

   "Options" menu. Enter or browse to select the desired path in the "Default Path" field. When the  

   file manager is opened it will attempt to display the folders and files in the default path, if  

   it cannot connect to the default path then the Wavewin path is displayed. 

 

2. Data Plotting (Emax Long Term - Save As CSV): Added support to save the Emax Long Term Angles under the 

   Save As CSV options. 

 

3. Data Plotting (Sequence Calculator): Added the display of the phasor chart to the sequence calculator. 

   Also, added support to display the sequence calculator for a single end or if two files are open 

   display the sequence calculator for both end to end files. Also, added the selection drop down lists 

   to define the channels for VA, VB, VC, IA, IB and IC. 

 

4. Data Plotting (Fault Calculator: Double Ended): Simplified the Double End Fault Calculator. The new  

   Double Ended Calculator displays the input fields: Z1 (Mag and Angle) and the Line Length on the left 

   side of the window and the Fault location Output fields (Zero Sequence - FL0, Positive Sequence -  

   FL1, Negative Sequence - FL2) in the middle of the window. To display more details such as the data  

   values, the channels for VA, VB, VC, IA, IB and IC and the sequence components magnitude and angles  

   click on the "Show Details" button. 

 

5. Device Manager (Save and Archive Dialog): Changed the Nomenclature in the Save and Archive dialog to 

   better define the Saving or Archiving of the system DTB files. 

 

6. Device Manager (Polling SEL Compressed Files): Corrected the settings of the milliseconds in the long 

   file name when polling for SEL compressed files. In previous version the zero padding was not being  

   applied for the millisecond’s readings. 

 

 

Wavewin F.C - 06/12/2011 

 

1. Data Plotting (RFL Driver): Added support to read RFL files that have blank lines in the header  

   information. 

 

2. Data Plotting (Merge Open Files): Corrected a scale factor conversion when merging open files that have 

   been converted from the original values to primary or secondary quantities. 

 

3. Data Plotting (Save As): Corrected a typo in the Save As menu under the CSV menu. 

 

4. Data Plotting (Emax Driver): Added support for the Emax 16-bit Director files. 



 

5. Data Plotting (Emax Trigger Time): Added support to read the trigger time from the new Director files.  

   The new Director files now include microseconds in the trigger time. 

 

 

Wavewin F.B - 04/20/2011 

 

1. Data Plotting (PNRF Driver): Converted checking recorder compatibility using strings instead of double  

   types. In previous versions the double types where not matching across recorders because of the  

   significant bit checks. 

 

2. Device Manager (Save Path): Added checks to not overwrite the defined Save Path and Messages & Logs Path  

   if the paths are not accessible when the device manager is first opened. 

 

 

Wavewin F.A - 04/10/2011 

 

1. Data Plotting (Digital Channel Original State): Added the default view to view all digital channels  

   when there are no original state values defined in the Comtrade CFG file. Also, set the digital   

   channel state at the cursor position to a red "D" in the digital channel table to define that the  

   channels original states where defaulted to 0. 

 

2. Data Plotting (Analog Channel Zero Axis Dotted Line): Corrected a problem when plotting the zero  

   x-axis dotted line. The previous version was plotting the zero x-axis as a solid line when in  

   a compressed view. 

 

3. Data Plotting (PNRF Driver): Added error checking for the total number of samples and the sampling 

   interval reported by the PNRF SDK driver. 

 

4. Data Plotting (Under and Over Triggers in SACs): Modified the way the under and over trigger checking 

   is performed in the SACs. 

 

 

Wavewin F.9 - 04/06/2011 

 

1. Device Manager (GPS Time in TIS driver): Added support for reading IRIG-B from a GPS connected to 

   one of the RJ45 ports on a TIS recorder. Improved the timing to be better than 1 millisecond. 

 

2. Data Display (PNRF Driver): Improved the PNRF display driver to read and display all channels in the 

   file. If the channels span multiple recorders, then the recorder name is added to the beginning of 

   the channel title.  

 

 

Wavewin F.8 - 03/31/2011 

 



1. Data Display (SEL SSI Driver): Added support for the difference in Voltage units for the R100, R300 

   and R200 series files. The R100 and R300 series voltage values are saved as kV and the R200 series 

   voltage values are saved as Volts. 

 

2. Data Display (PNRF Driver): Added support to reprocess the PNRF samples in a file. PNRF files usually  

   have over 1 million samples saved to a file. Wavewin attempts to bin all the samples in a file 

   before display. The PNRF files were causing the system to run very slow. To improve the display, Wavewin 

   bins no more than a million samples when the file is first open. It will skip the appropriate number 

   of samples to ensure only a million samples are in RAM. For example, if the file contains 3 million  

   samples every 2 samples will be skipped. Also, added a reprocess dialog that allows for selecting  

   a start time in the file, how many milliseconds to display and how many samples to skip. When a PNRF 

   file is first displayed it shows the samples in a compressed format. From there the reprocess dialog 

   allows for zooming in to specific areas in the file. To return to the original display, click on the 

   "Restore Original Data" menu button. 

     

 

Wavewin F.7 - 03/17/2011 

 

1. Device Manager (Virtual Comm Ports): Added a new option in the Device Configuration dialog to set 

   a serial COMM port connection as a Virtual Port. Virtual Ports in Wavewin will not hold the COMM port. 

   It will connect to the port before a poll and disconnect after the poll is complete. To set a device  

   as a Virtual Comm Port open the device configuration dialog for the device and click the "Virtual Port" 

   radio button under the "Connection Type" field. All device drivers that use the Virtual Port must  

   include the "Connect" and "Disconnect" drivers.   

 

2. Device Manager (FTP Sessions Active/Passive): Added a new option in the Device Configuration dialog to  

   set the FTP file transfer mode (Active or Passive). For an FTP device protocol, the file transfer mode 

   can be set using the "File Transfer Mode" drop down list. All existing FTP devices default to "Passive". 

 

3. Data Display (SEL SSI files): Added support to handle date and times listed in the SSI files with  

   duplicated date and times in consecutive scans. In previous versions a divide by zero error was  

   displayed if the first two scans of the file had the same date and time. 

 

4. Data Display (SEL SSI Driver): Corrected a problem with SSI files that have real values defined for  

   the Current and Voltage channels. The values where being multiplied by 100 two times to convert the  

   real values to integer. 

 

 

Wavewin F.6 - 03/08/2011 

 

1. Device Manager (Serial Communications): Corrected an error checking routine that was causing the  

   serial commands to be sent out the port multiple times.  

 

 

Wavewin F.5 - 02/27/2011 



 

1. Device Manager (TCP/IP Client): Changed the way the data is written to a server from a TCP/IP Client  

   devices. In previous versions the data was written in a preemptive fashion. This means the TCP/IP  

   client write operations would not return until all the data was sent to the server. In an event  

   based system the write operations return immediately with no wait time. Data is now written with  

   error checking to ensure the data is properly transferred. 

 

 

Wavewin F.4 - 02/22/2011 

 

1. Device Manager (Lock Device Manager): Added support to lock the device manager from a user editing  

   and seeing the device configuration information. In lock mode the device table is disabled and  

   minimized. 

 

2. Device Manager (Disable port switch): If the device manager is in lock mode a computer connected to 

   the device manager cannot port switch to any of the devices configured in the device table. 

 

3. Device Manager (TCP/IP Client): Changed the way the data is read from the TCP/IP Client devices. In  

   previous versions the data was read in a preemptive fashion. It is now read through event calls from  

   the operating system. 

 

4. Device Manager (Modbus Drivers): Added support for the IEEE float to the Modbus ASCII, RTU and TCP 

   drivers. 

 

 

Wavewin F.3 - 02/09/2011 

 

1. Device Manager (TCP Modbus Driver): Corrected a problem sending the Modbus TCP header to a Modbus 

   client. The data count byte in the TCP header was not being properly calculated. 

 

 

Wavewin F.2 - 02/06/2011 

 

1. Device Manager (TCP/RTU Modbus Driver): Added the ability to send polling variables from any of the  

   devices being polled to an RTU using the Modbus TCP commands and the Modbus RTU commands. The modbus  

   communications can be configured in Wavewin in the following ways: Multiple RTU Masters can be  

   connected to multiple ports/sockets on the same Wavewin machine provided that each RTU connects to  

   a different port on Wavewin (1 to 1 relationship). Or multiple devices (various manufacturers &  

   models) can be connected to one and/or multiple ports on the same Wavewin machine (1 to 1 and/or  

   Many to 1 relationship) (star and/or multi-drop topology) provided that all of the connected devices  

   are set to different addresses (each device must have a unique address). 

    

   The Modbus RX and TX device must be set to an Ethernet Server in the device configuration dialog. For 

   RX and TX of Modbus TCP commands the device title for the Modbus device in the device configuration 

   dialog must be set to MODBUS MASTER (TCP) and the data type field must be set to Binary. For RX and  



   TX of Modbus RTU commands the device title for the Modbus device in the device configuration dialog  

   must be set to MODBUS MASTER (RTU) and the data type field must be set to Binary. 

    

   The “RTU-MB4.INI” file located in the Wavewin folder holds the variables to send to the RTU.   

   This INI file is used to assign MODBUS addresses to the user variables that are defined in the  

   Wavewin “DRIVERS.INI” file.  The “RTU-MB4.INI” file is formatted as comma-separated values that  

   are listed in the following order: 

    Address, Variable, Type, Multiplier, Divider<CR/LF> 

 

    Address = 4x Read Register Address in Hex 

    Variable = Name of user assigned Wavewin variable 

    Type = (-1) for Signed or (1) for Un-Signed 

    Multiplier = Multiply Variable By before transmitting to RTU 

    Divider = Then Divide Variable By and transmit to RTU 

 

    The “RTU-MB4.INI” file is basically an electronic copy of a typical “MODBUS Register Definitions  

    Sheet”. The significance of this work is that the “RTU-MB4.INI” file is created by the user,  

    which means that the actual mapping/assignment of the MODBUS Slave registers is up to the user). 

    The MODBUS Registers Map is the same for all the connected devices which is another significant  

    result in that it simplifies having to deal with various types of devices from various manufacturers. 

 

 

Wavewin F.1 - 02/01/2011 

 

1. Device Manager (# of Devices): Increased the number of devices that can be configured and polled  

   from one device manager table. The total number of devices is now 2000. In previous versions the 

   device limitation was 999. 

 

2. Device Manager (# of variables): Increased the number of system and device variables to 64000.  

   In previous version the maximum number of variables was limited to 24000. The increase will  

   accommodate the increase of total devices to 2000.   

 

3. Fault Data Manager (List Devices): Added a new option to list all the devices being polled by 

   the master station(s). The new option is available under the "Options" menu. The device manager 

   now automatically exports a list of devices to the message folder. The device list is exported  

   upon entry to the device manager table and when a change is made in the device configuration  

   dialog. In the fault data manager open the "Options" menu and select the "List Devices" option. 

   If multiple master stations are active a drop-down list allows for selecting the master station. 

   To poll the devices listed in the table marked the devices using the Ctrl-click then click on the  

   "Poll Devices" button. Click on the "Close" button to close the window. 

 

4. Data Plotting (SEL Driver): The data plotting window shows an indication of a change of state in 

   the digital channels. A small red line shows where the digital channel changed state. If a change 

   of state happened on the last sample in the file the green end of file line was covering the  

   change of state red line. The last sample change of state is now displayed after the end of file 



   green line.   

 

 

Wavewin E.Z - 01/24/2011 

 

1. Device Manager (TCP/IP Server): Activated the TCP/IP Server for multiple TCP/IP Client socket 

   connecting to the Wavewin TCP/IP Servers. 

 

2. Device Manager (ASCII Modbus Driver): Added the ability to send polling variables from any of the  

   devices being polled to an RTU using the Modbus ASCII HEX commands. The modbus communications 

   can be configured in Wavewin in the following ways: Multiple RTU Masters can be connected to  

   multiple ports/sockets on the same Wavewin machine provided that each RTU connects to a different  

   port on Wavewin (1 to 1 relationship). Or multiple devices (various manufacturers & models) can  

   be connected to one and/or multiple ports on the same Wavewin machine (1 to 1 and/or Many to 1  

   relationship) (star and/or multi-drop topology) provided that all of the connected devices are  

   set to different addresses (each device must have a unique address). 

   The “RTU-MB4.INI” file located in the Wavewin folder holds the variables to send to the RTU.   

   This INI file is used to assign MODBUS addresses to the user variables that are defined in the  

   Wavewin “DRIVERS.INI” file.  The “RTU-MB4.INI” file is formatted as comma-separated values that  

   are listed in the following order: 

    Address, Variable, Type, Multiplier, Divider<CR/LF> 

 

    Address = 4x Read Register Address in Hex 

    Variable = Name of user assigned Wavewin variable 

    Type = (-1) for Signed or (1) for Un-Signed 

    Multiplier = Multiply Variable By before transmitting to RTU 

    Divider = Then Divide Variable By and transmit to RTU 

 

    The “RTU-MB4.INI” file is basically an electronic copy of a typical “MODBUS Register Definitions  

    Sheet”. The significance of this work is that the “RTU-MB4.INI” file is created by the user,  

    which means that the actual mapping/assignment of the MODBUS Slave registers is up to the user). 

    The MODBUS Registers Map is the same for all the connected devices which is another significant  

    result in that it simplifies having to deal with various types of devices from various manufacturers. 

 

3. Device Manager (Import): Added two new options to the Import engine. The new import options are  

   overwrite the existing device or append the new devices to the end of the table. The import 

   engine imports device information into the device table from a comma delimited text file. 

 

4. Device Manager (Log Variables): Added the option to turn off/on logging of the system log files 

   from the device configuration dialog. The "Log Header" field has been changed to "Log Variables".  

   Logging of the system log files is defaulted to ON. To turn off logging select off from the  

   "Log Variables" drop down list. 

 

 

Wavewin E.Y - 12/07/2010 



 

1. Fault Data Manager: Added a new interface to manager fault files named using the IEEE Long File  

   Naming Format (C37.232). To open the new manager, click on the fault’s menu button in the main  

   system toolbar located under the menu or select the "Fault Data Manager" menu option under the 

   "Options" menu in the file manager. The Fault Data Manager window has 4 sections: the Folder  

   Tree, the Device Table, the Query Bar and the Device Summary Information section. The Tab key  

   toggles between the 4 sections. The folder tree located on the left side of the window allows  

   for navigating the local and networked drives. When the window is first displayed the folder  

   tree points to the same directory active in the file manager. To change the active folder click  

   on the desired folder/drive listed in the folder tree. The table displayed in the top right  

   section of the window lists all the devices that have long file naming event files located in  

   the active folder. When the folder is scanned the device table compiles a list of unique devices  

   according to the information listed in the long filenames.  If there are no files, named using  

   the long file naming format, in the active folder then "No Items To View" is displayed in the  

   device table. 

   The Device Information section lists a history of the event files for the device selected in the  

   device table. The number of event files listed can be changed by opening the "Fault Manager  

   Properties" dialog under the "Options" menu. Change the "# of Event Files" field to the desired  

   number to display. The station name, device title and the total number of events files stored  

   in the active folder for the selected  device is displayed in the header section of the device 

   information window. If the devices are being polled by Wavewin then the last meter reading is  

   displayed under the history list.  

   Each file listed in the history can be plotted, viewed/edited and summarized. To plot one of  

   the files use the tab key to activate the device information section or click in the section.  

   The up arrow, down arrow, page up and page down keys are used to move the cursor. The enter  

   key will plot the highlighted file, F2 will display  the contents of the file and the F3 will  

   show a summary. Double clicking on the file will also plot the file. There are 3 buttons  

   displayed in header section that will plot, summarize or view/edit the selected file.  

 

2. Data Plotting (Tesla AutoComtrade): Modified the calling of the Tesla AutoComtrade application  

   to convert Tesla files to the Comtrade standard for display. In previous version a dialog box  

   was being displayed when the autocomtrade.exe application was called, and the dialog was removed  

   when the autocomtrade.exe finished. In some file conversions the dialog box was not being removed 

   because Windows was losing the handle to the dialog box. In this version the dialog box is  

   removed and is replaced with a message displayed in the status bar's last field: "Converting  

   Tesla File ... Please Wait". Also, the mouse cursor is changed to the hourglass cursor during  

   the conversion.  

 

3. Data Plotting (Html Digital Channels): Changed the way the digital information date and time is 

   read from the html files. In previous versions the date and time was read from the "Timestamp LOCAL"  

   fields. In this version the date and time is read and converted from the "Timestamp HEX" fields. 

   This will allow for date and times defined in 12 hours or 24 hours and it will also handle all  

   date and times formats (US, European, Japan).  

 

4. File Manager (Move Files): Added the ability to drag and drop files into the folder tree for moving  



   files to a new folder. Mark the files to move in the file table then drag them to the desired folder  

   displayed in the folder tree.  

 

 

 

Wavewin E.X - 09/27/2010 

 

1. Dispatch Table (Scan Events Folder): Added support to scan the events folder in the background.  

   The event folder is scanned when the dispatch table is first displayed and if the automatic  

   refresh is set it also scans the events folder on the interval set in the Dispatch Properties 

   dialog. Scanning the event folder in the background allows for working in the dispatch table  

   without interruption. 

 

 

Wavewin E.W - 09/20/2010 

 

1. Dispatch Table (Multiple Masters): Added support to the Dispatch Table to handle communications to  

   multiple master stations. A new button menu option was added to select the master station for  

   requesting events records from. 

 

 

Wavewin E.V - 08/23/2010 

 

1. System (Passed Parameter): Added a new passed parameter to automatically convert a file to the  

   IEEE C37.111 Comtrade ASCII 1999 format. The new passed parameter is /Comtrade. To retain the  

   original file name of the source file uses the /Comtrade passed parameter. To have the file  

   automatically named using the IEEE C37.232 file naming format use the /Comtrade=1 passed  

   parameter. The /Comtrade command line parameter can also be used in batch files. The converted  

   Comtrade files are saved in the same directory as the source file. The new passed parameter will  

   convert the source file to Comtrade then display the converted Comtrade file in the data plotting  

   window. 

 

   Below are some examples: 

  

 Examples: 

 --------- 

 

 1.) Passed Parameter:  "c:\faultlib\shipdir\SEL-421.CEV" /Comtrade=1   

            Comtrade Filename: 011207,145119291000,-5,Station A,Relay 1,SOFTSTUF,TRIP,, 

               SOTF B_PHASE C_PHASE GROUND 50,60.00.DAT 

 2.) Passed Parameter:  "c:\faultlib\shipdir\DATA1068.RCD" /Comtrade 

            Comtrade Filename: c:\faultlib\shipdir\DATA1068.DAT 

 

 

Wavewin E.U - 08/17/2010 



 

1. Data Plotting (Save Sample Values): Added a new menu option to the "Save As CVS" option. The new option 

   will Save the Vector values in RMS and Angle. The four Save As options are now: 

 1.) Save As CSV - RMS Values: Save the RMS Values in a comma delimited format. 

 2.) Save As CSV - Instantaneous Values: Save the Instantaneous Values in a comma delimited format. 

 3.) Save As CSV - Vector Values (Mag & Ang): Save the DFT Magnitude and Angle in a comma delimited  

            format. 

 4.) Save As CSV - Vector Values (RMS & Ang): Save the RMS Value and Angle in a comma delimited  

            format. 

 

2. Data Plotting (Emax Driver): Added support to read Emax waveform and log files that have 128 analog 

   channels and 128 digital channels. 

 

3. Data Plotting (Harmonics): Increased the number of harmonics displayed from Samples/Cycle div 2 to the 

   number of Samples/Cycle. Allows to see the mirror image of Nyquist harmonics. 

 

 

Wavewin E.T - 08/05/2010 

 

1. Data Plotting (Save Sample Values): Added a new menu option "Save As" to the "File" menu. There are 

   two sub-menus under the "Save As" option: "Comtrade" and "CSV Format". The "Comtrade" option saves the 

   displayed channels in either the ASCII or Binary format. The "CSV Format" will save the RMS,  

   Instantaneous or Vector (Magnitude and Angle) values to comma delimited text file. The first line in  

   the CSV file is the header information for each channel. All the analog channels that can be displayed  

   in the active data plotting are saved. A dialog box is displayed to enter the destination path and the  

   filename. The destination path is automatically defaulted to the active path in the file manager. The  

   filename can be directly entered into the "File Name" field or the file can be automatically named  

   using the IEEE long file naming format. To have the file automatically named click on the "ComNames"  

   check box. If the "ComNames" check box is checked then the File Name field will be disabled. To enter  

   a file name make sure the "ComNames" check box is unchecked. 

 

2. Device Manager (Log In/Log Out): Removed the password column from the "LOG IN-OUT Tracking.CSV" file. 

 

 

Wavewin E.S - 08/04/2010 

 

1. Device Manager (Log In/Log Out): For SIP security a new Log In/Log Out button has been added to the  

   Device Manager's toolbar. To Log In to the Device Manager click on the Log In button. A Log In dialog  

   will be displayed enter your Full Name in the "Users Name:" field and enter the password in the  

   "Password:" field. The password is case sensitive. The dialog will allow for three tries to enter the 

   correct password then it will be closed. Once Logged In the Log In button will change to Lou Out. The 

   Device Manager will be automatically Log Out if there is no activity for 15 minutes. 

   A comma delimited CSV file records all Log In and Log Out activity. The filename is  

   "LOG IN-OUT Tracking.CSV" and is saved to the Wavewin directory. 

 



 

Wavewin E.R - 06/27/2010 

 

1. Data Plotting (Fault Location:Double Ended): Added a new dialog to calculate a double ended Fault  

   Location. 

   The double ended calculator requires two open fault records (near and far ends). The near end is the top 

   left window displayed. To reorganize the windows, use the Tile buttons.  

   The channels in each record must be organized as follows: The first 3 visible channels are the Voltage  

   channels, VA, VB and VC. The next 3 visible channels are the Current channels, IA, IB and IC. To  

   reposition the analog channels first mark the channels then use the plus key to move the channels up  

   one position and the minus key to move the channels down one position.  

   The values populated in the dialog are read at the data bar positions from both open records. The double  

   ended dialog is a stay on top window. This allows for repositioning the data bars without closing the  

   dialog. To refresh the Voltage and Current values in the dialog use the Refresh button.  

   To increment the voltage and current angles for the near end and far end enter an increment value in the  

   Angle Rotation fields and click on the Rotate button. 

   Use the Calculate button to calculate the double ended fault location. To open the double ended dialog  

   select the "Fault Calculators" sub menu option under the "Data" menu then select the "Double Ended" menu  

   option.   

 

2. Data Plotting (Sequence Calculator): Added a Sequence Components calculator. The sequence calculator  

   works off the active (highlighted) data plotting record. The channels in the active record must be  

   organized as follows: The first 3 visible channels are the Voltage channels, VA, VB and VC. The next  

   3 visible channels are the Current channels, IA, IB and IC. To reposition the analog channels first  

   mark the channels then use the plus key to move the channels up one position and the minus key to  

   move the channels down one position. The values populated in the dialog are read at the data bar  

   position in the active record. The sequence calculator dialog is a stay on top window. This allows  

   for repositioning the data bars without closing the dialog. To refresh the Voltage and Current values  

   in the dialog use the Refresh button. Use the Calculate button to calculate the sequence components. 

   To increment the voltage and current angles enter an increment value in the Angle Rotation fields  

   and click on the Rotate button. 

   To open the sequence calculator dialog, select the "Sequence Calculator" menu option under the "Data"  

   menu.   

 

3. Data Plotting (Primary/Secondary Ratios): Added the ability to change the primary and secondary ratio  

   values for the analog channels in the open record. To change the ratio values, open the "Window's  

   Properties" dialog by selecting the "Window's Properties" menu option under the "File" menu. Click on  

   the "Driver Data Type" tab then click on the "Edit Ratio Values" button under the "Analog Values"  

   section.  

   In the Ratio Values dialog move the cursor to the specific Primary/Secondary values and change the  

   displayed value. To apply the modified ratios, click on the "OK" button. The modified ratio values  

   are Not saved to the original file on disk. To save the ratios values to disk use the  

   "Save As Comtrade" option listed under the "File" menu.   

 

4. Data Plotting (Peak/RMS Type): All analog channels displayed are viewed as Peak type. To change the type  



   of values displayed, open the "Window's Properties" dialog by selecting the "Window's Properties" menu  

   option under the "File" menu. Click on the "Driver Data Type" tab then select the Data Multiplier type  

   from the drop down list under the Analog Data Type section. To always have the driver specific files  

   displayed as RMS type (Root 2 Multiplier) open the "Driver Configuration" dialog from the File Manager's  

   "Option" menu. The Driver Configuration dialog lists all display drivers supported, click on the driver  

   in the "Drivers" list then change the Driver's Data Type to RMS calibrated.   

 

5. Data Plotting (Data Cursors): Corrected a problem with displaying the data bar in non-active data  

   windows. 

 

 

Wavewin E.Q - 05/24/2010 

 

1. Dispatch Table (Device Numbers): Changed the way the device numbers are assigned for polling. In  

   previous versions the device numbers where assigned according to the group numbers defined in the 

   device manager table. It has been changed to assign the device numbers according to the group name. 

   This will allow nested communication processors to abort just that communication processor if errors 

   occurred during polling.  

 

 

Wavewin E.P - 05/20/2010 

 

1. Device Manager (Save Path): Corrected a problem where the Save Path was blocked out due to testing. 

 

2. Device Manager (Address Field): Corrected a problem where the Address field was blocked out due to  

   testing. Testing was done on increasing the field to 5 characters. 

 

 

Wavewin E.N - 05/13/2010 

 

1. Device Manager (REL/MDAR Driver): Corrected a problem with sorting the event history list in the *.3EH 

   files. 

 

2. File Manager (Auto Convert to Comtrade): Added a new feature that will automatically convert specific  

   file types to the IEEE Comtrade format. To start the convert to Comtrade process open the  

   "Auto Convert to Comtrade" dialog by selecting the "Auto Convert to Comtrade..." menu option under the  

   "Options" menu in the File Manager. Enter the Source Path (path where the original files are located),  

   Destination Path (path where the converted Comtrade files are saved), Archive Path (path where to  

   archive the original files after they are converted to Comtrade), File Extension (the extension of the  

   files to Convert to Comtrade separated by commas, *.SSi,*.EVE) and the scan period in minutes. Auto  

   Convert to Comtrade will monitor the Source path for the defined file extensions every scan period.  

   If the define file extension is SSI for the SEL Voltage Sag/Swell/Interruption files then enter the  

   minimum number of cycles required before saving to Comtrade, the default is 2 cycles. Also, enter the  

   maximum number of milliseconds between samples before the SSI date is separated into multiple Comtrade 

   files. To start the process, click on the "Start Convert" button. Once the conversion starts the button  



   caption will change to "End Convert". To end the conversion process, click on the "End Convert" button.  

   All converted Comtrade files are saved using the IEEE long file naming convention. If a file already  

   exists in the destination path then the file is overwritten. The status of each scan is displayed in  

   the Status section of the dialog. 

 

 

Wavewin E.M - 05/01/2010 

 

1. Device Manager (Save Path): Protected the Save Path and Messages & Logs Path in the Save and Archive  

   Dialog. 

 

2. Device Manager (Save Path): Added the Device Configuration "Save Path" field to each internal driver. 

 

 

Wavewin E.L - 04/26/2010 

 

1. System Tables (Mark Files): Removed the new single click marking. This feature is now an option in  

   the "Display" dialog. The default is the Window's marking convention. To set the marking/unmarking  

   using a single mouse click open the "Display" dialog under the table's option menu and select  

   "Single Mark Click" in the "File Marking" drop down list. 

 

 

Wavewin E.K - 04/22/2010 

 

1. Data Plotting (SEL Voltage SSI Driver): Improved the SEL SSI display driver to read files that have  

   8 or 9 analog channels and added support to ignore incomplete samples due to polling errors. 

 

 

Wavewin E.J - 04/21/2010 

 

1. System Tables (Mark Files): Changed the way files are marked in the system tables. A single click  

   on a row will mark the row. To unmark the row, click on the row again. The single click now works as  

   a toggle between marked and unmarked. 

 

2. Device Manager (Port Back Out Field): The default Ctrl-D for the Port Back Out field in the Device  

   Configuration dialog has been taken out. 

 

 

Wavewin E.I - 04/20/2010 

 

1. Device Manager (Save and Archive Dialog): In the Save and Archive the Save Path: field has been  

   changed to Events Path: and the Message Path: has been changed to Logs Path:. 

 

 

Wavewin E.H - 04/14/2010 



 

1. Data Plotting (SEL Voltage SSI Driver): Added a new display driver to view SEL Voltage SSI  

   (Sag/Swell/Interruption) files. All files with the extension SSI are automatically tagged as SSI files.  

   To plot SSI files with a different extension, move the file cursor to the file then select the Voltage  

   Sag/Swell/Interruption driver under the SEL submenu. 

 

2. Data Plotting (Print Profile): Added the ability to save a print profile file when saving a view file.  

   The print profile fields where added to the "Save View" dialog. The "Save View" dialog is a menu option  

   under the "View" menu. The "Save View" dialog now has the ability to manipulate the channels in the view  

   and to specify the print orientation and the type of ASCII Summary information to print Short=General  

   Information, Advanced=General Information plus Channel Information. 

 

3. Device Manager (Driver.ini Variables): Added 2 new Escape Code Commands to the Drivers.ini file. The  

   first is TC, this command holds the value in the time code field displayed in the "Device Configuration"  

   dialog. The second is CMP, this command holds the "Company Name" displayed in the "Save and Archive"  

   dialog.  

 

4. Device Manager (SendCR=X): Added a new command called SENDCR=x. This command will send a Carriage Return  

   to the connected device every X seconds to ensure the device does not time out during a polling session.  

   Some devices have settings that will time out after a specified number of minutes if no characters are  

   received. Example: SENDCR=20. 

 

 

Wavewin E.G - 04/11/2010 

 

1. Device Manager (Device Configuration Dialog): Improved the Device Configuration Dialog to be more user  

   friendly. Below is a list of improvements: 

    A.) Broke up the Escape Sequence Command field into separate fields. The new fields are:  

           Phone Number: (CMND): displayed under Communication Information section for Serial Connections. 

           Password 1: (CMND1): displayed under the Device Information section. 

           Password 2: (CMND2): displayed under the Device Information section. 

           Port Back Out: (CMND3): displayed under Communication Information section for Serial &  

                                   Ethernet Connections. 

           Log Headers: (CMND4): displayed under the Device Information section. 

           Event File Type: (CMND5): displayed under the Device Information section. 

           Save Path: (CMND6): displayed under the Device Information section. 

    B.) Added a new Save Path (CMND6) field to specify where the files extracted from the polling device  

        are saved to disk. 

    C.) Added an Event File Type selection list to specify what type of event file to extract from the  

        polling device. 

    D.) Added a selection between Serial and Ethernet connections. The Ethernet connection also has a  

        Protocol list to select the type of Ethernet Protocol (TCP/IP Server, TCP/IP Client, FTP Client  

        and Telnet Client). 

    E.) Added hints to all fields. 

 



2. Device Manager (BPRO/TRPO/DPRO/LPRO Polling Driver): Added a new polling driver to poll the ErlPhase  

   relays. The new driver is called ERL-RELAYS. The ERL-RELAYS polling driver navigates the VT100 terminal  

   mode to select the latest event files then uses the Z-Modem protocol to download the events. 

 

 

Wavewin E.F - 01/14/2010 

 

1. System (System): Allow strings with 10 characters to be converted to an integer value. In previous  

   version the conversion to integer allowed only 9-character strings. 

 

2. Device Manager (File Transfer): Corrected the checking of the file transfer time when receiving files.  

   In previous versions it was accepting file transfers if the character size of the Microsoft file time 

   was less than or equal to 9. On December 26th, 2009 the Microsoft file time incremented to 10  

   characters. 

 

3. Data Plotting (PNRF Driver): Improved the Nicolet PNRF driver to bin the samples contained in a PNRF 

   file directly into Wavewin. This eliminates the conversion to ASCII. The PNRF SDK currently does not  

   allow for opening multiple files simultaneously therefor each file will be opened in a separate  

   window. 

 

 

Wavewin E.E - 12/22/2009 

 

1. Data Plotting (International Date Time): Added support to handle international date and time settings in  

   the Window's Regional and Language settings. Previous versions where using the US date and time settings  

   which was causing problems converting the date and time stored in the WFC Waveform files, Extended  

   Waveform files and the Meter files. 

 

 

Wavewin E.D - 12/10/2009 

 

1. Data Plotting (PNRF Driver): Added a new display driver to read the Nicolet PNRF files. All files that  

   have a PNRF extension are tagged as PNRF files and are displayed using the Nicolet PNRF format. The  

   files are first converted to ASCII then binned into memory for display in Wavewin. 

 

2. Data Plotting (Phasors): Added support to display the phasors using a common convention for showing  

   polarity. 

 

3. System (Data Plotting Print): Added support to print a file using a specific user defined view via the  

   command line parameters. To print a view, use the /PROFILE= "File path and name" along with the /PRINT  

   command line parameter. Example: 

   "c:\faultlib\comtrade\em files\DR1_0006.DAT" /Print /Profile= "c:\faultlib\comtrade\ 

        Average Channels-D.VIWD"  

 

 



Wavewin E.C - 11/30/2009 

 

1. Data Plotting (PNRF Driver): Added a new display driver to read the Nicolet PNRF files. All files that  

   have a PNRF extension are tagged as PNRF files and are displayed using the Nicolet PNRF format. The  

   files are first converted to ASCII then binned into memory for display in Wavewin. 

 

2. Data Plotting (Phasors): Added support to display the phasors using a common convention for showing  

   polarity. 

 

3. Data Plotting (Comma Delimited Data): Added a new display driver to read comma delimited (Time,Channel)  

   files. Files that have a TXT extension and contain SEGMENT in the first 3 lines of the file are  

   displayed using the new comma delimited driver. To plot multiple files that have the same time in one  

   window mark the files then select the Plot menu button. To plot a single file, move the table cursor to  

   the file then select the "Comma Delimited (Time,Channel)" menu option under the "Option" menu. 

 

4. System (Data Plotting Print): Added support to print a file using a specific user defined view via the  

   command line parameters. To print a view, use the /PROFILE= "File path and name" along with the /PRINT  

   command line parameter. Example: 

      "c:\faultlib\comtrade\em files\DR1_0006.DAT" /Print /Profile= "c:\faultlib\comtrade\ 

           Average Channels-D.VIWD".  

 

5. Device Manager (Password Protection): Added password protection to the "Configuration Dialogs",  

   "Save and Archive Dialog" and the "Export" option. Also, added a checkbox in the "Save and Archive"  

   dialog to hide the critical information such as phone numbers and passwords. 

 

 

Wavewin E.B - 11/12/2009 

 

1. Data Plotting (WFT Driver): Added support to combine WFT files that have the same date and time,  

   without using the merge option. To plot multiple WFT files in one window first mark the files then  

   click on the plot menu button or select the "Open all Marked Files..." submenu option under the  

   "Waveform File(s)" menu option in the "Options" menu. 

 

2. Data Plotting (SEL Driver): Added support to display SEL compressed files that have more digital  

   channel data defined in the data section then the number of digital channel titles listed in the  

   header section. 

 

 

Wavewin E.A - 10/29/2009 

 

1. Data Plotting (Replay Plus Driver): Added support for Replay Plus files were the total number of  

   digital channels are not a multiple of 8.  

 

2. Device Manager (SEL CEV Driver): Added support to parse out the event date and time, relay ID name,  

   event type, location and targets from the compressed format. These field are used for naming the  



   event files and for creating summary files.  

 

 

Wavewin E.9 - 10/26/2009 

 

1. Data Plotting (WFT Format): Added a new display driver to read the Nicolet Power Pro WFT files.  

   All files that have a WFT extension are tagged as WFT files and are displayed using the Nicolet  

   Power Pro format. 

 

2. Device Manager (File Transfer Driver): Modified the file transfer engine to transfer files with no  

   path defined in the drivers.ini file. If no path is specified, then the files are automatically  

   transferred from the Save Path. If no Save Path is defined, then the files are transferred from the  

   Wavewin path.  

 

 

Wavewin E.8 - 10/21/2009 

 

1. Device Manager (SEL Driver): Added to the extraction of the SEL compressed event files. The C  

   command now extracts 16 samples per cycle and 30 cycles of data by sending "CEV S16 L30" to the  

   relay. To define the C command put a C in the 6th field of the EscSeq Command:  

   example: 1 Otter 0 0 1 C 

 

 

Wavewin E.7 - 10/12/2009 

 

1. Data Plotting (SACs): Added 2 new SAC operators: "s" (Sin) & "c" (Cos). The "s" operator is used to  

   compute the sin "c" is cos. These two new operators allow for calculating Power factor, Active and  

   Reactive Power. Refer to the SAC help window for application examples. 

 

2. Data Plotting (Digital Channels): Added a change of state indicator to the digital trace display.  

   If the digital channel's state changes when in alarm mode a small orange line is drawn over the  

   digital channel. Alarm states are stored for SEL digital channels and for Mehta TRIG channels. 

 

3. Data Plotting (Harmonics): Added a white background behind the harmonic values in the histogram  

   display. This make the numbers more readable. 

 

4. Device Manager (SEL Driver): Added a new option to extract the SEL compressed event files. To  

   define compressed events put a C in the 6th field of the EscSeq Command, example: 1 Otter 0 0 1 C 

 

5. Device Manager (SEL Driver): Added a new option to extract the SEL ASCII raw event files. To define  

   ASCII raw events put a L (for long) in the 6th field of the EscSeq Command, example: 1 Otter 0 0 1 L 

 

 

Wavewin E.6 - 09/29/2009 

 



1. Data Plotting (Change Frequency): Added support for changing the frequency of Comtrade files that  

   have a zero defined as the Sampling Rate. The change frequency engine calculates the fractional  

   difference between the old frequency and new frequency. In previous version the fractional difference  

   was calculated once, before performing the change frequency. In this version the fractional difference  

   is calculated for each sample. 

 

2. Install(Installation Application): Eliminated the creation of subdirectories when installing the  

   software. This feature was causing a problem when installing to a subdirectory under the source path. 

 

3. Data Plotting (Primary/Secondary): Added resizing to the analog table column's width when changing the  

   type of data displayed, primary and secondary. 

 

4. Data Plotting (SEL 311B): Added support for reading SEL 311B files that have digital header information  

   inserted in the data. 

 

5. Data Plotting (SEL 487B): Added support to read the SEL 487B compressed formats. The 487B compressed  

   format inserts the $ symbol in the data section. Wavewin replaces the $ with zero. 

 

6. Data Plotting (SEL 387-5): Added support for the SEL 387-5 format. 

 

7. Data Plotting (Save As Comtrade): Corrected a problem Saving a File As Comtrade from the data window  

   when the File Manager table is closed. The Save As Comtrade engine was trying to access the  

   File Manager's translate strings. 

 

8. Data Plotting (Phase Angles): Added an option to toggle between showing the Cos Convention  

   (0 Deg at Positive Peak) and the Sin Convention (0 Deg at Zero Crossing) for the phase angles. The new  

   option is in the Window Properties dialog under the Display Settings tab. 

 

 

Wavewin E.5 - 08/18/2009 

 

1. Dispatch Table (New Feature): Added a new table that allows a dispatcher to request a poll for any of the 

   devices configured in the Master Station's device manager. 

 

 

Wavewin D.Z - 05/31/2009 

 

1. Data Plotting (Synchro-phasor Support): Modified the phasor displays to follow the synchro-phasor convention 

   (+Peak=0 Degrees). 

 

2. Data Plotting (SACS): Added a set of fast recursive engines for calculating RMS, Phase, Magnitude, Real, 

   Imaginary and frequency components for each channel. 

 

3. Data Plotting (SACS): Added 8 new SAC operators using the values calculated from the recursive engines.  

   The new SACS operators are: 



 

 "x": real component 

   "y": imaginary component 

   "m": magnitude 

   "d": angle 

   "r": true rms 

   "f": cyclic frequency 

   "q": instantaneous frequency 

   "t": delta time frequency 

 

4. Data Plotting (SACS): Added several examples in the SAC help window describing how to use the new 

   and existing operators. 

 

5. Data Plotting (Time Discontinuity): Added a new engine to detect discontinuities in time. If a time  

   discontinuity is encountered then a green dotted line is displayed at the sample where the discontinuity  

   occurred. A mouse over the small gray triangle displayed at the bottom of the green line will show the  

   duration. To turn off this feature set the "Show Event Separator Bars" field to "No"  

   (in the properties dialog). 

 

6. Data Plotting (Harmonics): Changed the displayed Total Harmonic Distortion value from RMS to  

   Instantaneous (for compliance with IEEE notation). 

 

7. Data Plotting (Summary): Revised the Summary Window to show: Max, Min & Max Min Difference for both  

   Instantaneous and RMS values. 

 

8. Data Plotting (Navigate Peaks): Revised navigate peaks to navigate the DFT peaks instead of the  

   instantaneous peaks. 

 

9. Data Plotting (Print): Added the timeline/ruler to the print engine. 

 

10. Data Plotting (Append Files): Corrected a problem appending log file. The time difference was being  

    calculated to the microseconds. It now calculates the time according to seconds. 

 

11. Device Manager (Export/Import): Improved the export and import device engines. 

  

 

Wavewin D.X - 02/22/2009 

 

1. Data Plotting (Fault Calculator): Added a new method to the fault calculator. The new method is the 

   Reactance Method. To switch between the 2 methods, click on the tabs at the top of the window. 

 

2. Data Plotting (HTML Events): Corrected a problem with initializing the default values for the digital 

   channels when a HTML event file is not available. In previous versions all digital channel values were  

   defaulted to 0. If a digital channel has an original state set to 1 then the channel was displayed in  

   a triggered state which was not correct. Now, if an HTML event file is not available then the digital  



   channel values are set to their original state. 

 

 

Wavewin D.T - 02/07/2009 

 

1. Data Plotting (Ruler): Corrected a problem with parsing the integer portion from a real value in French. 

   The previous versions where always looking for a "." it now includes the ",". 

 

2. Data Plotting (Views): Added resizing to the Select View dialog for different languages. 

 

3. Data Plotting (Views): Allows for views that do not fully match the displayed file. 

 

4. Data Plotting (Complex Calculator): Added a new dialog to perform complex mathematics calculations.  

   The new dialog is accessed from the "Data" menu in the data plotting window. The dialog is also  

   accessed from the file manager under the "Options" menu. 

 

5. Data Plotting (Fault Calculator): Added a new dialog to compute the fault location using the Takagi  

   algorithm. The new dialog is accessed from the "Data" menu. 

 

6. Data Plotting (Timeline): Corrected a problem with resetting a flag when switching between the time  

   line and the ruler. 

 

7. Data Plotting (Views): Added more view information to the Select View dialog. 

 

8. Data Plotting (Timeline): Improved the accuracy of the timeline. 

 

9. Data Plotting (Views): Changed the way the view channels are check against the displayed file  

   when opening a view. In previous versions the channel titles in the view had to match the channel  

   titles in the file, now if only checks if the channel numbers in the view exists in the selected  

   displayed file. 

 

 

Wavewin D.S - 11/30/2008 

 

1. Data Plotting (Timeline/Ruler): Added a new time bar measuring the time distance from the first  

   sample displayed. The new time bar is called the Ruler. The time bar is displayed between the analog  

   traces and the digital traces. The default time bar displays the current fault reference bar  

   measuring time in cycles from the fault position. All previous versions displayed the fault  

   reference bar. To switch between the new Ruler display and the fault reference bar right click on  

   the time bar and select the desired menu option under the popup menu. 

 

2. Data Plotting (Analog Channels): Increased the number of analog channels read and displayed  

   from 256 to 512.  

 

3. Data Plotting (SACs): Added a new command to perform SAC calculation only between the Reference Bar  



   and Data Bar.  

   The B command will perform the specified SAC command for the samples between the two bars. The B  

   command is not case sensitive. 

 Examples: 

    a) Multiply Channel 8 by 2 between the bars: +8/*^2b/ 

    b) Divide Channel 7 by Channel 2 between the bars: +7/:2B/ 

    c) 2nd Harmonic of Channel 3 between the bars: +3h=2b/ 

 

 

Wavewin D.R - 08/11/2008 

 

1. Data Plotting (Meter Driver): Corrected a problem reading and aligning the channels according to the  

   quantity ID vectors.  

 

2. Data Plotting (Meter Driver): Changed the auto append to read all files that have a ".PRO" extension  

   instead of only reading files that have the name 'AVG##.PRO'. 

 

3. Data Plotting (Thiran Filter): Added the removal of the correct number of samples in the file when the  

   Thiran filter is applied. 

 

 

Wavewin D.Q - 08/06/2008 

 

1. Data Plotting (Meter Driver): Added two new options for the meter driver. The first option allows  

   for opening only one-meter file at a time or automatically opening all meter files starting with meter  

   file 00 and going to 30. The second option specifies to sort all the samples by their time stamps.  

   Both options are available in the first two lines of the SandC Meter Channels.ini file located in the  

   Wavewin directory. 

      Auto Append=ON 

      Sort Samples by Time=OFF  

 

2. Data Plotting (Daily High Low Driver): Added a new driver to display the Daily High Low files. The 

   driver displays the data in a tabular form listing the low values, low time stamp, high values,  

   high time stamp and associated quantities.  Files that have the .DHL extension are tagged as Daily  

   High Low files. 

 

3. Data Plotting (Thiran Filter): Added the removal of the last 4 samples in the file when the Thiran  

   filter is applied. 

 

4. Data Plotting (Thiran Message): Added an option in the Thiran message to Not Show This Message Again. 

 

5. Data Plotting (Append Message): Added a new message to the append feature when the Thiran filter has  

   been applied to any one of the files included in the append. The message notes that the data may not be  

   continuous in time because of the removal of the last 4 samples when the Thiran filter was applied. 

 



 

Wavewin D.P - 07/10/2008 

 

1. Device manager (Station ID): Changed the name of the Station ID column to Group ID for cross triggering. 

 

2. Device Manager (Cross Triggers): Added cross triggering for the Poll Sensors/Binary driver. If a trigger  

   level is exceeded on a sensor then an event trigger file will be saved for that device along with an  

   event file for each device with the same Group ID number. 

 

 

Wavewin D.N - 06/26/2008 

 

1. File Manager (Show/Hide Channel Titles): Added a new dialog to give the ability to show/hide analog and  

   digital channels via the channel title. To open the dialog, select the "Show/Hide Channel Titles" option  

   under the "Options" menu. All titles listed that have a check in the checkbox are automatically hidden  

   when the file is displayed. To show the title uncheck the checkbox next to the title. To remove a  

   title from the list use the "Remove" button. To add a new title, type the new title in the edit box and 

   click the "Add" button. The new title is automatically added to the end of the list and the checkbox  

   is defaulted to checked. 

 

2. Data Plotting (WFC Driver): Modified reading the calibration delays from the file's header according  

   to the new spec document. 

 

3. Data Plotting (Print): Corrected a problem with printing the analog table. A problem was encountered 

   after adding the resizing of the analog columns. The print columns where being resized according to  

   the title column. 

 

4. Data Plotting (SandC Drivers): Changed the SandC drivers to store the preprocessed samples in memory  

   and not on disk in the Wavewin directory. 

 

5. Data Plotting (SandC Event Files): Added support for events that have an ON code but no OFF code. When  

   an event with only an ON code is encountered Wavewin marks only the sample where the ON code occurred. 

 

6. Device Manager (Escape Code Command): Expanded the number of Escape code commands from 8 to 12, CMND  

   plus CMND1 to CMND11. 

 

 

Wavewin D.M - 06/12/2008 

 

1. Device Manager (TIS Driver): Only allow the automatic offset calculation for channels that have AMPS as  

   the unit. 

 

2. Data Plotting (Save As Comtrade-Mehta Files): Corrected a problem when saving Transcan files as  

   Comtrade. If the Transcan file has more than 40 triggers defined than Save As Comtrade encounters  

   a range check error writing the triggers to the Comtrade HDR file an abort saving. The triggers are  



   stored in an array that hold up to 40 strings. 

 

3. Data Plotting (Print Window): Added a new print option to print the contents of the window. The new  

   option is called "Window" and is located under the "Print" submenu. 

 

4. Data Plotting (Print All & Page): Corrected a problem printing the analog table. The columns where  

   being resized improperly. 

 

 

Wavewin D.L - 06/04/2008 

 

1. Data Plotting (SandC Meter Driver): Added a new driver to read and display all 31 "*.PRO" files saved to 

   the active directory. The samples are binned into memory then sorted by time before being displayed in  

   the data plotting window. Meter files that have no analog channels defined in the quantity ID vector  

   section is ignored. Also, if a channel is not defined it's titled is defaulted to "Unused" and not  

   displayed. 

 

 

Wavewin D.K - 05/29/2008 

 

1. Data Plotting (Summary): Compressed the Fault Summary information into 4 lines for the SEL compressed 

   format. Previous versions were using 12 lines for each event saved in the file. There is a limitation 

   of 40 lines for the fault information section. Up to 10 event's fault information is now displayed. 

 

2. Data Plotting (Print): Included the Waveform Summary as part of the data plotting print. 

 

3. Data Plotting (Analog Table): Added automatic column sizing according to the largest max & min values. 

   Previous versions were using a fixed size which was causing values to overlap into neighboring columns. 

 

4. Data Plotting (Thiran Filter): Corrected a problem with initializing the Thiran filter for the first 

   3 samples. 

 

5. Data Plotting (WFC Time Stamps): Add support to use the Frame DNP time stamp when there is no primary 

   or secondary triggers defined in the file. 

 

6. Data Plotting (WFC Digital Channels): Added 14 new digital channels to the WFC file to show the trigger  

   information defined in the Auxiliary data activity flag section. The cycle that defines the trigger is  

   marked in alarm state. The new channels are listed below: 

     Channel   Title 

     -------   ----- 

        1      Over Current Flag Set 

        2      Over Current Flag Clear 

        3      Misc Relay Condition Set 

        4      Misc Relay Condition Clear 

        5      UNUSED 



        6      UNUSED 

        7      Check Open 

        8      Pulse Close 

        9      Block Pulse Close 

       10      Pole Error 

       11      Open Handle 

       12      Timer 

       13      User 

       14      Loss of Power 

 

7. Data Plotting (Automatically Add HTM Events): Added support to automatically add event information  

   from the event html files that have a begin and end date and time included in the filename. The  

   events will be automatically added if the html file is in the same directory as the WFC and  

   EWC files and the begin time defined in the html file name is greater than or equal to the file's  

   start time and the file's start time is less than the end time. The events that have a common time  

   are automatically added when the file is opened.  

 

8. Data Plotting (EWC Scale Factor): Corrected a problem with the Extended Waveform Capture Scale  

   Factors. Added support for the IQ24 data format. 

  

 

Wavewin D.J - 05/08/2008 

 

1. Data Plotting (Thiran Filter): Corrected a problem with the Thiran filter. When calculating the  

   relative number of samples Wavewin was using the negative value when it is greater than 1.   

 

 

Wavewin D.I - 04/17/2008 

 

1. Data Plotting (Calculate Frequency): Added a new dialog to calculate the Frequency. The new dialog  

   can be opened from the "Calculate Frequency" menu option under the "Data" menu. In the dialog select  

   the number of cycles visible between the Reference bar (blue dotted line) and the Data bar  

   (black solid line). Click the "Calculate" button to display the Frequency. 

 

2. Data Plotting (SEL 651): Added support for the SEL 651 compressed format. 

 

3. Data Plotting (SEL Driver): Added the Line Length and IA, IB, IC, IG and 3I2 header information to  

   the "Summary" windows "Fault Information" section. 

 

 

Wavewin D.H - 04/01/2008 

 

1. Data Plotting (Thiran Filter): Added a new dialog to align the displayed waveforms. The new dialog  

   is called "Align Channel Data" and is located under the "Channel" menu. Enter the Phase Shift  

   angles for each channel listed. To compute the coefficients for each channel, click the  



   "Calculate Coefficient" button. Each coefficient can be changed via each edit field. To run the  

   Thiran filter on the displayed channels click the "Run Thiran Filter" button. To always have the  

   "Thiran" filter applied when opening files for a specific driver click the "Always Apply" check  

   box. To use the modified coefficients, check the "Use Entered Coefficient Values" box. To use the  

   calculated coefficients check the "Calculate Coefficients at Run" box.     

 

 

Wavewin D.G - 02/25/2008 

 

1. File Manager (Network Drives): Corrected an error when navigating network drives. In previous  

   versions if there are 2 sets of () in the network name Wavewin was extracting the drive letter  

   from the first set of (). This is not the case; Windows puts the drive letter in the last set  

   of (). In this version Wavewin extracts the drive letter from the last set of (). This corrects  

   any access violation errors encountered when navigating to network drives. 

 

2. File Manager (Network Drives): Greatly improved the speed when reading the directories under a  

   network drive. Wavewin is now a 100% compatible with Windows explorer when navigating to network  

   drives.  

 

3. Data Plotting (SEL 421 driver): Made further improvements when reading the digital channel data  

   listed in the SEL 421 ASCII file. 

 

 

Wavewin D.F - 02/19/2008 

 

1. Data Plotting (SandC Event File): Improved the SandC Event file parsing. The parsing is now  

   compliant with the html format. 

 

2. Data Plotting (SEL 421 driver): Added support to read all the digital channel data listed in  

   the file. 

 

 

Wavewin D.E - 02/14/2008 

 

1. Device Manager (COM Port): Changed SETPORT to close and open the COMM port when executed. Previous  

   versions would only change the baud rate, parity and stop bits when executed. Added this to help  

   improve the communications when a massive amount of data is being sent through the port for long  

   periods. 

 

2. Device Manager (TIS driver): Added a new TIS Binary driver to support more recorders per PC.  

   The new TIS binary driver uses 0% resources. 

 

 

Wavewin D.D - 01/23/2008 

 



1. File Manager (Blink): Added a new command line parameter to blink the date and time displayed in  

   the upper right-hand corner of the menu. The new command line parameter is called "Poke". "Poke"  

   checks the current size of the active directory with the size of the directory in Windows. If the  

   sizes are different than the date and time will blink from red to gray. The directory sizes are  

   checked every 8 seconds. To clear the blinking click on the refresh directory menu button. 

 

2. Device Manager (TIS driver): Added a SOE file for every trigger waveform file created. The SOE  

   files are saved to the save path and contain a list of the channels that triggered during the event. 

 

3. Device Manager (TIS Trigger): When a trigger is detected in the TIS driver the date and time  

   displayed in the upper right-hand corner of the menu will blink from red to gray. To clear the  

   blinking click on the refresh directory menu button. 

 

 

Wavewin D.C - 01/03/2008 

 

1. Data Plotting (Sound): Added the ability to play the audio of an analog channel. A new menu option  

   has been added under the "Data" menu called Play Channels Audio. A toolbar dialog will be display  

   in the bottom right corner of the window. Press the play button to play the 1st marked analog  

   channel. If no channels are marked, then it defaults to the first analog channel. The volume can be  

   adjusted using the "Volume" control. The audio of the signal can also be saved to a .WAV file.  

   Select or enter the desired Wave file path and name under the "Save .WAV File" section. Also make  

   sure the "Save Audio" checkbox is clicked. This dialog will always be displayed on top of all other  

   windows. This allows for changing the active analog channel on the fly. 

 

2. Data Plotting (.WAV Files): Added a new driver to read and display Microsoft's .WAV audio files.  

   This driver currently only supports the 1 audio format. All files that have the ".WAV" extension  

   are displayed using the new Wave driver. If the file has a different extension select the  

   "Audio Wave File" menu option under the "Drivers" menu. 

 

3. Data Plotting (Digital Channels):  Increased the number of digital channel title characters  

   displayed from 40 to 80.  

 

 

Wavewin D.B - 12/16/2007 

 

1. Data Plotting (TIS Driver): Added the millisecond count to the TIS data file. All samples are  

   tagged according to the new milliseconds count in the data file. 

 

2. Data Plotting (TIS Driver): Added the sampling frequency tag to each sample. The sampling  

   frequency is extracted from the FREQ column in the data file. 

 

3. Data Plotting (TIS Driver): Remove the frequency channel from the data plotting window. The  

   frequency is now display in the Freq status field. 

 



 

Wavewin D.A - 11/30/2007 

 

1. Data Plotting (SandC): Added the SandC extended waveform capture format. All files that have the  

   ".EWC" extension are displayed using the new SandC extended waveform driver. If the file has a  

   different extension select the "SandC Extended Waveform Capture" menu option under the "Drivers"  

   menu. 

 

2. Device Manager (TIS driver): The TIS polling drivers will reset the recorder if it detects a gap  

   in sampling. The previous gap was set to 1 millisecond in this version the gap is now set to 50  

   milliseconds. 

 

3. Device Manager (TIS driver): Added a new button in the "Ethernet Connection" dialog to edit the  

   TIS recorder settings. Click the "Configure" button to display the "TIS Config" settings  

   application for the selected device. 

 

4. Device Manager (Telnet): Added support for the telnet protocol. To specify a telnet session for  

   Polling, open the devices "Configuration" dialog (F2) then click on the "Ethernet Connection"  

   dialog. Select "Telnet Client" from the "Ethernet Connection" list. Enter the port number and  

   IP address or host name. Click OK then click save in the "Configuration" dialog. 

 

 

Wavewin D.9 - 11/02/2007 

 

1. Data Plotting (Save Views): Added a new option to save analog and digital channel views to  

   an ASCII text file. To save a view mark the desired analog and digital channels and press  

   <enter>. Select the "Save View" menu option under the "View" menu. Enter the views filename  

   and path and press enter. The saved view will be added to the views drop down list on the menu  

   button bar. The views drop down menu list displays the last 15 saved or selected views. 

 

2. Data Plotting (Select Views): Added a new option to select saved views. To display a saved view  

   select the view file from the "Views" drop down list displayed in the menu button bar. If the  

   desired view is not displayed in the drop-down menu list select more views to navigate to the  

   saved view. Views can also be selected using the "Select Views" menu option under the "View" menu.  

   The "Select Views" dialog list all the view files in the active view path. To change the view path  

   select a path from the "View Path:" drop down list or use the browse button to select a new path.  

   The analog and digital table displays the properties of the selected view. 

 

3. Data Plotting (Rochester Display Driver): Added support to display the trigger position according  

   to the prefault samples defined in the preamble file and not use default positions according to the  

   sampling frequency. 

 

 

Wavewin D.8 - 10/12/2007 

 



1. Data Plotting (SandC PXI Driver): Added a new display driver to display SandC PXI file format. 

 

2. Data Plotting (Line Frequency): Added the ability to change the line frequency for all supported  

   drivers. To change the line frequency, open the "Driver Configuration" dialog from the File tables  

   Options menu. Navigate to the desired driver listed on the left side of the dialog and change the  

   "Line Frequency" field. 

 

 

Wavewin D.7 - 10/05/2007 

 

1. Data Plotting (Intellirupter): Improved the display driver for the S&C IntelliRupter driver to handle  

   all cases for the ADAF flag in the Auxiliary Data. 

 

 

Wavewin D.6 - 09/24/2007 

 

1. Data Plotting (Intellirupter): Fixed a problem with reading the first 6 channels in the new display  

   driver for the S&C Intellirupter Waveform files. The bytes where ordered wrong when composing the 32  

   bit signed long integer. This problem has now been corrected. 

 

2. Device Manager (TIS Driver): Replaced the sample number count reset with the new millisecond count  

   reset. Added this to support the TIS's latest firmware version.  

 

 

Wavewin D.5 - 09/20/2007 

 

1. Data Plotting (Intellirupter): Added a new display driver to display S&C Intellirupter Waveform files. 

 

 

Wavewin D.4 - 08/24/2007 

 

1. Device Manager (Import & Export): Modified the Export and Import features to use a tab delimited format.  

   The comma delimited format used in the previous version was conflicting with commas used in the device  

   "Driver" and "EscSeq Command" fields. 

 

2. Device Manager (Rochester): Improved the Rochester polling driver to rename any extracted files if an  

   error occurs during communications. Previous versions would delete the files. Also, improved saving the  

   last polled date and time. If an error occurred during communications the latest date and time polled  

   was not being saved to the SDC-HIS.INI file. 

 

 

Wavewin D.3 - 08/24/2007 

 

1. Device Manager: Added a new menu option under the Device menu to export the existing device table to a  

   comma delimited ASCII file. Export files are automatically tagged with the .CSV extension. The ASCII file  



   contains all or selected device entries. The first line in the export file specifies the column headers. 

 

2. Device Manager: Added a new menu option under the Device menu to import previously exported device 

   manager files. Import will read each entry in the import file and change any existing entries with  

   the new information and it will also add new entries if they do not exist in the open device manager  

   table. 

 

 

Wavewin D.2 - 08/22/2007 

 

1. Device Manager: Added 2 new commands in the Drivers.ini file for Ethernet connections. First command  

   "Connect", will connect to the IP address and port number specified at the active device. The second  

   command "Disconnect" will disconnect from the IP address at the active device. 

 

2. Terminal Mode: Added 3 new menu buttons. The first button allows for pinging the IP address and port  

   number for the open device. The second button will connect to the IP address and port number for the  

   open device and the third button will disconnect from the active device. The 3 new buttons are only  

   displayed if the device has an IP address and port number defined in its EscSeq Command field. 

 

3. Device Manager: Took out all ping and connection calls for IP addresses when the devices in the  

   table are initialized. 

  

 

Wavewin D.1 - 08/07/2007 

 

1. Data Plotting (All-Drivers): Upgraded all the time calculations from the old 32-bit, integer  

   infrastructure to a new 64-bit, floating point structure. This upgrade has eliminated the errors  

   that were caused by accumulated truncations. 

  

2. Data Plotting (SEL-Driver): Fixed the problem with the fault line indicator being misplaced while  

   reading a file with multiple event records that do not contain any digital channels. 

  

3. Data Plotting (SEL-Driver): Also, in the case of multiple event records, the "Delta X" field  

   (bottom status bar) will activate only if the reference bar and the data bar are positioned in  

   the same record. 

  

4. Device Manager (Mehta-Driver): Added an automatic feature to rename Mehta records upon retrieval.  

   The new names are in accordance with the IEEE C37.232 format and the old filename tag is placed in  

   a user field. 

  

5. Device Manager (SEL-Driver): Added new passed parameters via the "EscSeq Command" (positions 5, 6 & 7) 

   to allow for retrieval of 16 samples raw or filtered data. For example: you can ask for raw data at  

   16 samples/cycle by sending "EVE 1 R S16" to the relay. The "EVE 1" part is the default Wavewin setting, 

   to add the "R S16" parameters you need to edit the configuration dialog and add "R S16" at the end of  

   the command field. So, if the current command is: "OTTER 1 0 x" then the new command would be  



   "OTTER 1 0 x R S16". 

  

6. Device Manager (Ethernet-Driver): Changed the polling scheme for the Ethernet ports from an event based  

   interface to a preemptive based interface in order to synchronize the reading intervals across all ports  

   and to eliminate the possibility of collisions with data received from the RS232/485 ports. 

  

7. Device Manager (Save Archive Dialog): Added new fields to allow for disabling of the automatic save in  

   DTB files feature and to allow for renaming of the DTB files to the IEEE C37.232 format on a periodic  

   basis. 

  

 

Wavewin D.0 - 07/23/2007 

 

1. Device Manager: Added a feature to ping an Ethernet connection before attempting to open the connection.  

   The ping feature speeds up the validation of IP addresses. 

 

2. Device Manager: Added automatic detection of the loss of a TIS recorder by monitoring the sample counts 

   of each scan. When a sample count is loss the system will automatically reset the recorder and restart  

   the TIS configuration and capture drivers. 

 

 

Wavewin C.Z - 06/07/2007 

 

1. Device Manager: Added a circular buffer for the TIS driver. 

 

2. Device Manager: Added automatic screen updates from the TIS internal polling driver. 

 

3. Device Manager: Added an internal driver to read the TIS configuration information. 

 

4. Device Manager: Added triggers to the TIS internal driver. 

 

 

Wavewin C.Y - 05/21/2007 

 

1. Device Manager: Added a new command called TXLAST to send data to a device before the MID window  

   is closed. 

 

2. Device Manager: Added a new driver to poll the TIS device for the configuration. 

 

3. Data Plotting: Improved the TIS display driver to ignore all samples that have the first comma  

   beyond the 24th character.  

 

 

Wavewin C.W - 04/28/2007 

 



1. Device Manager: Expanded the memory manager for each driver to 16 megabytes. 

 

2. Device Manager: Added clearing of the IO logs upon exiting the device manager table. 

 

3. Device Manager: Improved the memory manager for Ethernet TCP/IP connections. 

 

 

Wavewin C.V - 03/29/2007 

 

1. Data Plotting: Fixed a problem with updating the file's date and time in the window's header when  

   the automatic Adjust Files Time is implemented. The files time was adjusted after the window's  

   header was updated. 

 

2. System: Added the ability to merge files via the command line parameter. Batch mode is used to define 

   the files to be merged. The files are automatically merged by time and if the files have different 

   sampling frequencies then the highest sampling frequency is selected. A 1999 ASCII Comtrade file  

   is saved in the same directory as the batch file with the name Merged File.cfg and Merge File.dat.  

   If an error occurs, then a Merge File.log is saved in the same directory as the batch file. 

 

 

Wavewin C.T - 03/19/2007 

 

1. Data Plotting: Added a new feature to adjust the Time of the open file. To open the Adjust Time  

   dialog select the "Adjust Files Time" menu option under the "Data" menu. You can specify to add  

   or subtract a given time increment. Enter the desired time increment for the hour, minutes, seconds  

   and milliseconds. For no adjust on a specific time field enter 0. To always have the file's time  

   automatically adjusted when a specific driver is used check the "Adjust Open Time" check box. 

 

 

Wavewin C.S - 03/15/2007 

 

1. Device Manager: Changed the point when MID or DXF is called when passed parameters are used. This  

   increased the speed of activation of MID or DXF. The previous version was waiting up to 10 minutes  

   before activating MID or DXF. 

 

2. Device Manager: Improved the FTP and TCP/IP connections to bypass all problem connections when the 

   device manager is first displayed. If a problem occurred connecting to a device then an error will  

   be displayed in the status bar's 5th field. If multiple connections had problems, then the last  

   problem device is displayed. 

 

3. Device Manager: Added support for an external FTP script service to run in the background and  

   send all polled files to the company network through a secure FTP protocol. 

 

 

Wavewin C.R - 02/15/2007 



 

1.  Device Manager: Revised the TCP/IP communication to not shut down the system if an ethernet  

    port has reported an error on an open port request. 

 

2.  System: Recently we added support for the Window's 120 DPI monitor setting. When 120 DPI is set  

    a number of dialog windows were being resized improperly. We added support to automatically  

    resize the dialog windows.   

 

 

Wavewin C.Q - 02/08/2007 

 

1.  Data Plotting: Modified the change frequency engine when changing from a high frequency to a low  

    frequency. The previous algorithm was not taken the fraction portion of the difference between  

    the old and new frequencies. This has been corrected and is now working. 

 

2.  Data Plotting: Added support to handle the comma as a decimal separator in the change frequency  

    dialog. This is supported if Microsoft's Language settings specifies France.  

 

3.  Device Manager: Added a new command called RUNFILE to run an executable or Bat file along with  

    command line parameters. The new command's calling sequence is  

    RUNFILE=C:\TEMP\FTP_SCRIPT.EXE | "C:\SCRIPT_COMMADS F.  

    If command line parameters are used, then the application path and file is separated from the  

    command line parameters with a pipe sign. 

  

 

Wavewin C.P - 01/22/2007 

 

1.  System: Added resizing to a number of dialogs and windows to handle the Microsoft Monitor  

    120 DPI setting.   

 

 

Wavewin C.O - 01/04/2007 

 

1.  Data Plotting: Added logic to the SEL 321 driver to place the trigger position at the end of  

    the 4th cycle if there are 11 cycles of data in the file and if there is a total of 12 cycles  

    in the file then the trigger position is positioned at the end of the 5th cycle. This logic is  

    only activated if there is no trigger position defined in the file.  

 

2.  Data Plotting: Removed a condition in the Comtrade driver to delete DC or AC off the end of the  

    units. 

 

3.  Device Manager: Added support for Master 0 in the Mehta poll driver 

 

 

Wavewin C.N - 12/06/2006 



 

1.  Data Plotting: Corrected a problem when calculating the conversion factors from Primary to  

    Secondary values for SEL files. Also, added the proper data values displayed (Primary or  

    Secondary) for each SEL relay type.  

 

2.  Data Plotting: Added the ability to have negative values in the TIS drivers offset fields. 

 

3.  Data Plotting: Added the ability to add a new DAU-DEF record to the Hathaway DAU-DEF file.   

    To add a new DAU-DEF record select the "Edit DAU-DEF File" menu option from the File Manager's  

    "Option" menu. Click on any one of the "Not Used" DAU-DEF records and enter the new DAU-DEF  

    information then click the "Save" button.  

 

 

Wavewin C.M - 10/10/2006 

 

1.  Data Plotting: Added a new display driver to read & display Hathaway Replay Plus files.   

    The drivers reads Waveform files (DFR files), Load files (TSS files) and Disturbance files  

   (CSS files). 

 

2.  Data Plotting: Added support to the GE SR745 driver to also read GE SR489 files. 

 

3.  Data Plotting: Added support to the SEL display driver to read any combination of the Hex  

    Digital Inputs & Outputs, Mirrored Inputs & Outputs and Relay Elements.  Previous versions were  

    only reading a certain combination of the hex digital channels defined at the end of the event  

    file. 

 

4.  Data Plotting: Fixed a problem with reading the station information from the Emax CTL file.  

    In previous versions the driver was  reading past the end of the file which was causing an  

    error in the driver. 

 

 

Wavewin C.L - 08/21/2006 

 

1.  Data Plotting: Added support to read Comtrade ASCII *.DAT files that include blanks between the  

    data values and the comma separator. The complier method used for converting the string to  

    integer values were returning an error because of the included blanks. Added support to delete  

    all blanks before converting the string to an integer. 

 

2.  Data Plotting: Added support to read the Channel offset, multiplier and units from the first  

    line in the TIS driver. 

 

 

Wavewin C.K - 08/11/2006 

 

1.  Device Manager: Increased the number of maximum variables allowed in the system from 10,000 to  



    24,000.  

 

2.  Data Plotting: Fixed a problem with reading files from Emax DFR's that define 16 analog channels  

    as the viewable channels. When 16 viewable analog channels are defined Wavewin was only reading 16  

    analog channels from the data file. Emax always saves 32 analog channels for single files (*.RCD)  

    no matter what the number of viewable analog channels are.  

     

    Also, corrected a problem with setting the primary & secondary ratio values for Emax files.  

    The ratio values were being defaulted to 1. 

 

3.  Data Plotting (Properties Dialog): Added a new button in the "Windows Properties" dialog under the  

    "Driver Data Type" tab. The "Analog Values" section allows for viewing each channel’s Primary &  

    Secondary ratio values. Click on the "View Ratio Values" button to display all the analog  

    channels Primary & Secondary values. 

 

 

Wavewin C.J - 08/01/2006 

 

1.  Data Plotting: Added a new selection option to switch between Primary and Secondary values. The  

    following drivers supply the CT and PT ratio values in the files to perform the calculation from  

    Primary to Secondary and from Secondary to Primary: Comtrade, Transcan DFR, Faxtrax/Director DFRs,  

    SEL Relays & DLP Relays. To change the analog values, open the Windows Properties dialog by clicking  

    on the "P" menu button or select the "Window Properties" menu option from the "File" menu. Click on  

    the "Driver Data Type" tab and select Primary or Secondary from the "Analog Values" section then  

    press <Enter> or click OK. The type of analog values displayed is defined in the Data Plotting's  

    Window header after the Fault Date & Time. 

 

2.  Data Plotting: Added support to the Mehta Transcan driver to bypass Trigger information defined for  

    analog channels that do not exist in the displayed file. Previous version caused an Access Violation  

    Error when trying to access the analog channel's memory. 

 

3.  Data Plotting: Fixed a problem with the # of changes of state for the digital channel’s column when  

    changing the Display driver type in the "Window Properties" dialog. The # of times the digital channel  

    changed state was being added to itself, the variables were not being cleared before reprocessing the  

    defined SAC channels. This only occurred when SAC channels were defined. 

 

4.  Data Plotting (SDCs): Fixed a problem with the SDC channels not being displayed after defining new SDC  

    channels. A call to the Window API UpdateWindow was being called after processing the SAC/SDC channels.  

    UpdateWindow is used to clear the gray box left by the SAC/SDC window. The position of the call to  

    UpdateWindow was clearing the display variable for the SDC. We moved the UpdateWindow to the beginning  

    of the execute SAC/SDC window. 

 

5.  ASCII Viewer: Fixed a problem with the F4 & F3 search engine. The Find dialog was changing the search  

    criteria in the find dialog when text is highlighted in the file. The F4 search engine was always using  

    the text between two spaces where the cursor is in the ASCII file as the search criteria. It  



    now takes the highlighted text as the search criteria or if no text is highlighted then it takes the  

    text at the cursor from the first space before the cursor to the first space after the cursor. 

 

6.  Device Manger: Fixed an Access Violation error when closing the Device Manager table when the MID and  

    terminal mode windows were open. The device manager table was being accessed in the resize window method  

    after the window was closed. 

     

 

Wavewin C.I - 07/10/2006 

 

1.  Data Plotting: Added support to the Mehta Transcan driver to read digital channels scan information  

    that start at a number greater than 1. Previous version caused an Access Violation Error when trying 

    to access the digital channels memory. 

 

2.  Data Plotting: Added support to read SEL files that have a sampling frequency greater than 1440Hz. 

 

3.  Data Plotting (SACs): Added more protection to avoid Access Violation Errors when improper information  

    is entered in the operator fields. 

 

4.  File Manager: Fixed a problem when trying to access directories using networked computer names:  

    \\other machine\fault files. 

 

5.  Data Plotting: Fixed a problem with the F9 function key for files with digital channels only.  

     

 

Wavewin C.H - 06/12/2006 

 

1.  Data Plotting: Added support for the 87L Protection digital channels in the SEL relay files. 

 

2.  Data Plotting: Added support for the SEL 587 append event files. For the SEL 387 & now 587 relay events  

    Wavewin appends the event information if the data and time for the events match. 

 

4.  Data Plotting: Added support to bypass all blank lines inserted between the digital channel headers for  

    the SEL 421 ASCII events. 

 

5.  Data Plotting (SAC Window): Added 4 new buttons in the SAC window to save / open SAC files.  The new  

    "Save" and "Save As" buttons allow for saving the current SAC information into an ASCII text file.   

    The new "Open" button allows for reloading previously saved SAC files. The "New" button allows for  

    creating new SAC files.  It clears all existing defined SACs. 

 

6.  Device Manager: Fixed a problem with the FTP Events driver when renaming to long file names using  

    File Type 1.     

 

  

Wavewin C.G - 04/23/2006 



 

1.  Data Plotting: Fixed a problem with the SACs for RMS Calibrated data.  The values where off by  

    a root 2. 

 

2.  Data Plotting: Fixed a problem with the Change Frequency when the samples/cycle is greater than 360. 

    The angle between samples was defined as whole number. It is now defined as a real value allowing  

    the angle between samples less than 1. 

 

3.  Data Plotting: Added two new buttons in the harmonics window. The up/down arrow buttons  

    increases/decreases the width of the histogram bars to show more harmonics in one window.  The second  

    button shows/hides the number values above the bars. 

 

Wavewin C.E - 03/29/2006 

 

1.  Data Plotting: Advanced the SEL display driver to correct any problems with blank lines between  

    samples. 

 

2.  Data Plotting: Reads the line frequency from the NFREQ definition under the Global Settings in  

    SEL files. 

 

3.  Data Plotting: Added a fixed dotted light red fault bar, also added an option under the  

    "Display Settings" tab in the properties dialog to show or hide the fault bar. 

 

4.  Data Plotting: Added resizing to the harmonics window to view as much information as needed. 

 

5.  Data Plotting: Fixed a problem with the SEL 187 differential channels when change frequency is used.  

    The channels were using sinusoidal interpolation, it now uses linear interpolation. 

 

6.  Data Plotting: Added the Shift '+' key to move analog channels up one position. 

 

7.  Device Manager: Added a new driver to put files on an FTP Server.  The new driver is called FTP-SEND. 

 

8.  Device Manager: Improved the ASCII parse engine to ignore all #0 inserted between text. 

 

Wavewin C.D - 03/10/2006 

 

1.  Data Plotting: Added the new driver to display Emax long-term records. 

 

2.  Data Plotting: Added automatic Comtrade conversion and display for the NxtPhase BPRO LPRO FPRO  

    and TPRO relays.  

 

3.  Data Plotting: Added a new driver to display Ametek files from the TR-100+, DL-8000, TR-2000  

    and P&QR128 devices.  

 

4.  File Manager: Moved the last active directory to the Wavewin.ini File.  In previous versions the  



    last active directory was saved to the Template database that has a limit of 80 characters.   

    The Wavewin.ini eliminates the 80-character limit. 

 

Wavewin C.B - 12/12/2005 

 

1.  Data Plotting: Fixed a problem reading the ASCII SEL421 digital channels when there are 3 or more  

    groups of digital channels defined. 

 

2.  Device Manager: Added full protection to the FTP extraction events driver to protect against the  

    FTP components and Windows message box being displayed in case of errors.  

 

Wavewin C.A - 11/28/2005 

 

1.  File Manager:  Added sorting to the table folder tree. 

 

2.  File Manager:  Always open Wavewin’ s folder tree to the last active directory. 

 

3.  Data Plotting: Fixed a problem with the boundary check for Comtrade ASCII digital channels. 

 

4.  Data Plotting: Fixed a problem with calculating the sampling frequency for Comtrade files that define 

    a zero for the sampling frequency. 

 

5.  Data Plotting: Increased the maximum number of harmonics displayed in the harmonics table from  

    100 to 200. 

 

 

Wavewin C.9 - 11/02/2005 

 

1.  Device Manager: Added an FTP Event extraction protocol driver to extract all the latest event/log  

    files from a device that has a direct ethernet connection and support the standard FTP server protocol. 

 

2.  Device Manager: Added the ability to send a "Break" key out the port to disconnect with a State Mux  

    or modem. A new command was added to the Escape Code Sequence called "BREAK".  The "BREAK" will first  

    send a break state out the port, wait 250 milliseconds, then clear the break state. 

 

3.  File Manager: Fixed a problem with using the backspace key when editing a folder name in the Folder 

    tree. 

 

4.  Data Plotting: Added a divide by 16 for the analog channel scale factor in the Emax Faxtrax II  

    16-bit driver. 

 

5.  Data Plotting: Fixed a problem in the Harmonics window when the # of harmonics exceeds 100.   

    Increased the maximum # of harmonics to 200 and protected against going over the 200 maximum. 

 

 



Wavewin C.8 - 10/20/2005 

 

1.  Data Plotting: Added the Faxtrax 16-bit display driver. 

 

2.  Data Plotting: Fixed a problem with reading Rochester files that have spare channels with no defined 

    name for circuit name field in the Analog channel configuration file. 

 

3.  Device Manager: Improved the "Change Password" feature.  Added protection against unwanted changes  

    and added new change password drivers for the new 2020/2030 firmware. 

 

 

Wavewin C.7 - 09/12/2005 

 

1.  Data Plotting: Added a histogram view in the harmonics window. Click the change view button in the  

    upper right corner of the window to toggle between the table and the histogram.  The histogram view  

    allows for selecting the column of data to show in the histogram.  Click on the "Select Bar Values"  

    drop down menu to change the values displayed. The "% of Fundamental" is the default view. 

 

2.  Device Manager: Added the ability to connect to any IP address as a Server connection.  To set up  

    a Server connection add the following command to the "EscSeq Command" field inside the Device  

    Configuration dialog: 

 

    SIP=21. 

 

    Enter the port number (example SIP=21). 

 

    Also, define a unique port number for the Socket connection in the "Port Number" field.  Start the  

    port number from the last port defined in the "Port Number" drop down list. Example: if the last  

    port number defined in the drop-down list is COM10 and COM10 is not being used by another  

    Client/Server socket connection defined then define your first socket connection to be at Com11  

    and increment the next IP address by 1 and so on. 

 

 

Wavewin C.6 - 08/15/2005 

 

1.  Data Plotting: Improved the Harmonics window to display the number of harmonics according to the  

    number of samples per cycle for the open file. 

 

2.  Data Plotting: Fixed a problem with the Comtrade read engine.  The last analog channel data was  

    not being read and the data values were defaulted to zero.  The Comtrade engine was modified so  

    that a maximum of 255 channels is displayed in the data plotting window.  The maximum analog  

    channel boundary was not being checked properly and the last analog channel was not being read. 

 

3.  File Manager:  Added a new menu option in the driver’s menu for manual override with Tesla recorder 

    files. 



 

 

Wavewin C.5 - 08/03/2005 

 

1.  Data Plotting: Corrected a problem when reading the GE SR745 relay files. 

 

2.  File Manager:  Added a new menu option in the driver’s menu for manual override with GE SR745  

    recorder files. 

 

3.  Data Plotting: Added two new columns to the Analog table. DFTMag = Displays the DFT Magnitude  

    calculated between the RMS bar (black dotted line) and the data bar (solid data bar).   

    Crest = Displays the DFTMag column divided by the RMS column. 

 

4.  Data Plotting: Added a new field in the harmonics dialog called "Total Harmonic Distortion".   

    The "Total Harmonic Distortion" field displays the ((square root of the summation of the squares  

    of DFT Magnitudes from harmonics 2 to 7) divided by square root of 2) and that quantity divided  

    by the DFT Magnitude of the Fundamental. 

 

5.  File Manager:  Fixed a problem with the status bar fields not updating when navigating via the  

    tree. 

 

 

Wavewin C.4 - 07/07/2005 

 

1.  File Manager:  Modified the table sort engine to always sort the columns in upper case.   

    The previous sort engine was sorting the column data as is. This was causing a problem when  

    files are named with upper case and lower case. 

 

2.  Data Plotting: Fixed a problem with reading multiple binary Comtrade files. The Comtrade binary  

    read multiple files was not reading the files in proper sequence. 

 

3.  Data Plotting (SACS):  Fixed a problem with the SACS returning an error when calculating an  

    Envelope using the "A" and "E" script commands. 

 

4.  Data Plotting (Tesla Files):  By passed an error reported by Tesla's AutoComtrade. In some  

    instances the Tesla AutoComtrade utility was reporting an Unknown Error # of 1000 but was  

    converting to the Comtrade Binary format. To accept the converted Comtrade file when an error of  

    1000 is reported by the AutoComtrade utility Wavewin will check to see if the file was actually  

    converted.  If it was converted, then Wavewin ignores the error and displays the converted file. 

 

 

Wavewin C.4 - 06/10/2005 

 

1.  Data Plotting:  A number of requests have been made to change the way the expand and condense time  

    displays the waveform signals.  In versions previous to C.3 the expand and condense would display  



    the first sample out of the group of samples to condense or expand.  To  better show the peaks we  

    changed that functionality in version C.3 to pick the highest value in the group of samples to  

    condense/expand.  This still did not show all the information. In this version Wavewin now  

    displays all the samples in the file.  When the signals are condensed the samples are plotted  

    over each other. 

 

2.  Data Plotting:  Added a feature to hop the data bar by one cycle for waveform files and one day  

    for load files. This feature is keyboard activated, use the Shift+Ctrl+Right/Left Arrows to move  

    the data bar one cycle/day from the previous position. 

 

 

Wavewin C.3 - 05/31/2005 

 

1.  File Manager:  Added Cut, Copy and Paste to easily move files from one directory to another. 

    The new Cut, Copy and Paste features work in the same fashion as Window's Explorer.  Use the  

    following menu items or short-cut keys to activate the added file features:  

    Cut:(Edit Menu: Cut Option, Ctrl+X, Shift+Del), Copy:(Edit Menu: Copy Option, Ctrl+C, Ctrl+Ins),  

    Paste:(Edit Menu: Paste Option, Ctrl+V, Shift+Ins). 

 

    Drag and Drop coming soon. 

 

2.  File Manager:  Added shortcuts in the file table right click pop-up menu for Cut, Copy and Paste  

    files and for the Zip, Email and Refresh features. 

 

3.  File Manager (Save As Comtrade):  Fixed a problem with Save As Comtrade for the 1991 and 1999 formats. 

    The 1991 format was defining 3 fields (substation,device ID,version #) for the first line in the CFG  

    file. The proper format is substation,version #.  Wavewin now puts the substation - Device ID,version#. 

    For the 1999 format the last line in the CFG file is the time multiplier for the sample times in the  

    .DAT file.  Wavewin was only adding the time multiplier field to the CFG if it was greater than 1.   

    Now it always adds the time multiplier field. 

 

4.  File Manager: Fixed a problem with reading the line frequency from the Comtrade ".CFG" file.  The line 

    frequency was always defaulting to 60. 

 

5.  File Manager: Fixed a problem with the list of child windows being displayed under the wrong menu item. 

 

6.  Data Display:  Added a medium display to the Auto Scale (F6, Alt-D, A) toggle feature.  Auto Scale 

    toggles between (Off, On and ++).  ++ plots the signal using the number of maximum pixels allowed  

    for the channel.  The highest value is plotted at the maximum position allowed and the smallest  

    value is plotted at the lowest position allowed.  This feature was added to clearly show the  

    profile of frequency, Vdc and load data channels. 

 

7.  Data Display:  Improved the "Condense" time scale to plot the highest value in the group of samples to 

    remove from the plotted traces.  This maintains the peak values. When contracted to the lowest level 

    an envelope is displayed. 



 

8.  Data Display:  Added a new option in the properties dialog under the Comtrade tab called: "Show Date 

    in (Us/European/Japan) Format. This new option allows for selecting a fixed date format for the Comtrade 

    files. 

 

9.  Data Display:  Fixed a problem with the fault timeline when calculating the time. 

 

10. Device Manager:  Added an option to edit the Drivers.ini file from the Device table. To edit the  

    drivers.ini file open the "Options" menu and select the "Edit Drivers.ini" file option. 

 

11. Device Manager:  Added an option to compile the drivers.ini from the Device table. To compile the  

    drivers.ini file open the "Options" menu and select the "Compile Drivers" option. 

 

 

Wavewin C.2 - 04/27/2005 

 

1.  File Manager:  Fixed a problem with deleting directories from the file list. They were never deleted  

    because the system was checking it as a file not as a directory. 

 

2.  File Manager:  Fixed a problem when renaming directories in the folder tree. If the backspace or  

    enter key was used in the editor, the system was executing the tree's backspace function (go back  

    one directory) and the return function (open/close directory nodes). 

 

3.  Data Display:  Added "Analog Input" & "External Input" as a non-used channel. Wavewin does not  

    show analog and digital channels that are empty or contain the following strings: 

      UNUSE 

      UNDEF 

      NOT D 

      NOT U 

      NOT I 

      NOT A 

      { 

      N/A 

      ANALOG INPUT 

      ANALOG CHANNEL 

      EXTERNAL INPUT 

      EVENT CHANNEL 

      CHANNEL: 

      DIGITAL TRACE # 

      SPARE 

 

4.  Data Display:  Added a driver to read and display the SEL Load Profile Data (LPD) files. 

 

5.  Device Manager:  Added a GE D60 Modbus driver to poll fault files, event files, log files and  

    oscillography files. 



 

 

Wavewin C.1 - 04/10/2005 

 

1.  Data Display: Fixed the data display in the Windows XP display mode.  The last digital channel was  

    being overwritten by the window's border.  Also fixed the sizing of the Wavewin main application  

    window to size around the desk top toolbars. 

 

2.  File Manager (Delete Files): Changed the delete function to send to the recycle bin or permanently  

    deleted only the marked files.  The deletion of support files was removed due to deleting important  

    configuration files. 

 

3.  Data Display (Hathaway driver): Fixed and Found a problem with an Access Violation error being displayed 

    when opening Hathaway DFR files. The WWSETUP.DTB file that holds the Hathaway Channel colors and  

    display sequences was corrupted. When the number of analog channels was increased from 128 to 256 the  

    WWSETUP.DTB file information was being overwritten by the added channels. 

 

 

Wavewin C.0 - 04/05/2005 

 

1.  File Manager: Added a Directory Tree for easy navigation. 

 

2.  File Manager (Delete Files): Changed the way the delete files engine works. 

    It will now send files that reside on the computer to the Recycle Bin all others are permanently  

    deleted. If support files exist, a message is prompted asking to also delete the support files. 

    Support files deleted are Comtrade .CFG, .DAT &amp; .HDR files, Rochester associated event files  

    &amp; .PRE, Emax .CTL files. 

 

3.  File Manager (Rename Files/Folders): To rename a folder in the tree click on the folder name twice 

    to display the edit box. To rename files select the rename option from the Files menu. 

 

4.  File Manager:  Added the ability to email marked files directly from the file table. 

    Click on the email menu button to activate.  All support files are automatically attached to the 

    email message. 

 

5.  File Manager:  Added the ability to zip marked files directly from the file table.  To activate,  

    open the "File" menu and select "Zip Marked Files" option. All support files are automatically  

    added to the zip file upon confirmation. 

 

6.  File Manager:  Added the ability configure each driver in the system.  To open the  

    "Driver Configuration" Dialog open the "Options Menu" and select the "Driver Configuration" option. 

 

7.  File Manager:  Added the ability to edit the Hathaway DAU-DEF file.  To open the "DAU-DEF Editor"  

    open the "Options Menu" and select the "Edit DAU-DEF File" option. 

 



8.  File Manager:  Added the ability to configure the way Tesla files are converted. To open the "Tesla 

    Configuration" dialog open the "Options Menu" and select the "Driver Configuration" option.  In the 

    Driver Configuration dialog select the Tesla driver. 

 

9.  Data Plotting:  Added the ability to email the active event file. All support files 

    are automatically attached to the email message.  To activate, click on the Email menu button. 

 

10. Device Manager:  Fixed a problem with Distance and Event # in the History files generated by the  

    REL 3XX driver. 

 

11. Device Manager:  Added a port switch driver for the Orion box. 

 

12. Device Manager:  Added the ability to create new device tables.  To activate, open the "Device"  

    menu and select the "New Configuration" option. 

 

13. Device Manager:  Added the ability to open different device tables.  To activate, open the "Device"  

    menu and select the "Change Device Configuration" option. 

 

 

Wavewin B.X - 01/24/2005 

 

1.  Data Plotting: Increased the number of analog channels per window from 128 to 256. 

 

2.  Data Plotting: Added support for the ABB TPU2000 Cap files to display up to 13 analog channels 

    (addition W3 Ia Ib Ic and Voltages). 

 

 

Wavewin B.X - 12/23/2004 

 

1.  File Manager: Added  support to display NxtPhase Tesla recorder files in the IEEE Comtrade format. 

    The NxtPhase autocomtrade.exe application must be in the Wavewin directory to convert the Tesla  

    files to Comtrade. If you do not have the autocomtrade.exe file, please contact  

    NxtPhase @ info@nxtphase.com. 

     

    Tesla files are first converted to Comtrade using the autocomtrade.exe application. The selected  

    file in the file table is passed as a command line parameter to autocomtrade.exe. The directory  

    were the Tesla files are located and the files them self cannot have any blanks. Autocomtrade  

    separates the passed fields using blanks spaces. If there are blanks in the directory or filename  

    then autocomtrade will return an error: Syntax of the command is incorrect. 

     

    The Tesla files are always named using the same Comtrade name, TeslaCom. The autocomtrade  

    application will add the sampling frequency to the end of the file, example: TeslaCom_S96.dat. 

    Some Tesla files contain multiple frequencies, in that case autocomtrade saves each frequency in  

    a separate file. For example, a file may produce: TeslaCom_S1.dat for 60Hz, TeslaCom_S8.dat for  

    480Hz and TeslaCom_S96.dat for 5760Hz. The file with the highest sampling frequency is used for  



    the selected action: plot, summary, SOE table, merge/append and so on... 

 

2.  File Manager:  Added a new button for Load Analysis. The new button has a circular chart icon  

    with a drop down menu.  Load Analysis is performed on SDC CSV Files that have Ratings Defined  

    in the RATINGS.INI file located in the Wavewin Directory. 

 

    To define the rating for an SDC CSV device file move the file table cursor to the desired file,  

    press Ctrl-F2, enter the devices ratings into the dialog then press OK.  If the device exists in 

    the RATINGS.INI file then the rating information will be updated else a new device will be added  

    to the end of the file. To View the Ratings.ini file click on the Rating File button. 

 

    Each new menu item is explained below: 

       A.  Process & Update Database: Read all the marked entries in the table and calculate Imbalance, 

           Overload and Inefficiency. The last four columns in the table show the results of the load  

           analysis. 

       B.  Process & Create Summaries:  Read all the marked entries in the table, calculate Imbalance, 

           Overload and Inefficiency and save an ASCII summary file in the selected destination  

           directory with the analysis results. 

       C.  Process & Save As Comtrade:  Read each marked entry in the table, calculate Imbalance, 

           Overload and Inefficiency then save the results in the ASCII IEEE Comtrade format. 

       D.  Device Summary:  Read the select file, calculate Imbalance, Overload and Inefficiency than  

           show an ASCII summary of the results in an ASCII edit window. 

       E.  Station Summary:  Process all the load files with the same station information as the  

           selected file. The active directory must be the history directory defined in the Broadcst.ini  

           file.  The history directory is the first directory defined on the second line of the  

           Broadcst.ini file located in the Wavewin directory.  The station summary results are  

           displayed in an ASCII edit window. 

       F.  System Summary:  Process all the load files located in the Broadcst.ini History directory. 

           The history directory is the first directory defined on the second line of the Broadcst.ini  

           file located in the Wavewin directory. The system summary results are displayed in an ASCII  

           edit window. 

 

3.  Broadcast Mode (Stations):  Added a new button to view the station and system Load Analysis results.   

    The new button has a circular chart icon with a drop-down menu.  Each new menu item is explained below: 

       A.  Station Summary:  Process all the load files for the devices defined in the selected station  

           tab. The load files are in the history directory defined in the Broadcst.ini file.  The history 

           directory is the first directory defined on the second line of the Broadcst.ini file located  

           in the Wavewin directory.  The station summary results are displayed in an ASCII edit window. 

       B.  System Summary:  Process all the load files located in the Broadcst.ini History directory.  

           The history directory is the first directory defined on the second line of the Broadcst.ini  

           file located in the Wavewin directory. The system summary results are displayed in an ASCII  

           edit window. 

 

4.  Data Plotting (Load Files):  Added a new column "AvgWin" to the Analog Table located between the traces  

    and the circular chart.  The "AvgWin" column averages all the sample values between the RMS bar (black 



    dotted vertical bar) and the data bar (black solid vertical bar). 

 

5.  Data Plotting: Added a new option to resize the RMS sliding window (area between the black dotted  

    vertical bar and the black solid bar).  The size of the sliding window can be changed by clicking  

    on the resize sliding window menu speed button to bring up a dialog or by selecting a fixed number  

    from the drop down menu list. The window in Load files is changed according to hours or days and  

    in transient files according to cycles. To bring up the resize dialog from the menu select the  

    "View" menu then select the "Set Sliding Window" option. 

 

6.  System Speed Bar Menu: Added a new "Back" button to go back to the previous window.  

 

7.  Data Plotting:  Fixed a problem with displaying Rochester files that define more Analog channels  

    in the Preamble file than the number of analog channels saved to the Event files. Avoided an  

    off-skew in the data by confirming the circuit name is a valid name. 

     

 

Wavewin B.T - 11/22/2004 

 

1.  File Manager: Added a new feature to save summary files. The "Waveform Summaries" submenu  

    option under the "Options" menu has a new item called "Save summaries".  Save Summaries generates  

    a summary file for each marked or selected file and saves it as an ASCII text file to the  

    specified destination path.  The file is named with the filename specified or by using the IEEE  

    PSRC long file naming convention.  The summary file extensions are "*.txt". 

 

2.  Data Plotting: Added 2 new buttons to the phasor/circular chart window (up-arrow/down-arrow). The  

    new up arrow and down arrow buttons allow for increasing/decreasing the phasor/circular chart  

    scale independent of the traces.  

 

3.  Data Plotting: Added 2 new buttons to the trace window (up-arrow/down-arrow). The new up arrow and  

    down arrow buttons allow for increasing/decreasing the trace's amplitude independent of the  

    phasor/circular chart.  

 

4.  Data Plotting:  Added 2 new buttons to the trace window (left arrows). The left arrow to the left  

    of the scrollbar shifts the sample at the databar (vertical solid black line) to the beginning of  

    the window. The left arrow to the right of the scrollbar shifts the separator bar between the  

    traces and the analog table to the databar. 

 

5.  Data Plotting: Added a new display driver for the GE-SR745 Relay (CSV format). 

 

6.  Data Plotting: Fixed the SEL display driver for the 321 Hex digital definitions when no mirror  

    bits are supported. 

 

7.  Data Plotting: Fixed a problem when reading corrupted SEL files. Ignore blank lines in the middle  

    of samples. 

 



8.  Data Plotting: Fixed a problem with calculating the winding difference for SEL-187 and 287 files.  

    The last versions were not picking up the IA, IB and IC k factors correctly. 

 

9.  Device Manager:  Added a check to ensure the date and time is valid prior to assigning a long  

    filename. The latest version will affix the current date and time if the date or time is invalid. 

 

10. Data Plotting: Corrected a problem in the "Save As Comtrade" feature when saving the sampling rate  

    information to the ".CFG" File.  The problem was occurring after a displayed file was modified by,  

    Change Frequency, Truncate Cycles, Duplicate Cycles, Append and Merge. Older versions wrote the  

    original sample rate information to the new Comtrade file. 

 

11. Data Plotting: Added a feature that will not display a phase angle in the analog table or in the  

    phasor diagram if the channel is DC or Frequency (Hertz).   

 

 

Wavewin B.R - 09/28/2004 

 

1.  Device Manager: Added the SetPort command to support Ethernet connections. SetPort will disconnect  

    from the active connection (if not connected), then re-connect to the active Ethernet port. Check  

    the timing to know when the connection is re-established. 

 

2.  Data Plotting:  Added a limit for analog channels (256 analog channels/display) for the Waveform  

    Merge & Append features.  Cannot Append/Merge waveforms if the combined exceeds 256 analog channels  

    or exceeds 1024 digital channels. 

 

3.  Data Plotting:  Fixed a problem with reading load data times from a Comtrade file that specifies  

    the data in seconds. 

 

 

Wavewin B.Q - 09/22/2004 

 

1.  Device Manager: Added the ability to connect to any IP address as a Client connection. To set up a  

    Client IP connection add the following command to the "EscSeq Command" field inside the Device  

    Configuration dialog: 

 

   IP=198.185.2.133:21. 

 

    Enter the IP address (198.185.2.133) for the connection and the port number (21). 

 

    Also, define a unique port number for the IP address in the "Port Number" field. Start the port  

    number from the last port defined in the "Port Number" drop down list. Example: if the last port  

    number defined in the drop-down list is COM10 then define your first IP address to be at Com11 and  

    increment the next IP address by 1 and so on. 

 

2.  Data Display:  Improved the SAC harmonic calculations to include the magnitude and angle. Previous 



    calculations were storing the magnitude value only. 

 

 

Wavewin B.P - 06/15/2004 

 

1.  File Manager:  Added a new feature to open multiple waveform files from the file table.  Mark the files  

    desired and select the "Open Marked Files" submenu option under the Options/Waveform File(s) menu. The  

    files will be tiled horizontally, and the file manage will be minimized. 

 

2.  File Manager:  Append Waveform Files:  The two features available under the  

    Options/Waveform File(s)/Append menu will append all the marked waveform files in time either by  

    deleting the common times between files (Discard Common Times) or appending all marked files back to  

    back (Back to Back), sorted oldest to latest. The files must be of the same type. 

 

3.  File Manager:  Merge Waveform Files: The two features available under the Options/Waveform  

    File(s)/Merge menu will merge different types of files into one display.   

      By Time: Merge channel samples if they have a common time segment.  The reference time is from  

               the file with latest start date and time. The file with the least amount of samples  

               determined the length of the new merged file. 

      By Sample: Merge regardless of time stamps. The reference time is from the first marked file.  

                 And the file with the least number of samples determines the length of the file. 

 

    When files with different sampling frequencies are merged a dialog will be displayed. The dialog  

    contains a list of all the sampling frequencies in the marked files.  Select the frequency for the  

    merged file or enter a new frequency. 

 

    To identify the merged channels the station name for each file is added to the beginning of the analog 

    and digital channel names.  To turn off this feature open the Properties dialog in the data-plotting  

    window. Click on the Append/Merge tab and uncheck the “Add the File’s Station Name to Beginning of the  

    Analog/Digital Channels” field. 

 

    If merged files have different data types (RMS Calibrated or Peak Values) then all RMS values will be  

    converted to Peak values by multiplying the RMS by Root 2. 

 

4.  Data Plotting:  Added a new feature Append Open Files. There are two options available under the Append  

    Open Files Menu (same feature as the file manager’s Append): 

      Discard Common Times: Any common times found in the open files will be deleted from the oldest file. 

      Back to Back: The files are appended back to back.  No samples are deleted. 

     

    The files must be of the same type.  

 

5.  Data Plotting:  Added a new feature Merge Open Waveform Files. There are three options available under 

    the Merge Open Files Menu: 

      By Time:    Merge channel samples if they have a common time segment.  The reference time is from  

                  the file with latest start date and time.  The file with the least amount of samples  



                  determined the length of the new merged file. 

      Manually:   Use the data bars to highlight where the common sample time is in each window. Merge  

                  manually will then line up the data bars and adjust the time stamps accordingly. This  

                  option is used when the file times are not synchronized.  The active window determines  

                  the time stamp of the new merged file and the open window with smallest number of  

                  samples determines the length of the new merged file. 

      By Sample:  Merge regardless of time stamps and/or data bar positions. The reference time is from  

                  the active window. And the file with the least number of samples determines the length 

                  of the file. 

 

    When files with different sampling frequencies are merged a dialog will be displayed. The dialog  

    contains a list of all the sampling frequencies in the opened files. Select the frequency for the  

    merged file or enter a new frequency. 

 

    Merging Open Files allows for flexibility of what channels are merged. Merge Open Files will merge 

    either the marked channels only or if there are no marked channels then it will merge the visible  

    channels. 

 

    To identify the merged channels the station name for each file is added to the beginning of the  

    analog and digital channel names.  To turn off this feature open the Properties dialog. Click on  

    the Append/Merge tab and uncheck the “Add the File’s Station Name to Beginning of the  

     Analog/Digital Channels” field. 

 

    If merged files have different data types (RMS Calibrated or Peak Values) then all RMS values will 

    be converted to Peak values by multiplying the RMS by Root 2. 

 

6.  Data Plotting:  Added a menu button to gain easy access to the driver’s data type setting. The data  

    type setting specifies if the samples for the active driver are saved in RMS values or in  

    instantaneous values. 

 

7.  Data Plotting:  Modified setting the sample time stamps in the Comtrade reader. If the sampling  

    frequency is set in the .CFG file then the time stamp is calculated from the sampling frequency. 

    If the sampling frequency is 0 then the time stamp is set from the time stamp in the .DAT file. 

 

 

Wavewin B.N - 05/14/2004 

 

1.  Data Plotting:  Fixed a problem with displaying the waveform data and analog table when switching 

    between open windows. The system was losing the window handles when a left mouse click was  

    encountered. 

 

2.  Data Plotting:  Added a feature in the Comtrade driver to calculate the sample time from the  

    sampling frequency if the sample time = 0. 

 

3.  Device Manager:  Added a new feature in the Options menu called "Change Passwords'. Change  



    Passwords will: 

      1st:  Backup the Current List of Passwords Stored in: SETPSW.CSV.  

      Next: Activate MID to Connect to the Devices and Change the Active Passwords and Update all the  

            Password information in the device table and in the device dtb record. 

      Last: Stored all the new passwords in: SETPSW.CSV. 

 

4.  Device Manager:  Added a new command to request data from a text file. The text file must be  

    located in the directory Wavewin is running from. The command is implemented as follows:  

    ^[$File Name:Line]. Line can be a number or a variable. The file in the Wavewin directory must  

    have the extension ".INI" and file name in the command cannot have the extension defined.   

    Example: ^[$WAVEWIN:^PL1;13;10] - This will open the Wavewin.ini file and extract the Line  

                                      number stored in the PL1 variable. 

    Example: ^[$WAVEWIN:5;13;10] - This will open the Wavewin.ini file and extract Line number 5. 

 

 

Wavewin B.M - 05/06/2004 

 

1.  File Manager:  Added a new feature in the File Menu called "ComName(s) Rename".  This feature  

    will rename all the marked waveform files (file entries displayed in red) using the IEEE long  

    file naming convention (ComNames). The format for the ComName Files are:  

       fault date,fault time,time code,station,device,company,duration,type,latitude,longitude, 

          user field.ext 

 

      * SEL Files have the Event Type and Fault Location in the type field (example type field:  

        ",CG T -86.0,"). 

      * DLP Files have the Fault Type, Distance and Trip Type in the type field (example type field:  

        ",AG 001.8 PLT,"). 

      * Transcan Files have the 4-character station ID in the 1st User Field  

        (example user field: ",BEDG,") 

      * Rochester Files have the 5-character header name in the 1st User Field  

        (example user field: ",20626,") 

      * Hathaway files have the #DAU ID data added next to the device name  

        (example device field: ",DAU 8#8,") 

     

    All files associated with the marked waveform files will be renamed.   

      * Comtrade files: the ".CFG", ".INF", ".HDR", ".DAT" and "*.D##" files will be renamed. 

      * Faxtrax files: the ".CTL", ".RCD", ".RCL", ".RCU" and ".RCS" files will be renamed. 

      * Rochester files: the ".PRE" file and all files with the same name and a ".###" extension  

        will be renamed. 

 

2.  File Manager:  Added a new feature in the File Menu called "ComName Properties". There are 4 fields  

    in the ComName format that cannot be extracted from the waveform files: "Company Name", "Time Code",  

    "Latitude" and "Longitude". The "ComName Properties" allows for entering these fields prior to renaming. 

 

3.  File Manager & Data Plotting:  Added a new feature in the "Save As Comtrade" option to use the ComNames 



    long file naming convention for the Comtrade Name.  There is a new check box inside the  

    "Save As Comtrade" dialog called: "Use the ComNames Naming Convention to Name the Comtrade File(s)".   

    If checked the system will automatically assign a ComName filename to all Comtrade files saved. If  

    unchecked then the files will be named using the name entered into the "File Name" field. 

 

4.  Device Manager:  Improved the DirMsg feature to add a new message to the system only if a "*.MSG" file  

    exists and a corresponding "*.CAL" does not exist in the monitored path. Previous version added the 

    message to the system when a "*.MSG" file was found, not checking if a "*.CAL" exists. This may have  

    caused problems with binning the message multiple times. 

     

 

Wavewin B.L - 04/21/2004 

 

1.  Device Manager:  Added a new command to the drivers.ini called CRCPASS. This command automatically  

    generates a random password with a fixed length of 6 characters. The characters are in the range of  

    [0..9,A..Z,a..z]. The random function generator is seeded once upon initial execution to insure even  

    distribution across the six-character spectrum (equally likely outcomes). 

 

 

Wavewin B.L - 04/16/2004 

 

1.  Device Manager:  Enhanced the SDC menu to support Modbus Master commands.  To activate, a device record  

    must be defined in the device manager table with the title equal to "MODBUS MASTER (HEX)".  Second, a  

    RTU-MB4.INI file must be defined in the Wavewin directory defining the Modbus address for the SDC  

    variable name, it's SDC variable name, is the variable signed or unsigned, the scale multiplier and the  

    scale divider: 

 

    Example: 

 

    ;Modbus Address, Variable Name, Signed(-1) or Unsigned (1), Multiplier, Divider 

    0100,VA,1,1000,1 

    0102,VB,1,1000,1 

    0104,VC,1,1000,1 

    0106,IA,1,1,1 

    0108,IB,1,1,1 

    010A,IC,1,1,1 

    010C,P,-1,1000,1 

    010E,Q,-1,1000,1 

    0110,PF,-1,100,1 

    0112,Status,1,1,1 

 

    Also, any devices that respond to the Modbus Master command must have the Address field set to the 

    same value as the Modbus Master Request.  For example, if the Modbus Master requests information from 

    device 07 then the device that responds to that request must have its address field in the device 

    manager set to 07. 



 

 

Wavewin B.L - 04/06/2004 

 

1.  Data Plotting:  Added support to display the SEL Communication Element digital channels. 

 

2.  Data Plotting:  Added support to reference phase angles across data display windows. All phase  

    angles in the opened windows are referenced by the 1st marked channel in the active data  

    display window. This feature is activated from the windows property dialog under the  

    "Display Setting" tab in the Sync Mode section.  Sync Mode must be active for the angles  

    to be referenced 

 

 

Wavewin B.L - 04/01/2004 

 

1.  Data Plotting:  Added support for selection of Line and Graph views for the EMAX AND Mehta drivers. 

 

2.  Data Plotting:  Added support to read Comtrade files that are distributed into multiple data files. 

 

3.  Data Plotting:  Fixed a problem with displaying SAC values when operating with RMS calibrated data. 

 

4.  Data Plotting:  Modified the Emax scale factors to compute the scale value using the primary, secondary,  

    cal_in and cal_ref values. Thank you to Dominion Virginia Power. Previous versions calculated the scale 

    value using the multi factor and display scale values. 

 

 

Wavewin B.K - 03/23/2004  

 

1.  File Manager:  Added a new feature to Append like waveform files in time.  A new sub menu 

    has been added to the "Options" menu called "Waveform File(s)".  Use the "Open Selected Waveform  

    File" option to display the traces in the selected file.  Use the "Append Marked Waveform Files" 

    option to append like waveform files in time.  The marked file's analog and digital channels must match. 

 

2.  File Manager:  Added a new feature to set up certain parameters for the append feature. Select the  

    "Waveform Properties" option under the "Waveform File(s)" menu option. To throw out samples with  

    common times check the "Discard Common Times" option.  Next, select what file will have the times  

    discarded from: the new file being created, or the files being appended. 

 

3.  Data Plotting:  Added support for SEL 387 multiple DIF winding event files. Previous versions would 

    read the 387 events up to the point where an event was encountered that did not match the previous  

    event info. Added support to read all events in the multiple event files and discard any event that  

    does not match the first encountered event. 

 

4.  Data Plotting:  Added a new setting to set the Opening frequency for each supported driver.   

    To setup this parameter open the desired waveform file, next select the "Change Frequency" option from 



    the "Data" menu and check the "Always Open" box. The frequency entered into the New Frequency" field 

    will be the frequency displayed for all the files for the active driver. 

 

5.  Data Plotting:  Added a new feature to Show/Hide the event separator bars for multiple event files.  

    The new field is in the "Properties" dialog under the "Display Settings" tab. 

 

6.  Device Manager:  Allowed for the script engine to process more than 8192 entries. 

 

 

Wavewin B.J - 02/29/2004  

 

1.  Data Plotting:  Fixed a problem reading SEL compressed files that have only a <Cr> after the  

    sample data. 

 

2.  Data Plotting:  Added support for the SEL 311L files. 

 

3.  Data Plotting:  Added the differential voltage channels for the SEL-187/287 relay files. 

 

 

Wavewin B.J - 02/25/2004  

 

1.  Data Plotting:  Added a new feature to Truncate cycles.  Truncate can be applied to remove cycles 

    from the beginning of the data, the end of the data and from the middle of the data. 

 

2.  Data Plotting:  Added a new feature to Duplicate the cycle of data between the RMS bar and the data 

    bar.  A dialog box allows for specifying the number of cycles to add. 

 

3.  Data Plotting:  Fixed a problem with computing the fault time in SEL files that do not specify the 

    fault time using the ">" character or the "PRE=" setting in the Global Settings. 

 

3.  Device Manager:  Allowed for long message by increasing the message string size to 255 characters. 

 

 

Wavewin B.I - 02/20/2004  

 

1.  Device Manager:  Performed a system wide review on all variables that are associated with the device 

    number.  Upgraded the variable from a byte to integer where needed. 

 

2.  Device Manager:  For multidrop topologies, dynamically change the baud rate, data bits, parity, and  

    stop bit before dialing a device. 

 

3.  Device Manager:  Fixed a check that was only allowing 256 devices in the Device Manager.  Currently, 

    the limit is 999. 

 

 



Wavewin B.H - 02/17/2004  

 

1.  Data Plotting: Added two new features to the data plotting's "Data" menu to change and restore the  

    sampling frequency.      

  

        a.) Change sampling frequency: This feature allows for changing the sampling frequency of the  

            displayed record.  If Sync mode is active, then Change Sampling Frequency will change all  

            open windows to the entered frequency. 

 b.) Restore Original Data:  This feature is active only after the sampling frequency is changed.   

            It allows for restoring the original raw data of the displayed record.  If Sync mode is  

            active then Restore Original will restore all the open windows to their original raw data. 

 

    In previous versions SEL 4 samples/cycle files and REL 8 samples/cycle files were applied interpolation 

    to expand the sampling frequency for display.  This latest version does not change any original  

    sampling frequency unless specified by the user.   

 

2.  Data Plotting: Added 3 new options to the "Values" menu. 

 

 a.) Mark Raw Samples - Draws a small circle at all the original raw samples. 

 b.) Mark Peak Values - Draws a small square at all the peaks. 

 c.) Mark Change in Sign Values - Draw a small triangle at all samples where a change in sign occurs. 

 

3.  Data Plotting: Modified the Channel Information, Summary and Raw Data menu buttons to indicate an ASCII  

    display with the corresponding character signifying the type of data. 

 

4.  Data Plotting: Added a new menu button to open new files or to open one of the last 14 files opened. 

 

5.  Device Manager:  Expanded the total number of variables allowed in the system from 5120 to 10,000. 

 

 

Wavewin B.G - 01/27/2004  

 

1.  Data Plotting: The data plotting window's menu has been arranged to be more windows compliant. 

      A large number of requests from Wavewin users asked to improve the menu.  

      Below are the additions: 

 - Added a new "File" menu. The "File" menu handles all commands directly related to the waveform 

          file. 

        - Added a new "Open" command under the "File" menu to open new waveform files. 

        - The "Data" menu handles all commands relating to the data such as: Expand & Contract Time,  

          Increase & Decrease amplitude, auto scale... 

        - Added a new "Channel" menu.  The "Channel" menu handles all commands directly related to the  

          Analog and Digital channels. 

 

2.  Data Plotting: The "Display" dialog used for setting up the properties of the window has been moved 

    to the new "File" menu and is now called "Properties". 



 

3.  Data Plotting: The "Displayed Device's Data Type" field in the "Properties" dialog (formally the  

    "Display" dialog) has been moved from the "General" tab to the "Display Settings" tab. 

 

5.  Device Manager:  The addition of a "++" after any message command sets the message to be at the  

    highest priority.  The message will execute immediately before any other waiting drivers. 

 

6.  Device Manager:  Added a new command "RXSAVE=filename".  RXSAVE saves the contents of the data buffer 

    to the text file set in the RXSAVE command. 

 

6.  Device Manager:  Increase the file transfer timers. The RX timer was increased from 50 seconds to  

    60 seconds. The TX timer was increased from 72 seconds to 120 seconds. Also, included 30 more dashes  

    at the end of the data transferred out the port. The dashes ensure that the CRC information is  

    received at the RX end. 

 

 

Wavewin B.F - 01/20/2004  

 

1.  Data Plotting: Fixed a problem reading the sampling frequency in the Comtrade driver.   

    The driver was defaulting the sampling frequency to 0 if it was >32768 or <-32768. Took 

    out the limit and open ended the sampling frequency value. 

 

2.  Data Plotting: Fixed a problem with displaying SEL relay files that have more than 16 samples in 

    the first cycle and 16 samples in all other cycles. 

 

3.  Data Plotting: Fixed a problem with displaying the digital channels in the 221 relays. The LOP,  

    REJO, Input and output digital channels were being shifted to the right by 4 because of the 4  

    empty channels in between the digital Relays and LOP channel. 

 

4.  Device Manager:  Implemented the Inter Character delay for all the transmitted (TX) data.  

    The inter character delay will be executed when the value is in the range [1..9999].  The  

    Inter Character delay field is in the device configuration dialog.  The entered value is specified   

    in milliseconds. 

 

5.  Device Manager:  Added backwards compatibility in the port communications functions to work with  

    Window's version 98 and below. 

 

6.  Device Manager:  Added a new RXSTRIP command "=".  Used to initialize variables to values. 

 

 

Wavewin B.E - 12/29/2003 

 

1.  Data Plotting: Improved the Rochester Display driver to support Analog Headers with duplicate  

    channels. 

 



2.  Data Plotting: Added support to display the latest SEL-421 ASCII format. 

 

3.  Data Plotting: Added a new engine that separates all the SEL multiple digital channels into  

    single channels. Example: the digital channel Out1&2 become Out1 and Out2.  

 

 

Wavewin B.D - 12/14/2003 

 

1.  Device Manager:  Maintain the SOE file using the Period field inside the Save and Archive  

    Dialog.  When the period expires the SOE files are deleted.  

 

2.  Data Plotting: Fixed a problem with displaying the last 152 samples in the Mehta files. 

 

3.  Data Plotting: Fixed a problem with displaying the digital channels in the Mehta files. 

    The Mehta display software shows a change of state for the digital channels if the  

    sample value is different than 0. The previous Wavewin versions used the digital  

    mask information from the SCF file for the digital channels original state. It now  

    defaults all the digital channels original states = 0. 

 

4.  Device Manager: Improved the driver for extracting REL relay files.  Cut down  

    communication time by 50%.  Added target (*.3TH) and event (*.3EH) summary files. 

 

5.  Device Manager: Fixed a problem with extracting SEL and Hathaway files.  A counter was 

    was being cleared which was causing the SEL and Hathaway drivers to leave before  

    extracting the files.  

 

6.  Data Plotting: Added a new feature to save RMS Calibrated data as Peak data for the  

    Save As Comtrade option. This feature is optional. Change the "Convert RMS Calibrated Data"  

    field in the "General" tab of the "Display dialog" to "Yes" to activate. 

 

 

Wavewin B.C - 11/14/2003 

 

1.  Data Plotting: Fixed a problem with displaying milliseconds in Mehta files that use  

    the IRIG-B signal. 

 

 

Wavewin B.C - 11/12/2003 

 

1.  Device Manager: Improved the driver for extracting Mehta DFR files.   

    Eliminated communication errors when receiving a file.  Also, improved on the  

    fault data and time values showing up in the MID/DXF display. 

 

 

Wavewin B.B - 10/30/2003 



 

1.  File Manager: Improved the speed of read engine for the File manager. Enhanced the way  

    the memory is allocated when reading the file allocation table.   

 

2.  SOE Table: Fixed a problem with displaying digital activity for Emax Director files. 

 

3.  Data Plotting: Fixed a problem with the "Software Analog Channel" menu disappearing. 

 

4.  Data Plotting: Took out the gray background for the digital channels in the print outs. 

 

 

Wavewin B.A - 10/17/2003 

 

1.  Data Plotting: Allowed for Comtrade Files to be displayed if the digital channels have  

    no original states set. 

 

2.  Device Manager: Fixed a problem with extracting files from the Mehta DFRs.  Added  

    more information to the Mehta temp file includes the original file name.  

 

3.  File Manager: Added better protection when requesting a copy/move feature. Sets the  

    active directory in the copy/move dialog to be the current directory in the file  

    table instead of the default directory of the drive set in windows. 

 

4.  Broadcast Mode (Stations): Added better protection when opening the request update 

    dialog.  Made sure the selected station is within the list. 

 

5.  Device Manager: Improved the output information for the Mehta driver. 

 

6.  Data Plotting: Added the original state value to the ABBRELS.INI file for the ABB 

    CAP files.   

 

7.  Data Plotting (SACs): Added a new operator to the instruction set, absolute value.   

    The "|" symbol is used to define the abs() function.   

 

 example: +1/+2/+3/|/   

 

 

Wavewin B.A - 10/10/2003 

 

1.  Data Plotting: Added two new buttons in the phasor/circular chart window title:  

    "P" to display the phasors at the data bar and "C" to display the circular chart. 

 

2.  Broadcast Mode (Stations): Added a new passed parameter called Broadcast that will  

    automatically activate broadcast mode when the system is ran.   

 



3.  Data Plotting: Fixed a problem reading Comtrade CFG files that use a line feed only as  

    an end-of-line marker. 

 

4.  Data Plotting: Added support to display Comtrade files that have digital channels only. 

 

5.  Data Plotting: Modified the equation for the fault time bar to have more resolution. 

 

 

Wavewin B.9 - 09/30/2003 

 

1.  Device Manager: Fixed an access violation problem in the SDCREMOTE command on the host computer.   

 

2.  Data Plotting: (SACs) Fixed a problem with the scale factors for the @ operator. 

 

3.  Data Plotting: (SACs) Added a new operator "h=" to isolate the harmonics of a channel. For more  

    information please refer to the SAC help window inside the SAC dialog. 

 

4.  Data Plotting: (SACs) Added complex equations to the SAC operators.  When the "h=" command is 

    included in a SAC set of instruction all operations will be computed in the complex domain.  The  

    final magnitude value is saved in the SAC giving an envelope of the instructions.  For more  

    information please refer to the SAC help window inside the SAC dialog. 

 

5.  Data Plotting: Added a new feature that marks (displayed in red) the zoomed channels when returning 

    to the original channel view. This feature is helpful when creating different views. To start a new  

    view use the F8 function key to unmark all the channels. 

 

 

Wavewin B.9 - 09/04/2003 

 

1.  Device Manager: Designed a compatibility interface for the Comtrol RTS hubs. All Wavewin copies that  

    use the passed parameters "Ports" and "DXF" or "MID" will wait up to 4 minutes before opening the  

    defined COM ports in the device manager. This eliminates having to calling Wavewin from a DOS batch 

    file. 

 

2.  Device Manager: Added support to activate the device manager and DXF or MID windows when Wavewin is  

    ran as a minimized application and the "Ports" and "DXF" or "MID" parameters are used. Previous  

    versions required the Wavewin application to be displayed on screen before activating the Device  

    manager and DXF or MID windows.  

 

3.  Data Plotting: Added data type (Peak Type, RMS Calibrated) support for Hathaway, Mehta and REL-30X  

    files named using the PSRC long file naming convention.  

 

4.  Data Plotting: Took out multiplying the sample values by -1 in the ABB TPU Cap files. 

 

 



Wavewin B.8 - 08/24/2003 

 

1.  Device Manager: Mehta driver: 

                    Added screen variables to show polling results.   

                    Allowed for non-alphanumeric characters to be used in the DIR name. 

                    Built an automatic search to dynamically find the file name.   

 

2.  Device Manager: DLP driver: 

      Improved the logon procedure to bypass if already logged on. 

 

3.  Device Manager: Allowed for use of ASCII variables from the Hex type of escape code sequences. 

 

4.  Device Manager: Allowed for recursive variable calls from escape code sequences. 

 

 

Wavewin B.7 - 08/11/2003 

 

1.  Broadcast Mode (Stations): Corrected a problem with the right click popup menu adding duplicate 

    menu options. 

 

2.  Device Manager: New feature added for Wavewin copies that use the pass parameters "Ports" and 

    "DXF" or "MID". Added a 5-minute timer to make sure the DXF or MID window is up and active. 

    If not up, then the system will automatically close the device manager table to clear the com  

    ports, re-open the device manager table then open the DXF or MID window. 

 

3.  Device Manager: Added extra checking on the DUNRENAME and RENFILE. 

 

 

Wavewin B.7 - 08/03/2003 

 

1.  Broadcast Mode (Stations): Provided dynamic memory allocation for the DXF data.  

 

2.  Data Plotting: Improved the error checking on Comtrade files.    

 

3.  Data Plotting: Increased maximum zoom factor for auto-scale mode from 99999 to 999999999 to allow  

    for further magnification.  

 

 

Wavewin B.7 - 07/30/2003 

 

1.  Broadcast Mode (Stations): Fixed a problem accessing DXF images that have not yet be read into memory. 

 

2.  Broadcast Mode (Stations): Fixed a problem with automatically scaling DXF pictures when new DXF files 

    are automatically added to the existing broadcst.ini file 

 



3.  Data Plotting: Fixed a problem with the auto scale feature for Log files. 

 

 

Wavewin B. 7 - 07/28/2003 

 

1.  Broadcast Mode (Stations): Enhanced the read engine upon entry to the window. Reads only the first  

    tab's DXF and Dun files upon entry. Tabs that have not been read are marked with a station ID of -1.  

    When the tab for a station is clicked it will read the tab's DXF and DUN files and update the tab  

    with the appropriate Station ID. 

 

2.  Broadcast Mode (Stations): Added automatic refresh when changing to a new station (tab). The DUN  

    files are automatically read from the latest information on disk and displayed. 

 

3.  Broadcast Mode (Stations): Automatically sets the display background to black if not specified prior, 

    and resizes the DXF display to the appropriate coordinates. 

 

4.  Broadcast Mode (Stations): Added 5 new menu buttons:  

       LOG - Displays the file table with all the log files for the active station highlighted in red and 

             sorted according to time. 

       PKS - Displays the file table with all the station peak files for the active station highlighted  

             in red and sorted according to time. 

       EVE - (Phasor Button) Displays the file table with all the station event files for the active station  

             highlighted in red and sorted according to time. 

       HIS - (Multiple Page Button) -Displays the file table with all the station history files for the 

             active station highlighted in red and sorted according to time. 

       SUM - (Page with Magnifying Glass Button) -Displays the file table with all the station summary  

             files for the active station highlighted in red and sorted according to time. 

 

5.  Device Manager:  Added a "DUNRENAME" command to automatically rename all DUN files to their appropriate 

    names. Used to rename DUN files that are building during communications. Allows the DUN files to build  

    with no conflict with the file transfer engines. 

 

6.  Data Plotting (Save Displayed Values): Added a new extension "*.mac" for the Save Displayed Values  

    Feature. 

 

7.  Data Plotting (Save Displayed Values): Allowed for the Display Save Values File and Format File  

    Window to be independent of the data plotting window.  Does not close the Save Values File and Format  

    File Window when closing the data plotting window. 

 

8.  Data Plotting: Enhanced the Fault time bar locator to look for the closes match defined by the  

    selected format. Prior versions looked for an exact match. 

   

9.  Data Plotting: Enhanced the Sync Time feature to look for the closes match. Previous versions looked  

    for an exact match. 

 



10. Data Plotting: Corrected the Sampling Frequency for Comtrade Files that specify a time scale multiplier. 

 

11. Data Plotting: Enhanced the Sync Manual Mouse Click to displace the mouse according to time difference. 

    Previous versions displaced according to click position. 

 

12. Data Plotting: Corrected the Fault Time displayed in the Waveform Summary Window. 

 

13. Data Plotting: Enhanced the EMAX display driver to display the new ".CTL" format files that defined  

    less than 32 analog channels. Prior files always defined 32 analog channels even when unused. 

 

14. Data Plotting: Added a Prompt to ask to overwrite existing Comtrade files for the Save As Comtrade  

    feature. 

 

15. Data Plotting: Corrected the Save As Comtrade feature to save only the digital channels that are  

    visible. Previous versions were saving the digital channels when the digital section was hidden  

    using the drag mouse. 

   

 

Wavewin B.6 

 

1. Broadcast Mode (Stations): Added two new fields to the device colors dialog:  

     Title Offset: specifies the x offset position from the top left-hand corner of the control point;    

     Show Type: Shows or Hides the Device type defined in the Device title.  Device types are  

                specified between "()".            

 

2. Broadcast Mode (Stations): Added 26 DUN classes. 

 

3. Data Plotting: Fixed a problem with the scale factors for the print engine. 

 

4. Device Manager: Improved the file transfer engine. Updated the overlap communications 

   structure.  

 

 

Wavewin B.5 

 

1. Data Plotting: Fixed a problem displaying the EMAX Director analog channels.                     

   Needed to re-flip the analog channels by 180 degrees back to original display.   

   Previous flip was determined by Emax's display software.  Confirmed the re-flip by  

   EMAX's latest release of their display software.    

 

2. Data Plotting: Added the Emax Director format for records that contain more than 

   64 analog channels. 

 

3. Data Plotting: Advanced the Save Display Values option.  Added user defined Templates. 

   Refer to the Data Plotting help window "Save Displayed Values" section for more information. 



 

4. Data Plotting: Added and new menu option "Values".  Allows for saving Values displayed 

   in the Analog Table to a text file (Mark & Save) in the default format or in the format  

   defined in the selected Template file.  Provides "Open", "New" and "Clear" features for 

   the active Values file and provides "New" and "Open" features for the Template Files.  

   Refer to the Data Plotting help window "Save Displayed Values" section for more information.  

 

5. Data Plotting: Added the Horizontal Bars to the print engine. 

 

6. Data Plotting: Fixed a time scale problem with Comtrade files that specify a time scale multiplier. 

 

 

Wavewin B.4 

 

1. Device Manager: Added a "BC" command in the RXSTRIP to parse values separated by commas & clear  

   all beginning and ending blanks in the final string. 

 

2. Device Manager: Added a "CRCHATH" command to compute the CRC of a command. 

 

3. Device Manager: Up cased the message files for the DIRMESSAGE command. 

 

4. Device Manager: Added a new separator, a pipe sign ("|"), for the RenFile (Rename) command in  

   the drivers.ini file. 

 

5. Device Manager: Added a new RXSTRIP command, "FT", to truncate real values into integer values. 

 

6. Data Plotting: New time based display.  New field "Trace Display Type" added to the "Display"  

   dialog under the "General" tab. Allows for toggling between a sample base display and the time  

   based display. 

 

7. Data Plotting: New Fault reference time bar.  Shows the time difference from the fault time. 

    

8. Data Plotting: New Close button for the Phasor/Circular Chart window. 

 

9. Data Plotting: New Close button for the Channel Information Table.    

 

 

Wavewin B.3 

 

1. File Manager: Fixed a problem with the SOE table when displaying files with SACs defined. 

 

2. Data Plotting: Fixed a problem with scaling the harmonic values in the Harmonics window. 

 

 

Wavewin B.2 



 

1. Data Plotting: Fixed a problem displaying the EMAX Director analog channels.   

                  Needed to flip the analog channel by 180 degrees. 

 

2. Data Plotting: Fixed a problem displaying the Mehta triggered channels.  

 

3. Device Manager: Added a variable in the drivers.ini to access the port number in the table: ^PID. 

 

4. Data Plotting: Fixed a problem displaying the EMAX Director digital channels. 

 

5. Data Plotting: Added a thicker line between events in multiple event files.  

 

6. Data Plotting: Allowed for the Constants in the SACs to be real values. 

 

7. Device Manager: Allowed for Com port numbers in the device configuration dialog to be entered as  

   any com port from com1 to com999. 

 

8. Data Plotting: Changed the REL/Mdar digital titles to the correct names.   

   Applies to the Digital titles assigned to the ABB events extracted using Wavewin. 

 

9. Data Plotting: Changed the way the digital bits are displayed: a value of 1 = thick green line,  

   a values of 0 = thin black line.  The A and N status next to the digital titles stay  

   the same. They are set according to the bit compared to the original state,  

   A = different then original state, N = same as original state. 

 

10. Data Plotting: Added in the SAC window divide and multiply operators: 

       division = ':' 

       multiplication = '*'   

        

    example: +1/*2/        - multiply channel 1 to channel 2 

             +1/+2/+3/*^12 - multiply the addition of channel 1,2 and 3 to a constant of 12 

             +1/:2/        - divide channel 1 by channel 2 

             +1/+2/+3/:^12 - divide the addition of channel 1,2 and 3 by a constant of 12 

 

11. Data Plotting: Added in the SAC window the ability to use a constant value for the  

    "+", "-",":" and "*" operators.  

     

    example: -12/*^15     - reverse channel 12 and multiply with a constant of 15 

             +2/+3/+4/*^5 - added channel 2,3 and 4 and multiply with a constant of 5 

             +2/+3/+4/:^5 - added channel 2,3 and 4 and divide by a constant of 5 

 

12. Data Plotting: Added phase shifts to the SAC operators mainly for + and -  

    sequence components: 

     

    example: +1/+2@120/+3@240/:^3/  - (+)Seq 



             +1/+2@240/+3@120/:^3/  - (-)Seq 

             +1/+2/+3/:^3/          - (0)Seq 


